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Welcome to the HackSpace magazine guide to 3D design 
– which is really a guide to FreeCAD, the number one 3D 
modelling and design software. We could have chosen from 
a few pieces of software to base this guide on, but we picked 
FreeCAD for three good reasons.

It’s not a clone. FreeCAD is designed from the ground up to 
meet the needs of users. Unlike some other free software 
applications, FreeCAD isn’t playing catch-up with some paid-for 
application: it’s its own thing. 

It’s free software. Time spent learning FreeCAD will never be 
wasted because no company can come along at a later date and 

change the licence 
agreement or start 
charging you to use it.

It’s flexible. Because 
FreeCAD is free 
software, its users can 

add to it, writing extensions to the software to suit their needs. 
These add-ons, known as workbenches, cover a range of uses, 
including PCB design, pipes, timber-framing, architectural 
design, and loads more. So, whatever you’re interested in 
building, you’ll find a FreeCAD workbench for it.

All the tutorials in this guide were first published in 
HackSpace magazine, the magazine for the modern maker. 
We regularly feature 3D printing, home electronics builds, 
woodworking, and other projects, alongside a load of 
technologies far too esoteric to list here. Download a copy of the 
magazine for free from hsmag.cc and see for yourself. If you 
like it, subscribe.

Finally, a word on the author: Jo Hinchliffe is a prolific 
maker and tinkerer and full-time tool enthusiast. He’s given 
talks at the European Space Agency (ESA), helped encourage 
and promote all kinds of creative communities, designed and 
produced open-source rockets – and particularly relevant for 
our purposes, he’s extremely good at using simple words to 
describe complicated things. 

ANDREW GREGORY 
Editor   andrew.gregory@raspberrypi.com
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Yorik van Havre

reeCAD has come a long way 
in 20 years. It was relatively 
unknown during its first 
decade, developing slowly 
and steadily, then it got 
embraced by the 3D-printing 

community around 2010 and is now 
putting its feet firmly in the professional 
world. I am very fond of this grey area 
that exists in and around FreeCAD, where 
all kinds of users, professional and 
hobbyist alike, meet and share tools and 
knowledge. It is a tool made by hackers 
for hackers. Like what happens in 
hackerspaces, the distinction between 
what is professional 
and what is non-
professional ceases to 
be meaningful.

Jo Hinchliffe’s 
tutorials are just like 
that, professional yet 
not particularly aimed 
at a specific category of 
users. They will take 
you everywhere 
through FreeCAD and 
further. Even if you’re here just to 
3D-print a new handle for your favourite 
coffee jar, there is no reason for not doing 
it the same way as if you were launching 
your own coffee jar production line. 
That’s what FreeCAD is designed for, and 
that’s what we all hope you will like and, 
possibly, get hooked and be part of this 
big ecosystem where what we produce 
helps others. 

Foreword

F

 
Jo Hinchliffe’s tutorials  

are just like that, 
professional yet not 

particularly aimed at a 
specific category of users

Yorik van Havre
FreeCAD developer
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FreeCAD For beginners

irst, go to freecadweb.org and 
download a copy of FreeCAD for your 
operating system. When you open 
FreeCAD, it defaults to a ‘start’ 
workbench which has limited tools but 
shows recent files and example files in 

the viewer window on the right-hand side (Figure 1). 
FreeCAD uses ‘workbenches’ which you can switch 
between. If you click the drop-down menu where it 
says ‘start’, you will see all the installed workbenches 
(Figure 2). The idea of workbenches is simple: 
imagine a large workshop with multiple benches, and 
each bench has a different collection of tools focused 
around a theme. FreeCAD has workbenches with 
tools to make parts, create architecture, assemble 
collections of parts into assemblies, create toolpaths 
for CNC, create technical drawings, and much more. 
The beauty of these workbenches is that FreeCAD 
automatically carries all your work between them 
when you switch benches. As you progress in 
FreeCAD, you will use more workbenches, and you 
might even install extra workbenches you discover in 
the FreeCAD community. 

F FIRST DESIGN
To begin, click ‘create new’ and the document 
viewer window will create an empty project in a 
new tab. Next, we are going to switch from the 
‘start’ workbench to the ‘part’ workbench using the 
workbench drop-down menu. The part workbench 
is a good place to start to get oriented and to 
explore one of the simplest ways to make parts. 
Before we go too far, though, let’s explore how 
we navigate, zooming and moving objects, in the 
preview window. 

You should be able to see a collection of tool icons 
that contain yellow shapes of a cube, cylinder, 
sphere etc. Left-click on the cylinder icon and you 
should see a cylinder appear in the viewer window. 
It probably will have defaulted to a top view of the 
cylinder, so you may only see a circle as you are 
looking straight down from above. There are 
numerous ways to switch the viewpoint in FreeCAD. 
First, you can use the cube in the upper right-hand 
side of the preview window to move to view 
different faces. You can also use the blue ‘view’ 
icons that appear as a cube with a single face 
marked as solid in the toolbars. If you hover over the 
view icons, you get a description of the view type 
they relate to and also a number. This indicates that 
you can also swap views by just using the number 
buttons 1, 2, 3, and 4 on your keyboard. 

NAVIGATION 
However, a common way to navigate and select 
items and parts in FreeCAD is in the viewer window 
itself, and there are numerous different navigational 
styles available for you to choose from. If you hover 
over the viewer window and right-click, you can 
scroll to ‘navigational styles’ and a drop-down list 
appears (Figure 3). Some of the navigational styles 
are based on other CAD environments, so if you are 

Get started with FreeCAD, using some of the tools to design 
a set of small wheels ready to be 3D-printed 

FreeCAD for beginners

Figure 1 
FreeCAD is an 
excellent open-source 
CAD environment 
developed by a 
dedicated group of 
motivated volunteers 
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Figure 2 
The workbench 
selection drop-down 
– each workbench has 
a collated set of tools 
for specific types 
of work

Figure 3 
Spend some time 
trying different 
navigation styles  
to find one that  
suits you

used to using, for example, Blender, then you might 
prefer that style. We use the ‘gesture’ style option 
that gives left-click for rotation in the document 
window, right-click for moving, and the centre 
button/wheel is for zooming. Of course, you need an 
object like the cylinder we created to allow you to 
judge which navigational style suits you best.

SET UP YOUR WORKBENCH
The part workbench is used largely to create parts by 
combining solid primitive objects like the cylinder we 

created. It’s definitely a good place to start, but you 
may find as you learn more/other ways to create 
parts on different workbenches, you use this 
workbench less. Returning to the cylinder we 
created, we can see that on the left-hand side of the 
screen there is a file-tree-type view, and under the 

FREECAD VERSION
For this series, we use FreeCAD version 0.19, but the 
same processes should work on a newer version, 
though as time passes, it's possible that some things 
will change. 

We are using the app image version on Ubuntu 
20.04; however, this should be the same for the 0.19 
version on other operating systems such as other Linux 
distributions, Windows or Mac.

heading ‘unnamed project’, we can now see that 
‘cylinder’ is listed, (Figure 4, overleaf). We can 
single-left-click on this cylinder label in the file view 
to select the object, or we can click on the various 
faces and edges of the cylinder in the document 
window to select them. Clicking on the label in the 
drop-down menu, you should see that underneath 
this a new dialog box appears with details about the 
dimensions and position of the cylinder. Initially, the 
first things you can change here are the radius and 
the height of the cylinder. Let’s imagine we are 
making a simple wheel for a toy car, and make the 
wheel radius 12 mm. Next, let’s set the height of the 
cylinder to 15 mm.

WHOLE HOLES
Click the cylinder tool once again and you’ll see 
another cylinder appear in the file tree view. You may 
not see the cylinder appear in the document viewer 
window, however, as it’s smaller than our other 
cylinder and is currently positioned inside it. If we 
left-click the new cylinder in the file tree view, it   

Hover your mouse 
over any tool icon 
in FreeCAD for a 
couple of seconds 
to get a text 
description of what 
the tool does. 

QUICK TIP

You need an object like the 
cylinder we created to allow 

you to judge which navigational 
style suits you best

”
”
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1.5 mm radius cylinder we just made out of our 
larger one. Select the larger cylinder first in the file 
tree and then hold either the SHIFT or the CTRL key 
down whilst you select the smaller cylinder. Once 
they are both selected, click the ‘make a cut of two 
shapes’ tool icon and a hole should appear through 
your first cylinder. If for any reason both cylinders 
disappear, it probably means you have selected them 
in the wrong order and have cut the larger cylinder 
out of the smaller one, which leaves no object 
behind! Press CTRL and Z to undo and try again. The 
shortcuts may be different on your OS. You can see, 
and change them in the Tools > Customize menu.

You should now see that in the file tree your cut 
object has been renamed to ‘cut’. If you click the 
small arrow to the left of ‘cut’, you should see a 
drop-down which contains both your original 
cylinders but greyed out. These objects, despite 
being components of a completed cut, can still be 
altered. For example, if we wanted to change the 
radius of our hole to 2 mm from its current 1.5 mm, 
we can do this without redoing the cut operation. 
Select the file tree name for the smaller cylinder, 
then press the SPACE bar. This should make the 
cylinder that made our hole visible in the viewer 
window. We can then use the dialog box to change 
the radius of the cylinder and then press the SPACE 
bar again to turn off the visibility of the object. This 
should reperform our cut with the new-sized 
cylinder. We can also change the position of the hole 
if needed by moving the object.

	
WHEELY GOOD
Our wheel design looks a little unrefined, so let’s add 
some features to make it look a little cooler. Let’s 
create another cylinder and change the radius of this 
cylinder to 10 mm, and set its height to 3 mm. We 
are going to perform another cut with this object, but 
we want to move it to the top of the wheel design. 
To do this, right-click on the cylinder object in the file 

should appear highlighted in the document viewer 
window. Change the radius of the new cylinder to 
1.5 mm and adjust the height to match our first 
cylinder, which was 15 mm. If we click anywhere off 
the image of the cylinders in the viewer window, we 
should now be able to see the ends of the cylinder 
we created in the top and bottom of the original 
cylinder (Figure 5).

SLICING AND DICING
Similar to most drawing and CAD packages, we can 
combine objects in multiple ways to create new 
objects. You should be able to see a selection of tool 

icons, some of which feature blue circles overlapping 
in different ways. Hovering over these icons, you 
should find one described ‘make a cut of two 
shapes’. We are going to use this tool to cut the 

Figure 4 
The combo view 
panel on the left-hand 
side includes a file 
tree window for 
selecting objects 
and parts. When an 
object is highlighted, 
its dialog box 
appears below 

Figure 5 
It can be hard to see 
objects when one 
is positioned inside 
another. Hovering 
over object names 
in the file tree will 
make them appear 
highlighted in the 
viewer window

Figure 6 
When moving 
objects, or rotating 
them, we can set the 
increments to allow  
us to quickly  
position objects 
accurately

Similar to most drawing 
and CAD packages, we can 
combine objects in multiple 
ways to create new objects

”
”
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tree and then select 'transform' from the drop-down 
menu. You should now see a dialog box called 
‘increments’, and in the viewer window, the cylinder 
will be highlighted with some red, green, and blue 
arrows attached. These arrows correspond to the x, 
y, and z axes, and left-clicking and dragging on either 
the red, green, or blue arrow points will move the 
item in that direction. It will move the object in 
multiples of the amount set in the ‘translational 
increment’ box, (Figure 6). This usually defaults to 
one millimetre, but we can set it to any step size we 
prefer. For example, in our case, if we set the 
translational increment to 12 mm, we can then drag 
the blue arrow by one step, bringing our 3 mm-high 
cylinder flush with the top of our design. Whilst we 
don’t need it for our wheel, it’s worth having a play 
with clicking and dragging the red, green, and blue 
spheres on the arced lines with the translation 
arrows. Clicking and dragging these rotates the 
object around the axis the colour represents. Again, 
you can set the rotational increment dialog to 
whatever number of degrees you like. 

Next, perform a cut to remove the new cylinder 
from the design. We then continued to make our 
wheel look a little fancier by creating four more 
cylinders. We moved the four cylinders equally 
outwards by 5 mm from the centre of our wheel 
using the moving techniques we learnt earlier. You 
should end up with a simple wheel that looks 
like Figure 7.

FINISHING TOUCHES
Our wheel is looking wheel-like, but the part 
workbench has some simple tools we can use to 
embellish it a little. You may have noticed in the 
viewer window that you can highlight/select either 
the faces or the edges of objects. Often you can also 
select corner points of objects, but as everything is 
circular in our wheel design, that doesn’t apply here. 
The part workbench has two nice tools for adding 

either fillets or chamfers to edges of objects. They 
appear as two tool icons: the fillet tool as a curved 
area between two flat surfaces, and the chamfer 
tool as an angled flat surface. In the viewer window, 
left-click to select the outside edge of the top of our 
wheel, and then click the fillet tool. In the dialog box, 
we can see a list of edges, including our selected 
edge. This is useful if you want to apply multiple 
fillets to multiple edges in one operation. You can 
also adjust the radius of the fillet in the dialog.  

Figure 7 
Our wheel design with 
all the cut operations 
performed on it and 
transparency set 
to 30 percent to 
allow us to see the 
internal geometry 

Figure 8 
Adding chamfers and 
fillets to internal and 
external edges of 
parts is made simple 
in FreeCAD

Figure 9 
Using the drop-down 
‘part’ menu to create 
simple copies of 
our wheel
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We’ll leave ours at 1 mm and click OK to apply the 
fillet. Both the fillet and the chamfer tools can be 
used on either external or internal edges. As an 
example, let’s select the edge inside at the bottom 
of the large cut-out at the top of our wheel. Click the 
chamfer tool this time, and set the chamfer length 
to 0.5 mm and OK it (Figure 8, overleaf). You should 
see that a nice internal chamfer has been created. 
Finally, we added a matching fillet to the bottom 
outside edge of our wheel.

RENAME
Now we have our basic wheel design (it's called 
‘fillet’ in the file hierarchy). Let's create some simple 
copies of our wheel to make a set of four.

First, to help keep things orderly, let’s right-click 
on ‘fillet’, select ‘rename’, and call it ‘wheel’. 
Renaming this doesn’t change the fact that if we 
double-click it, it won’t open up the fillet dialog, but 
will help us track when we make multiple items.

CREATE COPIES
To create our copies, single-left-click ‘wheel’ in the 
file tree view to select our wheel and then go to the 
‘part’ drop-down menu; select ‘create a copy’, then 
‘create a simple copy’ (Figure 9, overleaf). Clicking 
this option will create a new ‘wheel001’. If we 
double-click on wheel001, we can see that it can 
now be moved as a separate item. As we made a 
‘simple copy’, our new wheel doesn’t contain the 
hierarchy of operations and objects our original has 
and also is not dynamically linked to the original 
object. This means that if we make further changes 
to our original ‘wheel’, these aren’t pushed through 
to the simple copies. However, of course, you can 
delete the copies, make a change to the design, and 
recopy if needed.

THE NEXT STEP
Let’s make copies and lay them out as a set of four 
(Figure 10). We’re going to 3D-print these wheels, 
and we could just export one instance of the wheel 
and then duplicate it in our slicer software – but, 
again, it’s just as easy to do this in FreeCAD. Having 
made our four copies of the wheel, let’s save our 
work and then, click ‘file – export’. We can export 
a mesh file of the wheels ready for slicing for 3D 
printing. If we don’t specify the type of mesh file 
by adding a file suffix, it will default to an STL file. 
Having exported our STL file, we could open it in 
our favoured slicer and 3D-print them (Figure 11). 
However, FreeCAD isn’t only for 3D printing, and in 
in the rest of this guide, we’ll look more widely at 
what FreeCAD can do.  

TRANSPARENCY
Selecting items in the file tree makes them become 
highlighted in the document viewer window and, 
whilst this is useful sometimes, it’s easier to set some 
component items to be different colours and adjust 
their transparency. This can help us see the internal 
geometry of parts, and can allow us to check internal 
positions. To do this, highlight a part in the file tree view 
and right-click. Scroll to ‘appearance’. In the menu 
that appears, you will see that you can set the material 
type and also the shape and line colour, and also set 
the transparency. 

Figure 10 
Our finished set of 
wheels, ready  
for export 

Figure 11 
Our wheel design, 
exported and 
3D-printed
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n part 1, we began to look at FreeCAD 
using the 'part' workbench to design a 
small wheel. We used simple primitive 
shapes, cubes, and cylinders, and we 
added, subtracted, and joined them together 
to create our design. In this project we are 

going to make a small bird feeder, but will use 
different methods where we will create a 'body' using 
the 'part design' and 'sketcher' workbenches. The 
techniques are a little more complex, but give us 
much more control over our designs.

PICK YOUR WORKBENCH
Opening FreeCAD, start a new document and then 
select the part design workbench from the drop-down 
menu. You should see in the combo view, on the 
left-hand side, a single option which is 'create body' 
– click this. You should then see 'create sketch'; click 
on this, and you'll then be presented with a choice of 
which plane to base our sketch in: XY, XZ, or YZ.  
An easy way to visualise the XY plane is by imagining 
a 3D printer and looking down on it from above onto 
the bed. If we sketched onto the printer bed, we are 
then working on the XY plane. Select the XY plane 

I and click OK. At this point, FreeCAD should 
automatically switch to the sketcher workbench.

Next, select the 'create a polyline' tool icon which 
is 7th from the left on the top row in Figure 1. We are 
going to draw three connected lines in a U-shape 
roughly laid out, as shown in Figure 2. Starting at the 
top left-hand side of the U, click on the vertical 
zero-line on the Y-axis at any height and then drag the 
line down to the origin point of the XY plane. 
Conveniently, when we hover over either zero-line or 
any point they will turn yellow; clicking when yellow 
will place the drawn object on the highlighted point or 
line. Next, pull the line out horizontally and left-click 
before pulling it up vertically; right-click to end our 
three lines. 

If you have done this correctly, the horizontal line 
and vertical line will be white, but will have a small 
red horizontal or respectively vertical line. In the 
combo view panel, you should see a 'solver 
messages' tab with a message about numerous 
'degrees of freedom'. The aim is to reduce these 
degrees of freedom to zero by constraining all the 
items within a sketch. Constraining a sketch is the 
process of adding constraints that complete all the 

Our next project: we're going to design a small bird feeder 
using the 'part design' and 'sketcher' workbenches 

FreeCAD: using the 
part design workbench 

Above 
The completed bird 
feeder 3D-printed 
and attached to a 
window with small 
suction cups
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Figure 1 
The icons on the top 
line are mainly the 
tools for drawing 
lines, circles, 
rectangles, and more. 
The icons on the 
bottom line are the 
tools to add different 
types of constraints

Figure 2 
Our first three lines 
drawn roughly and 
unconstrained

Figure 3 
Our first three lines 
constrained

information about a sketch item's positions and 
dimensions. This is an incredibly useful approach, 
meaning we can return to sketches at any point in our 
design and make changes that will be automatically 
recalculated into the whole model. 

The sketcher solver automatically adds some 
constraints when it guesses, for example, you want a 
line to be vertical or horizontal, as we have just done. 
Starting on a datum line and including the origin point 
on the XY plane also means that we don’t need to 
constrain these lines' positional co-ordinates, but we 
do need to constrain the lengths of the line. Later we 
will constrain items that aren’t on these lines, so 
you’ll see how to set positions of items relative to 
other parts of the design. 

WHAT IS A BODY?
A body is best described as a component part that 
is one continuous solid object. To visualise this, an 
example could be a nut and a bolt. If we wanted to 
model a nut and bolt, they would both be separate 
bodies that could then be fastened together as an 
assembly. The 3D form of a nut and a bolt can be 
modelled as a continuous single piece, and so each 
can be considered a body. 

In this project, we are using sketches and 
performing operations on the sketches such as 
'padding' where we extrude a sketch, and 'pocketing' 
where we cut the shape of a sketch into an existing 
object. However, you can also add primitive objects 
on the part design workbench similar to the use of the 
part workbench in part 1. 

CONSTRAINING CHOICES
As you get used to applying constraints, you will realise 
that there are lots of different ways to achieve the 
same results. To constrain our lines, we are going to 
select the two vertical lines. To do this, right-click to 
deactivate the line drawing tool and then left-click on 
both the vertical lines in turn. Next, press the 'create an 
equality constraint' tool (8th from left, top row, in 
Figure 1). The two lines should now appear as an 
equal but undefined length. If you left-click on the red 
point at the top of either line and drag it, you should 
now find that both lines extend together as they are 
constrained as equal. This ability to extend the line is a 
degree of freedom, and sometimes, clicking and 
dragging items in the sketch can help identify what you 
need to constrain. Left-click to select one of the  



TUTORIAL

16

FreeCAD, Using the Part Design Workbench

vertical lines, and then click the 'fix the vertical 
distance' tool icon (13th from left, top row, in Figure 1). 
In the dialogue box that appears, type '20 mm', and 
then click OK. You should now see a red constraint 
label with '20 mm' in the viewer window – both vertical 
lines are now set to 20 mm. If you ever want to change 
this value, double-click on the constraint in the viewer 
window and the dialog box will reopen. You can click 
and drag the constraint around in the viewer window, 
and as you add more detail and constraints, you might 
do this to keep things clear.

Next, select the horizontal line and click the 'fix a 
horizontal distance' tool (12th from left, bottom row, 
in Figure 2) – set this length to 80 mm. You should 
now see that the sketch as it stands is fully 
constrained, the solver says there are no degrees of 
freedom, and that all lines are green (Figure 3).

A BIT SKETCHY
We are going to add more to the sketch, though. Let’s 
click the 'create an arc' tool icon, but click its 
drop-down menu and scroll to the 'end points and rim 
point' option (Figure 4). Hover over the uppermost 
point of the left-hand vertical line until the point 
becomes yellow, single left-click, and then move 
across to the top point of the right-hand vertical line 
and left-click again – this creates the end points of the 
arc. Next, move up and towards the centre of the two 
vertical lines to finish the arc roughly in the correct 
place. To constrain the arc – as the end points are 
already constrained – we just need to set the radius 
of the arc. Highlight the arc line and then click the 
'constrain an arc or a circle' tool icon (15th from left, 
bottom row, in Figure 2), and in the dialog box, set 
the radius to 40 mm. We should now have a fully 
constrained sketch, with all lines turned green.

This sketch is the main outline of our bird feeder, 
so click 'close' on the sketch solver panel in the 
combo view window, and we will return to the part 
design workbench. Make sure that the sketch you 
drew is highlighted in the file tree, then click the 
'tasks' tab just above the file tree view. Click 'pad', 
and then type '15 mm' in the dialog box to set the 
thickness of the pad/extrusion (Figure 5).

For the rest of this project, we are going to create 
more sketches, but these sketches are going to be 
drawn onto faces of the pad object we have just 
made. The first job is to make a pocket for our bird 
feed to be contained in. So, left-click in the viewer to 
select the upper face of our object (Figure 6). Then 
click the 'create sketch' tool icon which should now 
bring you back into the sketcher workbench with the 
face of the pad we selected in view. Click the 'create 
a circle' tool icon (4th from left, top row, in Figure 2). 
Left-click and drag and left-click again to draw a circle 

Figure 4 
Some drawing tools 
have drop-down 
menus and options for 
their use, such as the 
'create' and 'arc' tools

Figure 5 
The part design 
workbench task 
menu tab

Figure 6 
Selecting a face and 
clicking the 'create 
sketch' tool to launch 
a sketch attached to 
that face

The first job is  
to make a pocket for  

our bird feed to be 
contained in

”
”

You can use the 
constraint tools in 
different ways – 
you can select the 
sketch item and then 
click the constraint 
tool, or you can 
select the tool first 
and then click the 
item or items. 

QUICK TIP
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of any size anywhere in the sketcher viewer. Use 
the 'constrain an arc or circle' tool we used earlier 
to set the diameter to 20 mm. Next, click to select 
the centre point of your circle, and then click the 
zero point of the axis at the bottom of the left-hand 
vertical line. To position our 20 mm circle, click the 
'horizontal distance constraint' tool we used earlier 
and set the distance to the midpoint of our feeder, 
which is 40 mm. Next, set the vertical height of the 
centre point of the circle relative to the zero point at 
30 mm. This should place it nicely centralised in the 
feeder design and should be fully constrained. Close 
the sketch, and with this new sketch highlighted in 
the file tree, click 'pocket' from the list on the 'tasks' 
tab. You should now see that it’s cutting our circle as 
a pocket into our bird feeder design. We set the depth 
of our pocket to 8 mm (Figure 7).

A STICKING POINT
To attach our bird feeder, we are going to create a 
pocket and a slot which we used to fit some rubber 
window suckers that we found in our parts drawer. 
The arrangement of the slotted pocket could allow 
the bird feeder to slot onto a couple of small screws. 
In the part design viewer, we rotated our bird feeder 
and selected the bottom of the design opposite to the 
pocket we had just created. As before with this 
selected, we clicked the 'create a sketch' tool. Next, 
select the 'create a rectangle' tool icon (8th from left, 
top row, in Figure 2). Draw two rectangles of any size 
anywhere in the sketcher window. Conveniently the 
rectangle drawing tool constrains the vertical and 
horizontal lines, so all we have to add is the line 
lengths and the positions. We made our rectangles 
10 mm by 6 mm. Then we used the zero axis point to 
locate the closest rectangle to it, 10 mm across and 
4 mm down from the straight edges of the design 
(using the horizontal and vertical distance constraint 
tools and a corner point of the rectangle, as we have 
done with other items). However, to position the 
other rectangle, we used a clever little function. By 
clicking the 'create an edge linked to an external 
geometry' tool (14th from left, top row, of Figure 2), 
we can select and import lines from the underlying 

object which aren’t in this sketch. We hovered over 
the 20 mm vertical line at the far edge of our bird 
feeder and selected it, once highlighted. This now 
creates an edge and points at either end to which we 
can attach objects or constraints. This means that 
instead of calculating the position of our other 
rectangle from the XY zero origin point, we can now 
constrain this by saying it is 10 mm and 4 mm from 
the opposite corner of the object; you can see where 
we connected that rectangle tool in Figure 8. 

Figure 7 
Setting parameters to create 
a pocket from a sketch

Figure 8 
Laying out sketches for 
further pockets in our bird 
feeder is made easier by 
importing geometry from pre-
existing parts of the design

Figure 9 
Selecting the back 
face of the bird feeder 
to draw the slots for 
the suction cups
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FreeCAD, Using the Part Design Workbench

In this tutorial, 
we have mainly 
created sketches 
on our object and 
pocketed them, but, 
of course, you can 
create sketches and 
extrude them just 
as easily using the 
'pad' tool. 

QUICK TIP

We closed the sketch  
and performed another 

pocket operation to a  
depth of 10 mm

”
”

Figure 10 
Fully constrained slot 
sketch ready to be cut 
as a pocket

Figure 11 
Selecting the entire 
upper face and adding 
a 2 mm fillet is easier 
than selecting the 
individual edges

Having constrained our rectangles sketch, we closed 
the sketch and performed another pocket operation to 
a depth of 10 mm. Next, we need to cut slots that go 
into these pockets, so we selected the face of the 
back of the bird feeder object that we need to sketch 
on and created a new sketch (Figure 9 overleaf).

FINISHING OFF
In this sketch we again imported and created an edge 
for the far side of the object and then used the 'create 
a slot in the sketch' tool (10th from left, top line, in 
Figure 2). This tool works similarly to the rectangle 
tool but creates a pill-shaped slot item. Similarly again, 
some of the edges and arcs are partially constrained. 
You can constrain these in multiple ways, but we 
opted to select two opposite points on either side of 
the slot and constrain the horizontal distance between 
them to 4 mm. We then constrained just one of the 
vertical lines to 10 mm as both sides are considered 
an equality. With a fixed width and height, there is no 

need to constrain the arc, and so we only needed to 
position the slot sketches in the correct places to 
coincide with our rectangular pocket. We used the 
point at the centre of the top end of each slot (the 
centre point of the radial arcs) to position the slots to 
coincide with the rectangle pockets – you can see 
these values in Figure 10. We closed the sketch and 
again performed a pocket, setting the depth to 5 mm, 
to cut into our rectangular pocket, but not deeper into 
the object.

Finally, we added a fillet to the edge of the top of 
the feeder and the feeder bowl by selecting the top 
face of the feeder and clicking the 'fillet tool' icon 
and setting the fillet radius to 2 mm (Figure 11). We 
covered usage of the fillet and chamfer tools last 
month in the part workbench, but they work similarly 
on the part design workbench.

Hopefully, you now have a feel for how sketching 
and constraints work – the great advantage being 
that, if you want to change a dimension or position at 
a later date, you can click through to find the 
underlying sketch constraint, edit it, and the whole 
design relating to that change will be updated. It’s a 
powerful and useful way to work.  
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FreeCAD, parametric parts, and other approaches 

n this tutorial, we’re going to add to our 
skills by exploring a small range of tools 
and approaches and making a variety of 
small project items. We’ll start by exploring 
the ‘Add a Thickness’ tool, look at using 
the Spreadsheet workbench, and working 

parametrically, we’ll bring these skills altogether to 
make an automatic box with lid generator. 

For a quick example of using the ‘Make a Thick 
Solid’ tool, begin in the part design workbench and 
create a new body. Create a new sketch in the body 
on the XY plane, then select the polygon tool to draw 
a hexagon. Start your hexagon on the 0,0 point of the 
axis so that it is positionally constrained. You should 
have a hexagon with two degrees of freedom. A 
simple way to constrain a hexagon is to make the 
uppermost line of the hexagon horizontal by selecting 
the line and clicking the ‘create a horizontal constraint’ 
tool. Next, you can select two nodes vertically 
above each other, and set a vertical distance to fully 
constrain the sketch Figure 2. 

I Close the sketch and then pad the sketch using 
the pad dialogue found on the tasks tab in the combo 
view window or by clicking the 'pad a selected 
sketch' tool icon.

We are going to now use the thickness tool to 
hollow out our hexagonal extrusion. Select the upper 
face of the hexagonal extrusion and then click the 
‘Make A Thick Solid’ tool. You should see instantly 
that the part now appears as a hollowed version 
of itself. In the thickness tool dialog, you can see 
the selected face and change various parameters 
(Figure 3). You can, of course, increase and decrease 
the thickness that is created. By default, the 
thickness dialog adds the thickness to the outside of 
the underlying geometry, so if you set the hexagon 
vertical constraint to 30 mm you now will have an 
object that is 30 mm plus the thicknesses. If you 
want to create an object that matches the external 
dimensions of the underlying geometry, click the 
‘make thickness inwards’ tick-box. You can also swap 
between Arc and Intersection, which essentially 

Design a variety of objects using numerous different tools and approaches

FreeCAD, parametric parts, 
and other approaches  

Figure 1 
Using a parametric 
approach means 
that we can create 
collections of similar 
parts with differing 
dimensions from one 
base model
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Figure 2 
Constraining a 
hexagon centred on 
the 0,0 co-ordinates 
only needs two other 
constraints to fully 
constrain it 

Figure 3 
Using the 'Make a 
Thick Solid' tool  
to make our  
padded hexagon 
object hollow

toggles between creating filleted edges or sharp 
edges on the thickness. 

Finally, if you want to apply a thickness but create 
an object which is more of a pipe than a bowl, you 
can click the ‘Add Face’ button. In the preview 
window, the original selected face reappears 
highlighted and you can select the opposite face. 
You should now have a hexagonal object with a wall 
thickness with both ends open. 

LET’S GET PARAMETRIC!
We looked at making multiple ’simple copies’ of 
parts using the ‘part’ menu on the part workbench 
in previous parts of the series. You can also use 
that approach to create simple copies of bodies that 
you have designed in part design. Sometimes we 
might want to make multiple similar parts, but with 
one or more dimensions changed – for example, if 
we were drawing a model of a 3D printer that used 
the common 2020 aluminium extrusion (Figure 1). 

One way we could make this easier is to draw an 
aluminium extrusion profile sketch, and then pad or 
extrude it multiple times to multiple lengths. As a 
workflow, we might choose to use the part design 
workbench to create a body for our original extrusion 
and then create multiple simple copies on the 
part workbench.

This is a very simple example that introduces the 
idea of working parametrically. Parametric work in 
CAD is where we can change the model geometry by 
adjusting parameters such as dimensions. Whilst only 
being one parameter, we can use this mini project 
to learn about using a spreadsheet to store and alter 
parameters for objects and sketches.

We downloaded an image with the dimensions of 
the 2020 extrusion and created a new project. On 
the part design workbench we selected to create a 
new body and then to create a sketch in the XY plane. 

We crudely drew a shape of the profile using the 
polyline tool and then worked through to constrain the 
sketch (Figure 4).

Having constrained the sketch, we checked how 
it looked by performing a ‘pad’ from the tasks menu, 
and we then added the external corner radius fillet 
and the chamfers at the edges of the extrusion slots. 
We could now, of course, just set a pad length of 
extrusion and then create a simple copy on the part 
workbench to create different length parts, but we  
want to learn how to use the spreadsheet function to 
further explore parametric work.

Let's move to the spreadsheet workbench using 
the workbench drop-down menu, and click the  

Often in this article, 
we have described 
tools using the 
text that appears 
when you hover 
the mouse over the 
tool icon. This is a 
great way to find the 
tools or explore a 
new workbench.

QUICK TIP

OTHER OPTIONS
The thickness tool is an excellent way to quickly create 
hollow geometries, but it does have some limitations. 
It can fail to work with more complex shapes; things 
like curvy cones can be its nemesis. In the next part, 
we’ll begin to look at ‘Lofting’ tools, which enable us to 
create hollow parts with curved walls and more. 

Parametric work in CAD 
is where we can change 
the model geometry by 
adjusting parameters

”
”
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FreeCAD, parametric parts, and other approaches 

‘create a new spreadsheet’ icon. You should now 
see a spreadsheet open in the preview window 
in a separate tab (Figure 5). This is very handy, 
as it allows quick switching between the model 
and the spreadsheet. If you close the spreadsheet 
tab, the spreadsheet is still an item in the file tree 
view and you can double-click to open it. The 
spreadsheet functions are very capable, and similar 
to standard spreadsheets you may have used in 
office software. For this simple task, we are going 
to write the label ‘Length’ in cell A1, and then in 
cell B1 we can type a length we want our extrusion 
to be. When we type a dimension into a constraint 
in the sketcher, it interprets that number as the 
units you use throughout FreeCAD, which can be 
set in the preferences menu. In our case, this is 
millimetres and will be the case for our spreadsheet 

values, so we don’t need to define our input units in 
the spreadsheet.

Set cell B1 to 100 and click back onto the preview 
tab with the model in it. Reopen the pad by double-
clicking on the pad in the file tree. In the input box for 
‘length’ you should see the current pad length value, 
but you should also see a blue circle icon on the right-
hand side of the box . Click this to open the formula 
editor (Figure 6). In this input box, now start to type 
‘Spreadsheet’. You should find that it automatically 
suggests the word spreadsheet as you start typing. 
Click the suggested ‘Spreadsheet’ from the drop-
down and it should insert the word spreadsheet 
followed by a full stop. After the full stop, we need 
to input the cell location of the cell from which we 
want it to take its value. If you type ‘B’, it again 

should automatically suggest ‘B1’ as a value. This 
autosuggestion is useful when we come to projects 
with numerous cells of data in a spreadsheet, as it 
will only suggest cells that have data in them. Click 
the ‘B1’ so that the value in the formula editor reads 
‘Spreadsheet.B1’, as in Figure 6.

Returning to the preview tab with the model in, you 
should see that the extrusion body is now padded 
or extruded to the 100 mm length. You can now 
create multiple simple copies from the body using 
the ‘create a simple copy’ tool in the ‘part’ drop-down 
on the Part Workbench, changing the length of the 
original body copy in the spreadsheet, as in Figure 1.

Having explored using both spreadsheets and the 
thickness tool, let’s combine our new skills and create 
an automatic parametric box generator. This simple 

Figure 4 
A basic sketch of 
the 2020 profile. We 
added chamfers and 
fillets once the sketch  
was padded

Figure 5 
The spreadsheet 
workbench, with our 
spreadsheet opened 
in its own tab in the 
preview window

Figure 6 
Clicking the circular 
blue box in the corner 
of any input box takes 
you to the formula 
editor, where you can 
link the value to a 
spreadsheet, amongst 
other functions

This autosuggestion is useful 
when we come to projects with 

numerous cells of data  
in a spreadsheet

”
”
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project makes it easy to create a box and lid of any 
size that we could 3D-print or CNC-machine. 

Let’s begin by creating a new project. In the new 
project, go to the spreadsheet workbench and create 
a new spreadsheet. For the main body of our box, we 
are going to need four parameters: the box length, 
width, height, and the wall thickness. Create labels for 
these parameters in cells, and in adjacent cells input 
some initial values (Figure 7).

Next, jump to the part design workbench and create 
a body and a sketch in the XY plane. We are going to 
draw a rectangle around the zero point and then, at first, 
constrain it to always be centred around the origin point 
of the sketch. Draw the rectangle and then click the 
‘create a symmetry’ constraint tool. Use the symmetry 
constraint tool to select the upper right-hand node, the 
upper left-hand node, and the vertical Y axis line. Repeat 
this for the upper right and lower right nodes, and the X 
axis line. Now the rectangle should always be centred 
around the 0,0 co-ordinates, regardless of its size. 

Next, let’s add a constraint for the box length 
by selecting the top line and clicking the ‘Fix the 
horizontal distance’ tool. In the input box, click 
the blue circle formula editor button and insert 
‘Spreadsheet’, followed by the cell location for the 
box length, which in our case was B2. Repeat this for 
the vertical line to set the box width, and the sketch 
should now appear fully constrained.

Close the sketch and perform a ‘pad’ task to 
extrude the box; set the pad dimension to receive 
the input from the box height cell in the spreadsheet. 
Next, we will click the upper surface of our box and 
use the thickness tool we explored earlier to hollow 
out our box. To set the thickness, we are going to link 
the thickness value in our spreadsheet. All being well, 
you should now have a hollow box in the preview 
window (Figure 8).

To make a lid, we are going to do the same process 
as we did to make the box section, but we are going 
to use some simple formulae so that the lid is 
generated to fit whatever dimensions are of the box 

created. On the part design workbench, click to create 
a new sketch on the XY plane. We don’t need to 
import any geometry from our first sketch, but let’s 
draw another rectangle and place it along the x axis 
so it isn’t on top of our box base. To positionally  
constrain this lid rectangle, select the upper left 
corner node and the sketch origin point at 0,0 and set 
a horizontal distance constraint. For the value of this 
constraint, we have linked the spreadsheet cell that 
holds the box_length value. This means that the lid  

Figure 7 
The spreadsheet set up 
for our box generator 

Figure 8 
Using the spreadsheet 
and the thickness tool, 
we have a parametric 
hollow box ready to 
make a lid for

Figure 9 
Laying out the sketch 
for the box lid, making 
sure it will always be 
positioned away from 
our box
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Figure 11 
The box now 
complete with a  
fitting lid laid out  
on the XY plane

Figure 10 
Adding a small 
formula to a cell 
to automatically 
generate the 
dimension needed 
for the lid length

an input value for the lid height. We constrained 
the length and width of the lid sketch by adding 
constraints linked to our calculated dimensions in the 
spreadsheet. We then performed a pad using the 
lid_depth value and, in turn, applied a thickness to 
the lid using the thickness value in the spreadsheet. 
You now have an automatic box generator at your 
disposal! Simply change the parameters in the 
spreadsheet and it will automatically generate your 
box with a fitting lid (Figure 11).  

will always be away from the box with a gap in 
between them (Figure 9).

Next, select the upper right and lower right nodes 
and the x axis line, and create a symmetry constraint. 
To create the length and width of the lid, we are 
going to create two new labels in the spreadsheet 
and create two new cells to hold this value. However, 
we are going to insert a small formula in the cells to 
generate these values. The value for the length of 
the lid will be equal to the box length value plus twice 
the value of the wall thickness. It will also need a 
clearance to make the lid fit over the box. We have 
created a label and a cell called ‘clearance’, and put 
in a value of half a millimetre which we will add to 
each side of the lid. So, to create the value of the 
lid_length in that cell, we input the formula to multiply 
the thickness and the clearance by two and add them 
to the box length. To add this formula, highlight the 
target cell and type it into the formula bar (Figure 10).

To finish the lid, we added the formula for the box 
width, using the same formula for length, except 
using the box width dimension. We also created 

LINING UP
Once you have your box generator set up, you can 
generate boxes of any dimensions easily. The layout 
on the XY plane means that the box and lid will 
be easy to export and 3D-print, as both parts are 
modelled in a way that emulates them sitting on the 
print bed. If you wanted to look at your box with the lid 
in position, again you could create a simple copy on 
the part workbench and move and rotate those parts 
into the correct position. 

When working on 
a sketch like the 
2020 extrusion, 
using the ‘create an 
equality’ constraint 
tool is helpful 
on lines that are 
relatively the same 
in each quadrant of 
the sketch.

QUICK TIP

You don’t have 
to draw the 2020 
extrusion to learn 
this technique 
– you can just 
draw a simple 
square instead!

QUICK TIP
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FreeCAD: let’s get curvy!

irst up is the Additive Loft function, 
which is a method that creates straight 
or curved transitions between sketches 
– it’s a great way of creating complex 
flowing shapes. To start with, we will 
make a nonsense object just to see how 

it works, and then we will create a small ornamental 
bowl that can be 3D-printed.

On the part design workbench, create a new body 
and then create a new sketch on the XY plane – this 
should move you onto the sketcher workbench. Select 
the rectangle tool and draw a rectangle in this sketch. 
As this is a test, we don’t need to add constraints, so 
close this sketch now. In the part design workbench 
again, within the same body, create a second sketch. 
Click the 'New sketch' button, and select the XY plane 
for our second sketch.

In this second sketch, use the regular polygon tool to 
draw a hexagon that is smaller than the rectangle you 
drew – draw it inside the rectangle, and don’t worry if it 
overlaps a little.

F
Figure 1 
Two sketches in the XY plane 
with one sketch raised above 
the other on the Z-axis

Figure 2 
Using the lofting tool 
can create pleasing 
curved results

Again, we don’t need to constrain the hexagon, so 
close the sketch. The next step is to move the hexagon 
sketch away from the rectangle sketch in the Z-axis. 
As both of the sketches are part of the same body, we 
can’t move the basic position of the hexagon sketch, 
but we can move the relative attachment point of 
the sketch. With the sketch containing the hexagon 
selected, you should see the dialogue box for the 
sketch in the combo view panel. In this dialogue box, 
there are three sections of values separated under 
the headings 'Attachment', 'Base', and 'Sketch'. 
Making sure you are in the Attachment section, click 
the Attachment menu, and then click to expand the 
Position menu. In this drop-down menu, adjust the 
Z-axis to raise the hexagon sketch over the rectangle – 
this can be any amount, but we went for 20 mm. If you 
are in an isometric view in the part design workbench, 
you should see the hexagon sketch rise above the 
rectangle sketch (Figure 1). 

Next, select the original rectangle sketch in the file 
tree view, and then click the yellow and red 'loft a 

Add bendy transitions to your parts for a more elegant look

FreeCAD: 
let’s get curvy!
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selected profile through other profile sections' tool. In 
the combo view panel, you should now see a window 
– click the 'Add section' button. Having clicked that, 
select the hexagon sketch in the preview window. As 
you do this, you should see a preview of the lofted part 
connected between the rectangle and the hexagon. 
There are a couple of checkboxes you can click: one is 
called 'closed' which will close the ends of the lofted 
object, and the other is 'ruled surface'. Clicking 'ruled 
surface' toggles the lofted object between having either 
straight line/plane geometries or curved. It is not that 
obvious a difference with our simple example, but we 
will use this in our next lofting project.

To finish, click the 'closed' checkbox and then OK 
to perform the loft. In the preview window, you will 
now see the resulting object. Lofted objects are like 
any other in that you can use other tools on the objects 
created with them, such as selecting edges for fillets. 
However, when the surfaces generated become 
complex and curved, you might find that some tools 
don't work and we need a different approach. 

One thing people often try with the lofting tool is 
to apply a thickness to the resulting object to hollow 
it out. Sadly the thickness tools only work on simple 
geometries, so it’s not possible to work this way. 
However, let’s make a more interesting lofted object – 
the bowl pictured in Figure 2 – and show how we can 
create curved objects with defined thickness walls. 

In a new project, create a body and create a sketch 
in the XY plane. Draw two circles constrained around 
the origin point and make one slightly smaller than 
the other; the distance between them will create the 
wall thickness of our object. We made our sketch with 
the outer circle having a diameter of 25 mm and the 
inner circle having a diameter of 22 mm, to give a wall 
thickness of 1.5 mm (Figure 4). 

Close the sketch and then create another sketch in 
the XY plane. Create a larger pair of circles, but with the 
same wall thickness – we went for 45 mm and 42 mm. 
Close this sketch and then create a third sketch with a 
pair of circles constrained to match the first set we drew.

With the second sketch highlighted, move these 
circles up the Z-axis using the same method we used 

earlier with our hexagon. Move it up by 25 mm. Next, 
do the same with the third sketch, moving it up the 
Z-axis 60 mm (Figure 5). Create the loft in a similar way 
to the earlier example, starting by selecting the first 
sketch and then adding the second sketch and the third 
sketch in that order. If you uncheck the ruled option and 
the closed option, you should end up with a nice curvy 
shape, as shown in Figure 2.

Adding one final sketch of a circle matching the outer 
diameter of the lowest sketch in our bowl means that we 
can pad/extrude to add a base to our ornamental bowl.

Sweeping along a path is a similar idea to revolving 
a sketch and also shares some attributes of lofting. 
However, sweeping uses a user-drawn path or 
geometry that the extrusion is swept along, rather than 
an automatically generated one. There are a couple of 
approaches to sweeping in FreeCAD: one using the part 
workbench, the other using the part design workbench. 
Let's look at both to have both methods in our skill set.  

Figure 3 
Our completed  
loft experiment

Figure 4 
In this approach, the 
two circles in each 
sketch represent the 
wall thickness of our 
bowl design

Figure 5 
The three sketches  
for our lofted bowl  
laid positioned on  
the Z-axis

Figure 6 
The first sketch which 
forms the profile  
for our curvy 
extrusion using the 
sweep function
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Starting on the part design workbench, create a 
new project, create a body, and create a sketch in the 
XY plane. In the blank sketch, make a small closed 
shape around the origin point. We drew a square and 
then added some fillets in the corners by clicking the 
'create a fillet between two lines or at a coincident 
point' tool. With the fillet tool selected, click on some 
corners of the square to add some fillets, and resize 
them to make an interesting shape. This shape will 
be the profile of our item we extrude by sweeping it 
along a path (Figure 6 overleaf). Again, constraining 
the sketch is unimportant for a simple exploration of 
the tool.

Close the sketch and then create a new empty 
sketch in the body. Create this new sketch in the XZ 
plane. In this sketch, we are going to create the path 
along which our first sketch profile will be swept. Let's 
use 'create a B-spline in the sketch' tool. This tool 
allows us to create a combination of curves in a single 
line. With the B-spline tool selected, left-click over the 
origin point in the sketch and pull a line up and to the 
right or left of vertical, then left-click again and continue 
with the next line upwards and back towards the centre 
line. Left-click again and move back out to the right and 
upwards to create a skewed kind of Z-shape. Left-click 
to set the next point, and then right-click to finish the 
B-spline. The two lines you drew should now become 
curved, and you should see some blue circles. Simply, 
for now, moving the circles allows you to adjust the 
curve of the lines. Make a nice swooping curve, such as 
the one we created (Figure 7).

Close the sketch, and in the preview window, you 
can rotate your view a little and see that the curved 
edge we created starts at the origin point, which is in 
the middle of our profile sketch (Figure 8). To sweep 
the profile along the curved path, highlight the first 
sketch we made and then click the yellow and red 
'sweep a selected sketch along a path' tool. You should 
see a dialogue box appear in the combo view panel. In 
the dialogue box, we need to select the path or object 
along which to sweep. We can do this in a couple of 
ways. We can either click the 'Object' button under the 
'path to sweep along', or we can click the 'Add Edges' 
button. Having clicked either of these buttons, we can 
then select the curved path in the preview window. You 
should now see a brown preview of the profile swept 
along our path. Click 'OK' to finish the sweep. You 
should now have a nice swept object in the preview 
window (Figure 9).

There are many other options in the sweep utility in 
the part design workbench that can change the way 
that corners are handled in a swept object, and also 
how it handles transforming from one profile to another 
profile over the course of a sweep, which we will 

Figure 7 
A sketch in the  
XZ plane using  
the 'create a B- 
spline' tool

Figure 8 
The profile sketch, 
and the path to sweep 
the profile along

Figure 9 
The completed object 
with the profile sketch 
swept along the  
target path sketch

MAKING PIPES
The part design workbench sweep tool creates single 
solid body objects, but we can apply some techniques 
we learnt in the last chapter, where we used the 
'Create a thickness tool'. As a quick recap, select 
the face of one end of our swept solid object and 
click the thickness tool. In the dialogue box, you can 
set the thickness of the wall structure, and to make 
it a pipe object open at both ends, click 'Add face' 
and then additionally select the opposite end of the 
swept object. 
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explore on the part workbench shortly. The other thing 
of note on the part design workbench is that there is 
a blue and red icon that is the same as the sweep tool 
we used, except that it's for subtractive sweeps. This 
means you could draw a solid object and then cut out 
and remove a swept path through it.

Finally, let’s look at the sweep utilities on the part 
workbench, which are laid out a little differently. We will 
also create two profiles and a path, and the profile will 
be transformed from one shape to the other along the 
path. Let's create a new project and go directly to the 
Sketcher workbench. Create a new sketch in the XY 
plane and then draw a circle anchored around the origin 
point – it is up to you if you want to constrain it or not for 
this example. Close that sketch and then create a second 
sketch, again in the XY plane. In this sketch, let's draw a 
square – which should be a similar size to the circle we 
drew in the first sketch – around the origin point. Close 
this sketch, but highlight it in the combo view panel 
so that the dialogue box options for the sketch appear 
below it. We are going to move the position of the 
sketch so that it shifts vertically 70 mm up the Z-axis. In 
the sketch dialogue box under the 'Base' heading, open 
the drop-down menu labelled 'Placement' then, in turn, 
open the drop-down menu labelled 'Position'. In this 
menu, change the Z-axis value to 70 mm.

You should be able to see in the preview window 
that the square is now above the circle. Next, making 
sure nothing is selected in the file tree, add a third 
sketch with this sketch drawn on the XZ plane. Using 
the 'create an edge linked to an external geometry' 
tool, click the horizontal line that is on the upper square 
sketch. Next, use the B-spline tool to create a nice 
curved line which starts at the origin point and curves 
up to reach the centre of the upper square sketch. Then 
close the sketch, and you should have three sketches 
roughly similar to Figure 10.

Moving to the part workbench, click the 'utility to 
sweep' tool. In the dialogue box, you should see the list 

of sketches on the left-hand side. In turn, select the first 
sketch containing the circle, and click the right-facing 
arrow that becomes highlighted to move the sketch 
into the 'selected profiles' column. Repeat this for the 
second sketch – the sketch that contains the square 
(Figure 11). Next, click the 'Sweep path' button, and 
the dialogue box will become greyed out. Click the path 
you want to sweep along in the preview window to 
turn it green, and then click the curved path we created 
earlier (Figure 12). Next, click 'Done' and then click 
the 'OK' button. You should now see the circle profile 
has been swept towards the square on our curved 
path, and it has transformed throughout the curve to 
conform to the square profile. In the file tree, this is 
now a 'sweep' object, and double-clicking the sweep 
object doesn’t allow you to edit the sweep, but rather, 
opens the dialogue box to move and rotate the part. If 
you want to change any sweep parameters, you must 
select the sweep object and delete it, which will return 
you to just having the three separate sketches, and 
then repeat the sweep utility process. In the dialogue 
box for the sweep utility, you can select to make the 
object a solid; then, you could create a simple copy and 
then use the thickness and other tools and utilities.  

Figure 10 
Three sketches ready 
for sweeping on the 
part workbench

Figure 11 
Adding the profile 
sketches in the 
sweep utility

Figure 12 
Adding the path  
that the sweep  
utility will follow

When you are 
drawing the 
third sketch, the 
circles will appear 
exactly on top of 
the first sketch. 
To make it easier, 
make the original 
sketch invisible by 
highlighting it in the 
file tree, toggling 
visibility by pressing 
the SPACE bar. 

QUICK TIP
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FreeCAD: technical drawings

any users will be using FreeCAD 
to model in 3D to produce files 
that can be sliced and printed 
on a 3D printer. Other users, 
however, will be perhaps designing 
parts that they want to create using 

subtractive methods, like lathes or milling machines. 
Some will be using bench-fitting techniques to cut, 
drill, and file to hew parts from materials. To share 
the information needed to manufacture a part, 
the standard practice is to use technical drawings. 
Drafting a technical drawing using pencil and paper 
and a drawing board is a fantastic skill to have, but 
it can be difficult to master. FreeCAD (Figure 1) 
simplifies the creation of technical drawings from 
3D models by having a dedicated technical drawing 
workbench called ‘TechDraw’.

To work through an example of creating a technical 
drawing, we need a 3D model to use. Let’s quickly 
draw an item using simple techniques we learnt in 

M the first parts of this guide, using the Part Design 
workbench.

Create a new project and, on the Part Design 
workbench, create a body and then a sketch in the 
XY plane. Using the ‘Create Polyline’ tool, create a 
shape similar to Figure 2. We don’t necessarily need 
to constrain the entire model or sketch to use the 
TechDraw tools, but it’s useful in this case to have 
all the dimensions constrained so we can compare 
the dimensions on the drawing (more on why that’s 
important later).

Having drawn the outline, add a circle in the 
object, and then close the sketch and perform a pad 
operation on the sketch to create our part. Finally, 
before we jump into the TechDraw workbench, 
add a fillet to an external edge with a 7 mm radius. 
Having an internal hole and an external radius and 
an angled edge gives us enough details to do a 
good demonstration of the TechDraw workbench 
tools – see Figure 3.

To begin playing with TechDraw, select the 
TechDraw workbench from the drop-down menu. 
Click the ‘Insert Default Page’ tool icon and you should 
have a new tab in the preview window with an empty 
technical drawing page in it – Figure 4, overleaf.

You can see that the new ‘page’ is listed as 
an object in the file tree. Switch back to the tab 
that contains the 3D model and you’ll notice that, 
despite switching tabs, you are still in the TechDraw 
workbench. As an experiment, move the model so 
that it is at an angle rather than in one of the ‘front, 
top, back’ type views. Next, ensuring the body is 
highlighted in the file tree, click the ‘Insert View’ tool 
icon. If you switch to the ‘page’ tab, you should see 
the 3D object has been added to the drawing in its 

exact view, at the angle it 
appears on the live preview. 
It’s important you know that 
it does this, because if your 
object is slightly at an angle, 

Explore the TechDraw workbench and create technical drawings of our FreeCAD projects

FreeCAD: 
technical drawings 

Figure 1 
FreeCAD allows 
the easy creation of 
technical drawings of 
our 3D parts
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Figure 2 
The basic sketch of 
our test object to 
explore the  
TechDraw workbench

Figure 3 
Our object, now 
padded and with 
a 7 mm radius 
fillet added

you might not notice, but it can affect dimensions 
in technical drawings added later. On the ‘page’ tab, 
you should have a dashed line around the ‘view’ – 
these are referred to as the ‘View Frames’. Clicking 
the frame and dragging allows you to move the view 
around the technical drawing page. Highlighting 
the frame and clicking delete allows you to remove 
it. Click and delete this angled view and let’s have 
another go. Return to the preview window and, 
using either the view icons, or the rotation block, 
select the ‘top’ view. Repeat the process of clicking 
the ‘Insert View’ tool to add the view to the page, 

(Figure 5, overleaf). You’ll notice that all the lines in 
the drawing have the vertices marked as dots (similar 
to the Sketcher layout). The vertices help us to add 
dimensions and other tasks, but they are part of the 
view frame. You can toggle the view frames on and 
off by clicking the ‘Turn View Frames On/Off’ icon, or 
by right-clicking and selecting ‘Toggle Frames’.

Our simple test piece design doesn’t need masses 
of views to be able to show all of its attributes and 
dimensions, but we would definitely need another 
view adding to show the thickness of the part. Later, 
we will look at automatically generating multiple 
views of a part which adhere to technical drawing  

Our simple test piece design 
doesn’t need masses of views 

to be able to show all of its 
attributes and dimensions

”
”

GETTING SET UP
Before we add any views to our new page, we need to 
make an important change in some preferences so that 
the centres of circles and arcs are marked when they 
are drawn in TechDraw views. Making sure you are on 
the TechDraw workbench, go to Edit > Preferences and 
then scroll down the left-hand side to the TechDraw 
icon. On the TechDraw preferences window, click 
the ‘Annotation’ tab and make sure the ‘Show centre 
marks’ and ‘Print centre marks’ boxes are checked. 
Click Apply, and then OK to close Preferences.
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conventions, but for now, let’s just add another view. 
Do this manually as we did with our top view. Return 
to the 3D model preview, and move the model so we 
are in a left- or right-hand view, then click the ‘Insert 
View’ button.

Next, let’s add some dimensions to parts of 
the views so that someone could make this part 
accurately. It’s similar in feel to adding constraints in 
the Sketcher workbench. First, let’s select the long 
line/edge at the base of our object in the front view 
on the technical drawing page. Then click the yellow 

‘Insert Horizontal Dimension’ tool icon. You should 
now see a dimension appear in the drawing. Similar 
to the Sketcher workbench, you can click and drag 
this dimension to different areas to organise where 
the labels are. Adding the height of the 3D object is a 
similar task, except we don’t have a single complete 
line from the bottom to the top of the object, so we 
will use vertices instead. Similar to the vertical and 
horizontal constraints in the Sketcher workbench, 
TechDraw can create a vertical dimension between 
two points, even if they don’t sit on the same edge. 

You can click and drag this 
dimension to different 
areas to organise where 

the labels are

”
”

Figure 4 
Starting a first 
technical drawing 
by inserting a 
blank page

If a linked dimension 
doesn’t update 
straight away, clicking 
and moving the 
dimension slightly 
often refreshes it.

QUICK TIP

ANNOTATIONS

Most technical drawings will have some details added 
as text; in our default template, we have some text 
boxes set up in the lower right-hand corner. These 
include common details you might wish to add to a 
technical drawing, including the title, designer name, 
date, scale of the drawing, and more. With the view 
frames turned on, you should notice that each text 
area has a small green block. Clicking on the green 
block allows you to edit and insert the text that you 
want to add. You’ll also notice that there are some 
blank boxes with no text inserted. You can add text 
anywhere on the document by using the ‘Insert 
Annotation’ tool. Clicking the tool, you should see a 
view frame appear labelled ‘annotation’ with ‘default 
text’ written in it. To edit the annotation, select the 
view frame either by clicking it in the preview, or 
selecting it in the file tree view. In the combo view, 
you should now see the editable parameters of 
the annotation, which include common text editing 
options like font and size. At the top of the annotation 
parameters, you should see ‘Text’ and the ‘Default 
Text’ that is stored within it; click the ellipsis icon (the 
three dots to the right) and in the pop-up window you 
can input text. Note that it doesn’t use text wrapping, 
and you need to click the RETURN key to create a new 
line of text. In the image above, we have filled in the 
default drawing details with the editable text boxes, 
but also added the lines about the part tolerance and 
surface finish by adding an annotation box. Notice 
we also added some text in an annotation box outside 
the default drawing text boxes, as you can add an 
annotation frame anywhere in the drawing.
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Slightly differently than the Sketcher workbench, 
when you want to select multiple vertices, you need 
to hold the CTRL key down. Select the right-hand 
vertex on the bottom edge of our object and the 
highest vertex on the right of the small bit that sticks 
up at the top of the design. Click the ‘Insert Vertical 
Dimension’ tool to add the dimension and note 
that it correctly adds the vertical distance between 
the points – not the distance along a straight line 
between the points.

Holes in designs in technical drawings are 
commonly annotated with the diameter rather than 
the radius, often as the maker will be wanting to 
know what size drill or reamer to use. Adding a 
dimension for the diameter of our hole is similar to 
adding a radius constraint when we drew the circle 
in Sketcher. We simply select the circle and then 
click the yellow ‘Insert Diameter Dimension’ and 
the diameter of our hole is displayed. To indicate 
the co-ordinate position of the hole centre, we can 
select the centre mark and apply horizontal and 
vertical dimensions relative to another vertex. We 
have selected the lower left-hand corner of the 
object to act as this datum point and, of course, you 
could repeat this for the centre marks of the arc 
of the fillet. Most technical drawings would have a 
radius of the arc marked, rather than a diameter, and 
this would apply to our fillet arc. To add this, simply 
click the arc line and then click the ‘Insert Radius 
Dimension’ tool – Figure 6.  

Figure 8 
Linking a drawing 
dimension back to 
the model is  
useful in angled 
isometric views

Figure 5 
Our first view of our 
object inserted into 
the new drawing

Figure 6 
Our view of our 
object with most 
dimensions added 

Figure 7 
Adding a line length 
to an isometric 
view can create an 
incorrect dimension, 
as seen here
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This is a very useful function at 
times, but also it hints at the 

way TechDraw handles  
line/edge length

”
”

To add a dimension showing the angle of the 
left-hand side line, relative to the base of the object, 
select both these lines and click the yellow ‘Insert 
Angle Dimension’ tool icon. Whilst it’s not often 
necessary, sometimes we might want to add 
the actual length of a line rather than a vertical or 
horizontal and, to do this, let’s select the angled line 
and click the yellow ‘Insert Length Dimension’ tool. 
This is a very useful function at times, but also it 
hints at the way TechDraw handles line/edge length 

and a possible problem. If we return to our 3D object 
in the live preview, click the ‘Set to Isometric View’ 
icon from the collection of blue view icon tools. 
With the object now at an angled isometric view, 
let’s add a new view to our TechDraw page. Move 
to the technical drawing page and move the new 
view so that it’s clear of other views. Select one of 
the long lines that is the base of our object and click 
the ‘Insert Length Dimension’ tool. If you compare 
the dimension you have just added to the very first 
horizontal dimension we added on our first view of 
the object, you’ll notice that they are different. This is 
because the TechDraw dimensions default to being 

Figure 9 
Selecting views to 
insert multiple views 
in one pass

WHICH ANGLE?
Technical drawing in itself is a massive field to 
learn about, and there are numerous standards and 
systems in place governing technical drawings. 
One set of standards relate to the projection 
angles which affect where views are positioned in 
a technical drawing. These two projection views 
families, ‘First Angle’ and ‘Third Angle’, are both used 
but create a technical drawing laid out differently. 
First angle drawings are more common outside of 
North America, whereas in North America third 
angle is more common. It’s important that you 
indicate that you are using a first or third angle 
projection on a technical drawing and that you only 
use that type of view and don’t mix them. Commonly 
on technical drawings, you indicate whether a 
drawing is first or third angle by adding the correct 
icon, as seen in the image below.

It’s quite complex to explain the difference, 
and there are numerous different approaches to 
explaining first and third angle. 

A good place to start is this Wikipedia page: 
hsmag.cc/Angle.

http://hsmag.cc/Angle


35

based off the view drawing rather than the actual 3D 
object, so the actual length of the angled line in the 
isometric view drawing is shorter (Figure 7, overleaf).

If you wanted to add an isometric view with some 
dimensions added, you can overcome this problem 
by linking a dimension to the 3D object. First, 
highlight the incorrect dimension we just added to 
the isometric view, and look in the file tree view to 
identify the name of this dimension. In our example, 
this was ‘Dimension012’. Having noted that, click 
over to the 3D object tab and highlight the same 
edge on the 3D object. Next, click the yellow ‘Link 
Dimension to 3D Geometry’ tool. In the combo view, 
you will see a window with a list of dimensions in a 
left-hand column. Select the dimension name that 
we noted earlier and then click the right-facing arrow 
to bring that dimension name over to the right-hand 
column – Figure 8, overleaf. Click OK at the top of the 
menu and return to the technical drawing page tab. 
You should now see that the dimension has updated 
to the correct length of the 3D object.

Having played with the TechDraw tools a little, let’s 
delete our practice drawing and start again, looking 
at a couple of things that might make the process 
quicker now we know how some of the tools work. 
Select the page we were working on in the file tree 
and delete it. To create a new page for our technical 
drawing, let’s click a different icon: the ‘Insert Page 
Using Template’ icon that looks like an orange folder. 
This opens a folder containing different templates for 
technical drawings. There are some things that will 
appear obvious to you, like there are different page 
sizes: A4, A3, A1, etc. There are also some templates 
that adhere to particular technical standards, such 
as the American National Standards Institute (ANSI) 
and the International Organisation for Standardisation 
(ISO), which may be of use if you want to make 
standard-compliant drawings. Let’s use a page called 
‘A3_LandscapeTD.svg’.

Make sure that the 3D object is in the top view 
in the preview and highlight the body in the file 
tree. This time, instead of clicking to insert a single 
view, let’s use the ‘Insert Multiple Linked Views Of 

GETTING CENTRED
Technical drawings often use centre lines and hatching and other effects to make them 
more readable. Adding a patterned centre line is possible, and you can use a face, two 
vertices, or two lines as a reference. As a quick example, click the face of our object in 
the front view to select it and then click the ‘Insert Centre Line’ tool icon. In the dialog 
box you can adjust the position and appearance, but for now just click OK and a dashed 
line should appear vertically through our object. A centre line is classed as a ‘cosmetic 
object’ and as such doesn’t appear in the file tree. To remove the centre line we just 
created, you need to select the centre line and then click the ‘Remove Cosmetic Object’ 
icon, which looks like an eraser. To add hatching to a face, select the face and then click 
the ‘Apply Geometric Hatch To Face’. In the dialog you can change various settings such 
as the pattern, line weight, and colour.

Drawable Objects’ tool icon, which should be next to 
the template folder icon. If you now click to the ‘page’ 
tab, we can see any changes we make in the dialog 
box live on the template.

In the dialog box, the first thing you will see is a 
projection menu. Let’s use first angle, as our template 
indicates the drawing will be in first angle projection. 
For this example, we don’t need to scale the 
drawings as it’s quite a small object. However, you 
can play with selecting a custom scale and changing 
the values, which is useful if you want to scale down 
a large object on the plans. Further down you will see 
an arrangement of checkboxes that correspond with 
the multiple views that will be added to our drawing. 
Select the pattern we have selected in Figure 9 
and click OK. On the technical drawing, you should 
now have the corresponding views automatically 
inserted. To move linked views is slightly different 
as it always aligns the projection of the main views 
to the centre view. To move all the views as a group, 
move the centre view; to move the upper, lower, and 
side views, you can push and pull them relative to 
the centre view. The exception is our isometric view, 
which we can move anywhere in the page.

As ever with FreeCAD, there’s heaps more we 
could look at on this workbench alone, but hopefully 
you are well on the path to creating beautiful and 
useful technical drawings for all your project needs.  

To export and print 
your technical 
drawing at any 
time, simply right-
click anywhere 
in the drawing 
to get a range of 
output option. 

QUICK TIP

Left 
Figure 10. Adding text 
can help your viewers 
understand what’s 
going on
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FreeCAD: add-on workbenches and interlocking parts

fter looking at how we install 
additional workbenches, we 
will focus on using an excellent 
workbench called ’Laser Cut 
Interlocking’ or ’LCInterlocking’, 
which offers some useful tools 

for those working on designs destined for a laser 
cutter or CNC router. 

To explore the amazing array of add-on 
workbenches, you’ll need to be connected to 
the internet. You can view the available add-on 
workbenches from any workbench in FreeCAD by 
simply clicking Tools > Addon Manager. The Addon 
Manager will then check all the available add-on 
workbenches – it may take a few seconds for the 
list to appear as it checks it’s up to date. You should 
end up with a list that looks like Figure 2. 

Before we install the workbench we’ll be using 
in this article, scroll around the list. If you highlight 
a workbench on the list, information about it will 
appear on the right-hand side of the window. It’s 
incredible what workbenches there are! Like all 
of FreeCAD, the add-on workbenches listed in 
the Addon Manager represent many thousands 
of hours of voluntary contributions by FreeCAD 
community developers, covering a vast array of 

subjects and interests. From aeroplane design 
tools to computational fluid dynamics to 3D print 
slicing engines – there’s a lot to explore. Installing a 
workbench is as simple as selecting it in the list and 
then clicking Install. Behind the scenes, FreeCAD 
connects to the workbench code repository online 
and downloads and installs the latest version. It’s 
then simple to update a workbench when new 
features are released. It’s just a case of clicking 
’Install/update selected’ on the relevant workbench 
in the Addon Manager. 

The workbench we are going to look at is called 
’LCInterlocking’ – it’s described as the ’FreeCAD 
Laser Cut Interlocking Module’. Go ahead and click 
install. Once installed, the Addon Manager will 
prompt you to close and restart FreeCAD to finish 
the installation. Once FreeCAD has restarted, let’s 
create a small project to explore the tools on this 
new workbench.

The LCInterlocking workbench has tools that 
allow a collection of parts in FreeCAD to be pulled 
apart and laid out flat. It then has tools that enable 
us to create a two-dimensional projection of the part 
shapes that we can export in various file formats 
(DXF, SVG, etc.). While it’s predominantly, as the 
name suggests, aimed at laser cutting, it also can 

Use add-on workbenches to make interlocking parts

A

FreeCAD:
add-on workbenches 
and interlocking parts
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Figure 1 
Our box, complete 
with automatically 
generated 
interlocking tabs, and 
ready to be flattened 
and exported from 
the LCInterlocking 
workbench

Figure 2 
The Addon Manager 
has an astonishing 
list of amazing 
workbenches with 
toolsets for all  
kinds of projects  
in FreeCAD

be useful for other processes, such as  
preparing files and objects to set up toolpaths  
for CNC routing. The ’interlocking’ part of the  
LCInterlocking name hints at another handy  
feature: the workbench has tools that can 
automatically create tabbed joints in objects  
where one part has tabs and the other part has 
receiving slots.

To explore these tools, let’s create a collection  
of parts that form the base and sides of a simple 
box. In the Sketcher workbench, draw a sketch in 
the XY plane of a square that is 100 mm on each 
side, and let’s constrain it with the lower-left corner 
onto the 0,0 point of the axis.

Having drawn the box sketch, use the ’extrude/
pad’ tool on the Part workbench to extrude the 
sketch to a thickness of 3 mm. Using 3 mm means 
we can imagine we are going to laser-cut our tabbed 
box out of 3 mm plastic or plywood. We could make 
this base part in a much easier way – namely, we 
could use the ’Create a cube solid’ tool. However, as 
an example, we wanted one part to be made from 
an extrusion as we need to treat extruded parts a 
little differently when we get to the LCInterlocking 
workbench. We can use the cube generator to 
create the sides of our box, however. First, let’s 

make a cube by clicking the ’Create a cube solid’ 
tool. Double-click the object in the Combo View file 
tree and then change its dimensional parameters. 
Let’s make the length 100 mm, height 97 mm, and 
width 3 mm. Next, let’s right-click this cube in the 
file tree and then select Transform – use the arrows 
in the preview window to bring the side up on the 
Z-axis by 3 mm so that it sits exactly on top of the 
base we made earlier (Figure 3, overleaf).

Make the opposite side of your box by either 
repeating the process and moving it to the opposite 
side, or simply copy and paste and move a duplicate 
of the first side. Next, repeat the process to make 
the final two sides of the simple box, making the  

 From aeroplane design 
tools to computational 

fluid dynamics to 3D print 
slicing engines – there’s 

a lot to explore

”

”
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height 97 mm, width 94 mm, and length 3 mm. 
Move these in a similar way using the ’Transform’ 
tool to move these sides into the correct positions 
lined up with the edges of (and sat on) the base, as 
in Figure 4.

Before we move over to the LCInterlocking 
workbench, we need to convert the base into a 
simple part. LCInterlocking prefers to work with 
parts that are simple objects rather than parts that 
appear as a stack of operations in the file tree view. 
We could just draw the base with a cube, but if 
you’re working with more complex shapes, this 
might help you remember to convert parts into 
simple copies before opening the LCInterlocking 
workbench. So, before proceeding, highlight the 
base part in the file tree, and click Part > Create a 
Copy > Create a Simple Copy. Delete the original 
extrusion and sketch in the file tree to keep things 
simple and clutter-free. It’s a good idea to right-click 

on the simple copy of the base and rename it to 
something recognisable, such as ’Base’ (Figure 4).

Next, let’s move to the LCInterlocking workbench 
by selecting it from the drop-down menu. The first 
task in the new workbench is to create some tabs 
and slots to ensure strong joints in the box. 

To get started, highlight the five parts that form 
our open box in the file tree, and then click the 
grey ’Interlocking’ tool icon. In the dialog box that 

appears, you will see a button that says ’Add parts’. 
Click this button and you will see the five selected 
parts appear in the window (Figure 5). This list of 
parts in the dialog box is similar to the file tree in 
the combo view in that you can highlight anything 
in the list – you can press the SPACE bar to toggle 
visibility. This is very handy for the next task. We 
need to tell the ’Interlocking’ tool which faces of our 
box are going to interlock. Let’s begin with the faces 
that will form the tabs that extend into the base. 
Select the ’Base’ part and then press the SPACE 
bar to make it disappear – do this for three of the 
sides. Next, select one of the thin faces on the 
remaining side of the box, making sure it is the face 
that is touching the base when the base is visible 
(Figure 6, overleaf). With that face highlighted, click 
the ’Add faces’ button in the dialog. You should see 

Dog bone holes are where 
the machine is instructed to 
cut a little further into the 

corners on both axes

”
”

Figure 3 
Adding sides to our 
extruded base using 
the ‘Create a cube 
solid’ tool

Figure 4 
Our simple box base 
and sides, created 
and aligned on the  
Part workbench
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the added face highlighted in the list, filed under the 
part that it is attached to. If you scroll down in the 
dialog box, you will see a menu relating to that face. 
In this, you can input the details of the tabs that you 
wish to generate on this face.

Add the number of tabs – you can make your own 
choices, but we went with four. We set the ’width 
of tabs’ to 10 mm, ’shift’ was left at 0.00, and the 
’interval ratio’ was set to 1.00. You’ll see there’s 
a couple of checkbox items: ’Dog bone hole’ and 
’Tab dog bone hole’ (Figure 7, overleaf). Dog bone 
holes are a method often used in parts that are 
CNC routed to get rid of a problem created by the 
fact that most router tools are round. If you send a 
round end mill cutter along a path to cut a 90-degree 

internal corner, you are left with the radius of the 
tool in the corner of the cut. If you are cutting tabs 
into material in this way, then the tabs won’t fully 
seat into the slots due to this excess material. Dog 
bone holes are where the machine is instructed to 
cut a little further into the corners on both axes; 
this slight overcut creates two small, round cuts in 
a corner that look like a stereotypical dog’s bone, 
giving the process its unusual name. 

We deselected both of the checkboxes as we 
don’t need them for this example.

Having input the tab parameters, scroll back up to 
the top of the interlocking dialog box and click the 
’Preview’ button. This will launch a new tab in the 
preview window, and you should see that our box 
appears (regardless of which parts are visible or 
invisible in our other tab). If we look at the joint  

ROCKET WORKBENCH
One add-on workbench we wanted to give a special 
mention to was the Rocket workbench. The Rocket 
workbench is in active development, and contains 
tools that help you design rocket parts parametrically. 
It has an exciting road map ahead that includes 
features like importing files from other rocket design 
environments such as OpenRocket, RockSim, and 
RASAero. This will open up great possibilities for 
rocket design, flight simulation, the realisation of parts 
via 3D printing, CNC milling, and more. We featured 
rocketry, including a tutorial on OpenRocket, back 
in issue 12 if you’re interested in getting started with 
model rockets and rocket design.

Figure 5 
Adding the parts of 
our box to create tabs 
and slots using the 
‘interlocking’ tool
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between the base and our tabbed face, there are 
now four tabs interlocking into the base (Figure 8, 
overleaf). We can now repeat the above process of 
selecting and adding faces to the interlocking 
dialog and configuring tabs. Working our way 
through the model, we added tabs to the other 
three faces that interlock with the base, and then 
added tabs to two of the side panels to create 
tabbed joints on every interface of our box.

Once we are satisfied with our added tabs in 
the preview, click the ’OK’ button to apply the 
interlocking tool to the parts. In the Combo View 
under our main document, there is now an object 
called ’MultiJoin’ (Figure 1). Within this file tree, 
there are now parts that are the tabbed version  
of our original parts, and there is also an invisible 
folder that contains the original non-tabbed parts. 
The preview tab also stays available – you can  
save this as a separate project if you like; however, 
we can close the preview tab without saving it for 
this example.

The next task is to apply the ’Export’ tool to 
the tabbed parts we have generated. Rather 
than actually export a file, this tool explodes our 
box apart, lays the parts out as flat parts, and 
automatically creates a drawn shape projection of 
the parts. In the file tree, select all the new tabbed 
parts we created under the MultiJoin object, and 
then click the ’Export’ tool icon (Figure 9).

Once again, FreeCAD will open a new preview 
window tab – this will contain all the parts of your 
box separated and laid out on a single plane. You 
will also see some new objects in the file tree if 
you rotate the plane in the preview, as we have in 
Figure 10. These are the ’Shape2DView’ objects – 
line projections of the outline of your parts. While 
this might initially seem confusing, having both 
versions of the parts is incredibly useful, depending 
on what you would like to do to create the parts.

If we wanted to cut the parts for our tabbed 
box on a CNC router, we could easily use the Path 
workbench to create toolpaths using the 3D objects 
that the LCInterlocking workbench export tool has 
laid out. Using the Shape2DView parts, however, 
we can create 2D output files that are suitable to 
cut this design using a laser cutter. First, in the file 
tree, let’s toggle the visibility of the 3D parts so that 
we just have the Shape2DView objects visible in 
the preview. Next, highlight all the Shape2DView 
parts in the file tree, and then click File > Export. In 
the export dialog, select a location to export to, and 
then from the drop-down menu, select ’Flattened 
SVG’ as the file type. Give your export a name 
followed by ’.svg’ and then click the Save button.

You should now have saved an SVG file containing 
a vector line drawing of the parts we created. The 
beauty of an SVG export is that we don’t lose any 
dimensional accuracy, and we can open this file for 
editing in many graphics packages. We are huge 
fans of the free, open-source Inkscape package here 
at HackSpace magazine, so let’s take a quick look at 
our SVG using that.

Find your file and open it in Inkscape. Note 
that you can select and move each of the parts 
individually. This is excellent, as often we will 
want to move parts around on an Inkscape canvas 
to arrange our components so that we are as 
economical as possible when cutting the parts on 
our laser cutter. That might be the only edit you 

Figure 6 
We toggled the 
visibility so that only 
one side was visible, 
then selected the 
face of that side that 
touches the base, and 
then clicked the  
‘Add faces’ button

Figure 7 
Adding tabs to a 
face is as simple 
as inputting a few 
options about the 
number and size  
of the tabs

Figure 8 
Previewing the  
added tabs in a 
separate preview 
window to check  
they are correct
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need to make, but often you may need to customise 
the SVG file to work with the settings of your laser 
cutter. We can think of a couple of different laser 
cutters that we have access to that have slightly 
different requirements. One needs any line that the 
laser is going to perform a cutting/vector action to 
be a ’hairline’ thickness of 0.0254 mm or thinner; 
another machine isn’t worried about the thickness 
applied to a stroke on a path but wants all cut 
lines to be red in colour. These changes are trivial 
to make in Inkscape. Of course, as a fully-fledged 
vector graphics package, Inkscape can also be 
useful to embellish your parts with decorations that 

the laser cutter will engrave/raster; again, this is 
simple to realise in Inkscape, as we have done in 
Figure 11. Having made our changes in Inkscape, 
we can resave the file as an SVG or, of course, 
Inkscape is capable of producing many other file 
types that may be of use to you depending on your 
making process. Remember, sometimes simple is 
best – you could always print the box part design 
out on paper as a template to cut out!  

COMMUNITY FORUM
Asking for help with FreeCAD is something everyone 
who uses FreeCAD does or has done, and a great place 
to request assistance is on the FreeCAD community 
forum. The golden rule to remember is that everyone 
working on FreeCAD is a volunteer, so we need to do 
our best to make life easy, and be nice! Before you 
post, do a search on the forum for the topic you want 
to post about – the forum has been running for a long 
time, and chances are someone else has raised a 
similar discussion. We find that we barely need to 
post on the forum when we search first. We have also 
discovered all kinds of interesting approaches and 
techniques. Secondly, it’s really important when asking 
for some assistance that you describe which version of 
FreeCAD you are using and on which operating system. 
FreeCAD makes this really easy to do: just click Help > 
About FreeCAD, and you will see all the details of your 
installation listed. There’s a ’Copy to clipboard’ button; 
if you click it, you can then paste those details into your 
forum post before going on to ask your question. You 
should also do this if you are answering another thread 
or comment with additional information relevant to the 
post. While you are on the forum, remember every now 
and again to say thanks to the developers for voluntarily 
creating such great tools for us to use.

Figure 10 
Using the export 
tool in Laser Cut 
Interlocking creates 
3D and 2D flattened 
versions of all your 
interlocking parts

Figure 11 
Editing our 
exported SVG of 
the Shape2DView 
objects in Inkscape

Figure 9 
Selecting the newly 
interlocking tabbed 
parts, and clicking 
the ‘Export’ tool



TUTORIAL

42

FreeCAD: getting started with assemblies

've already seen how to use 
add-on workbenches; in this 
chapter, we will use two other 
add-on workbenches, which 
we'll need to install. Open 
FreeCAD, go to Tools > Addon 

Manager, and click to install the A2plus workbench. 
Once installed, follow the prompt to restart FreeCAD, 
and then repeat the above task to install the 
Fasteners workbench.

Creating an assembly in CAD is useful for many 
reasons: it allows us to design more complex projects, 
to check that parts fit, and it allows us to use the same 
parts multiple times. It also can be used to check 
clearances and movements of dynamic systems and 

more. We are going to make and assemble an example 
of a pulley wheel mounted in some brackets, sat on 
top of a base, and held together with M6 nuts and 
bolts. As we are focusing on the assembly, we aren’t 
going to step through how we made every separate 
component, but we have posted the parts used in this 
project online, so you can just have a go at assembling 
the pulley block using those parts. This isn’t supposed 
to be a particularly well-designed pulley block; it would 
need some bushings and bearings in real life, as well 
as a proper spindle, but as an example, it’s a good 
project to play with. 

When using Part Design to create a body, that body 
is a single continuous solid object. The classic example 
is a nut and a bolt – which would require two bodies: 
one for the nut and one for the bolt – because although 
the items can be assembled, they are both single solid 
items. You could make two separate bodies within a 

project and then painstakingly move them into position 
relative to each other, but this is long-winded, and 
also, if you make a change or move the bolt, suddenly 
the nut is in the wrong place. Using A2plus, we will 
make assemblies where components are constrained 
to the specific parts of other components that they 
are attached to. Beyond parts simply being lined up 

Make complex designs out of a collection of parts

FreeCAD:
get started 
with assemblies
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This isn’t supposed to be a 
particularly well-designed 
pulley block … but as an 

example, it’s a good project 
to play with
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Figure 1 
We are aiming 
to assemble this 
example of a 
pulley block made 
up of 14 parts
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positionally, the assembly constraints describe the 
relationship of one part to another. For example, 
if something can turn around an axis, or if one 
component is always parallel to another. 

We began by making our components using Part 
Design to create bodies for each part. We created a 
base, two L-brackets, some nuts and bolts, a simple 
V-pulley, and a longer nut and bolt to act as a shaft. 
You’ll see that we are going to import these items into 
the A2plus workbench, and when we do, we could 
import each body either from an individual project, 
a project with just that one body in it, or we can 
import multiple bodies from the same project. Most 
of our files are single items, but we created one file 
containing two parts to allow us to explore how to 
import an individual part from a multipart project. This 
is useful for many reasons. We can imagine borrowing 
items from unrelated projects in our library.

We made a base which is a simple block and is the 
file ’base’. The base has holes to mount the L-brackets 
using M6 nuts and bolts. The sketch for the base is 
drawn in the XY plane and is centred around the 0,0 
point – the bolt-holes are constrained positionally 
relative to that origin point. This means that if we 
change the size of the base, the bolt-holes will remain 
in the correct position, which is important because 
they define the L-bracket position and the width of the 
gap for the pulley wheel.

The L-brackets are again a simple part with holes 
that match the hole coordinates on the base and a hole 
on the upright to receive the spindle bolt. You can see 
the complete assembly in Figure 1.

Download the files (from hsmag.cc/issue43) and 
create a new project in FreeCAD. For ease, save the 
new project in the same folder as all the component 
files. Move to the A2plus workbench and start 
importing components. On the left-hand side of the 
A2plus toolbar, you should see a yellow and green tool 
icon, which when you hover over reads ’Add a part 
from an external file to the assembly’ (Figure 2). Click 
this and navigate to select the ’base’ file in the folder. 
Select the file and click Open. In the preview window, 
you should now have a copy of the base object 
inserted (Figure 2). Let's repeat the task with the 
L-bracket file. The L-bracket will import overlapped with 
the base – you might notice that until you left-click, you 
can move it to any position in the preview area. If you 
need to move it again,  

Figure 3 
Importing the 
L-bracket file twice, 
we will position these 
using the constraint 
tools to attach them 
to the base

Figure 2 
Importing our first part of the pulley block

http://hsmag.cc/issue43
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double-click on the item in the file tree menu and you 
can transform it incrementally using the dialog and the 
axis arrows. Move it to a position free of the base to 
make things easier to see. Repeat the process and 
import a second instance of the L-bracket file. The files 
in the file tree will automatically be given a number 
suffix, so we have L_Bracket_001 and L_Bracket_002. 
As an example of one way of working, simply rotate 
the second bracket so that it faces the correct way 
relative to the base in terms of how it will sit when 
assembled (Figure 3). 

Let’s assemble the L-brackets to the base – to do 
this, select the bottom edge of one of the holes on 
the first L-bracket. This edge has a corresponding 
edge on the upper end of a hole in the base, and 
when in position, these two edges would sit together 
(Figure 4). Move the model so that you can see that 
particular hole edge, and then using the CTRL key, 
click to select it. You should now have two hole edges 
selected. When you select items in A2plus like this, 

KEEPING BACKUPS
If you hang out in CAD circles for long enough, 
regardless of what CAD environment you use, you may 
come across a term for a problem. The ’topological 
naming problem’, or ’toponaming’ for short, is a 
common issue we can easily demonstrate in our 
project. Objects and parts – for example, the base of 
our pulley block – are all made out of edges and faces. 
These edges and faces are automatically given an 
annotation. Sometimes you see these names when 
you select things like ’edge 12’ or ’face 3’. When we 
apply constraints in the A2plus workbench, we are 
essentially telling FreeCAD to ’attach face X to face 
Y’ or ’make edge 2 parallel to edge 5’, etc. When we 
edited our base part to make the brackets fit, we only 
changed a dimension, and, as such, none of the names 
of the features changed. As an experiment, edit the 
base and create a small rectangular pocket over one 
of the holes – to any depth – and then save the file. 
As we did before, update the parts in the assembly; 
when you do so, you’ll see that the model is now a 
little broken, as in the image below. This is because 
the names of the edges and faces have changed, but 
the constraints don’t know this. It’s definitely worth 
having a backup of a saved assembly before making 
any major edits to parts within it. You might find 
that sometimes these issues are easily resolved by 
removing constraints and reapplying them. 

Figure 4 
Setting some parts as 
transparent enables 
us to show which hole 
circles we selected 
to constrain the 
L-bracket to the base

Figure 5 
When applying 
constraints, you  
will see a dialog box 
with options

We used the Part 
Design workbench 
and Sketcher 
workbench tools to 
create the different 
parts for our 
assembly.

QUICK TIP
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any constraint types that could be applied to the items 
automatically become available on the toolbar. You 
should now be able to click the ’Add circular edge 
constraint’ tool icon (Figure 4). You will see that the 
L-bracket moves, hopefully into a correct position. You 
will also see a dialog box with some options showing 
the constraints you can adjust. We shouldn’t need 
to adjust the constraint for this one, but it’s worth 
noting the ’Flip’ button, which is commonly used if 
the constrained items end up in an undesired position 
– often clicking the Flip button repeatedly will toggle 
through the optional placements until you find the one 
you require. Click Accept to confirm the constraint 
(Figure 5).

DOUBLE UP
Repeat the process for the second L-bracket to end up 
with the two L-brackets facing each other with the gap 
in between for the pulley wheel. Noting the error on 
the size of the base, let’s use that to work through how 
to edit a part from the A2plus workbench. 

Highlight the base in the file tree and click the ’Edit 
an imported part’ tool icon (Figure 6). Clicking this 
should open the base part in a separate project, and 
the file tree of the part will appear. Even though you are 
still on the A2plus workbench, you can click the drop-
down menu to select the primary rectangular sketch, 
which is the root of the base object. Double-click this 
to open the sketch in the Sketcher workbench, and 
then change the horizontal dimensional constraint to 
101 mm. Close the sketch and then save the base 
part project by clicking the Save button. Now close 
that project tab. Notice that the base in our partly 
assembled project hasn’t changed. To update the parts, 
click the ’Update parts, which have been imported 

to the assembly’ tool icon (a yellow part icon with 
two curved green arrows over it). Once clicked, you 
should see the base now fits, perfectly matching the 
L-bracket ends. A point to consider again is that the 
holes in the base file are constrained to the centre line 
of the base. This means as the base dimensions are 
expanded, the holes stay the same distance apart. If 
we had constrained the holes relative to the edges 
of the base, then our update to the horizontal length 
would have moved the holes, and the brackets would 
still overhang. As you develop parts destined for 
assemblies, these factors become more important 
to consider. 

Using either the project with the M6 nuts and bolts 
you just made or, if you didn’t, the file we supplied 
in the download, let’s add the four nuts and bolts 
to connect the brackets to the base. Just as an 
experiment, try and import the nuts and bolts project 
using the same technique we did for the base and  

Figure 6 
We can see the base 
doesn’t quite fit; the 
A2plus workbench 
makes it easy to edit 
imported parts

Figure 7 
Selecting a circle 
edge on the bolt and 
a circle edge on the 
hole to align the bolt 
and hole axis

At the risk of 
sounding obvious, 
you can use a 
component part 
numerous times in 
an assembly, so don’t 
model things more 
than you need to!

QUICK TIP
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edges of one of the holes on the bracket. We want 
these two circles to align on an axis, but we don’t want 
to constrain the edges together as the bolt end circle 
obviously needs to be out of the other end of the hole. 
Clicking the ’Add an axisCoincident constraint between 
two parts’ achieves this – the bolt should now align to 
the hole (Figure 7, overleaf). To make the bolt-head sit 
flush to the surface of the bracket and the bolt to sit all 
the way through the hole, let’s add another constraint. 

This time, click to select the upper face of the bracket 
and then select the lower face of the bolt-head. These 
two faces can then be brought together by clicking 
the ’Add a planeCoincident constraint between two 
objects’ tool (Figure 8). Now the bolt should be 
correctly in position. Click Accept in the dialog box to 
finish the constraint. Moving to the nut, if we move the 
nut closer to the bolt end under the base, we can then 
select the edge at the base of the bolt before the slight 
chamfer and the lower similar edge just inside the nut 
(Figure 9). Again, apply a ’circularEdge’ constraint to fit 
the nut to the bolt. 

Now that our nut and bolt are constrained, we 
want to add the other nuts and bolts. Again, as an 
example for learning, you might think – based on other 
workbenches – that you can copy and paste the nut 
and bolt in the file tree system. Of course you can, 

the brackets. You’ll note that even though there are 
two objects, it will import, but the nut and the bolt 
appear as a single item in the file tree and cannot be 
moved independently. The correct way to do this is 
to use the ’Add a single shape out of an external file’ 
tool icon. Having deleted our incorrectly imported nut 
and bolt, click this and then select the file again; this 
time, a dialog asks us to specify which part to import 
from within the file. Select the nut or bolt and repeat 
this for the other part. Once you have the first nut and 
bolt in place, let’s constrain this one before tackling 
the others. 

Let’s constrain the bolt section first. Select one of 
the circle edges at the opposite end of the bolt from 
the head. Using the CTRL key, select one of the upper 

It’s a great workbench to 
play with and experiment 
with how the different 

constraints work

”
”

Figure 8 
Selecting the top  
face of the bracket 
and a lower face of 
the bolt-head to apply 
a planeCoincident 
constraint

Figure 10 
All the nuts and bolts 
added to  
the assembly

Figure 9 
Using the 
circularEdge 
constraint again 
to affix the nut to 
the bolt

Similar to Sketcher 
and other parts of 
FreeCAD, there 
are numerous 
ways to achieve 
similar results using 
different assembly 
constraints.  

QUICK TIP
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but now that we have added constraints to our first 
nut and bolt, if we copy and paste, that will copy all 
the constraints applied to that part. Of course, we 
could delete these constraints and reapply them in the 
other positions, but it’s easier to either import multiple 
copies or to copy and paste before adding constraints 
to an object. However you choose, create three more 
nuts and bolts and constrain them into position in the 
assembly (Figure 10). 

PULLING TOGETHER
Let’s add the pulley wheel next. Import the pulley 
wheel, but let’s use constraints to position it rather 
than double-clicking to use the transform tools. Select 
one of the edges of the hole through the pulley 
and then click one of the holes on the inside of the 
L-brackets in the gap for the pulley wheel. Even if the 
pulley wheel is at 90 degrees to the brackets, clicking 
the ’Add a circularEdge constraint’ should bring it 
into the correct orientation. You may need to flip the 
direction in the constraint dialog to get the pulley 
largely between the brackets. Before you close the 
constraint dialog, note that the pulley is 12 mm wide 
and the gap between the brackets is 13 mm – this is 
because one would probably want the pulley wheel 
to have some clearance (Figure 11). Currently, the 
pulley is positioned touching the bracket of which we 
selected the hole edge. Setting the ’offset’ to 0.5 mm 
in the constraint dialog moves the pulley 0.5 mm off 
the bracket and positions it equally with clearance 
between the two brackets. Finally, there is a ’Lock 
Rotation’ value in the constraint dialog. Setting this as 
’false’ means that our pulley wheel part can be rotated 
around this circular constraint, emulating its real-world 
movement. If you wanted to lock it at a certain point 
in rotation, set the part in position and then toggle this 
value to ’true’.

To finish our assembly, import the spindle bolt file 
and constrain it through the centre of the brackets 
and the pulley, then fit the nut to the other end. We 
are sure by this point that you can work out how to 
constrain this one into position without instruction. We 
hope that you’ve found this introduction to assemblies 
useful, and after you have put this together, it’s a great 
workbench to play with and experiment with how the 
different constraints work. The simple assembly we’ve 
created is a good starting point and a foundation for 
making assemblies that move and can be animated, 
and much more.  

JOIN TOGETHER
We are going to make some nuts and bolts for our assembly. For this, we will use the 
Fasteners workbench we installed. Create a new project and move to the Fasteners 
workbench. The Fasteners workbench makes it easy to model metric and imperial nuts 
and bolts and screws – it even has some rarer fasteners like PEM insertion nuts, PCB 
standoffs, and more. We are going to use four M6 nuts and bolts that are 25 mm long to 
attach the L-brackets to the baseplate; however, we only need to model one and then 
import four copies to the A2plus assembly project. To create our bolt, first click the 
yellow icon that looks like a hexagonal-headed bolt, which when you hover over it says 
’ISO 4014 Hex Head Bolt’. M6 is the default diameter for this bolt type on the Fasteners 
workbench – it should create a 30 mm M6 bolt model. You’ll notice that the model doesn’t 
have any thread modelled onto it. This is common across most CAD platforms when 
modelling threaded fasteners because the thread is a complex geometry. If you have lots 
of fasteners, it can increase the project complexity and speed of loading or recomputing. 
Most of the time in CAD, we don’t need to model the thread; however, you can simply 
add the thread to this model by highlighting the item in the file tree and, in the dialog box, 
setting the ’thread’ property to ’true’. Depending on your computer, this may take some 
time to generate the thread on the model. Turn the threads back to ’false’ and shorten 
our bolt to 25 mm by selecting ’custom’ in the ’length’ property in the dialog box and 
typing in 25 mm. Let’s create a nut for our bolt in the same project file. Depending on your 
screen, you might need to expand the toolbar to select the yellow icon that looks like a 
hexagonal nut labelled ’ISO 4032 Hexagon nuts, Style 1’. Again, the Fasteners workbench 
will automatically create a nut, but it will be positioned on the origin point in the same 
place as the bolt-head. To move this, double-click the nut in the file tree and then use the 
arrows in the preview window to move it down and away from the bolt. Making sure you 
have turned off the thread setting for each item, save this project ready for use in our 
assembly, or use the one we have provided. 

Figure 11 
Adding the pulley, and positioning it with an offset within the 
constraint, to create the clearance gap with the L-brackets
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ften when we are designing 
something, we would like to 
make multiples of some aspect 
of the design and we want to do 
it as quickly and as efficiently 
as possible. A common example 

might be placing circles to become pockets, holes, or 
pads in a sketch. As a first example, let’s go straight 
to the Sketcher Workbench and create a new sketch 
in any plane.

In Figure 2, you can see the desired sketch item 
on the left, a small square with a hole in each corner.   
To create this sketch, we drew four separate circles 
and constrained each of them dimensionally and 

positionally. It’s a fine approach, but it’s quicker to 
use some of the cloning and array tools the Sketcher 
Workbench offers. In Sketcher these tools can 
create matching objects and carry over some of, or 
manipulate, the existing constraints to save us some 
time. Starting over, if we draw one circle for example 
in the upper left-hand corner of the square, we can 
constrain the radius and then the position by setting 
a vertical and horizontal distance constraint between 
the centre point of the circle and the origin point 
of the plane. Next, select the circle and the Y axis 
datum line. We can now click the ‘Create symmetric 
geometry with respect to the last selected line or 
point’ tool icon. This should now create a second 

Figure 1 
Creating arrays 
can produce 
fascinating 
geometries from 
a single copy

Save time with clones, arrays, and drafts

FreeCAD: making 
multiples of things

O
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circle, with the same radius constrained and in a 
mirrored position in the upper right-hand corner of 
our square. It doesn’t have the positional constraints, 
but it is in the same mirrored position as the original, 
so if you add a vertical and horizontal constraint 
without changing the default position then they will 
remain correct. Of course, you can then select the 
two circles and the X axis datum line and repeat the 
process to create two more circles in the lower left 
and right corners.

Another approach is to use an array tool called 
‘Create a rectangular array pattern’. Starting again 
with just our upper left constrained circle highlighted, 
click this tool and you’ll see a dialog box (Figure 3). In 
the dialog, set the column and row number each to 
‘2’ and then tick the ‘Equal vertical/horizontal spacing’ 
checkbox as well as the ‘Constrain inter-element 
separation’ box. Clicking OK, if you now move your 
mouse around the sketch area, you will see a line 
protruding from your original circle; this represents 
the angle at which your array will be created and 
the distance from the original circle. Left-click to 
place the rectangular array of circles into the sketch. 
Don’t worry if you set it at a slight angle: click on the 
generated angle constraint and set it to zero degrees. 
Finally, edit one of the distance constraints it has 
added; as our original circle is 12 mm from the datum 
point vertically and horizontally, we set the constraint 
distance to 24 mm, which makes our square array of 
circles fully constrained and accurately placed.

For our next examples, let’s move to the Part 
Design Workbench and create a body and then create 
a sketch in the XY plane. In the sketch, draw a simple 
rectangle and don’t worry about constraining it. Close 
the sketch and pad the sketch to any thickness. 
Next, select the upper face of the padded rectangle 
in the preview window and click to create a new 
sketch on that surface. Select the ‘Create a slot in 
the sketch’ tool and draw a small slot at one end of 

the rectangular surface. Close the sketch and then 
perform a pocket to cut the slot into or through the 
pad. Just to add to the example, select an edge of 
the slot and apply a fillet, which should auto-complete 
around the entire pocket edge.

DESIGN PARTS WITH PART DESIGN
The Part Design Workbench has some specific array 
tools, and we are going to try the ‘Create a linear 
pattern feature’. With nothing selected in the file tree, 
click the linear pattern tool. You should now have a 
dialog opened in the Tasks tab of the Combo View 
window. At the top of this dialog, you should see a 
panel titled ‘Select feature’ and all the available 
features should be listed; in this case, that is the pad, 
the pocket, and the fillet. For now, highlight just the 
pocket item in the list and click OK. You may see a 
duplicate pocket in the other end of your rectangle 
now, but don’t worry if you don’t. You should see that 
the dialog box in the Tasks tab has now changed; 
scroll down to the bottom of this new panel. You 
should see two adjustable parameters: ‘Length’ and 
‘Occurrences’. The value of Length represents the  

Figure 3 
Using the rectangular 
array tool to save time 
in sketches

Figure 4 
Creating a linear array 
of chamfered pockets

Figure 2 
This symmetrical square sketch with circles 
can be created in numerous ways
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length of the array and isn’t linked to the length of any 
attached object. At the default length of 100 mm with 
two occurrences, this might place the second 
occurrence of the pocket outside of the rectangular 
pad. Increase the number of occurrences to 5 and 
adjust the length of the array so that your array of 
pockets fits in the rectangle. You might also discover 
that if the length is shorter than the multiple widths of 
the pocket, it will overlap the pockets in the array. 
Before we close this example, you’ll note that our 
fillet hasn’t been replicated in the array. To add the 
fillet, click the ‘Add feature’ button, then either select 
part of the original fillet by clicking it in the preview 
window. Alternatively, you can swap to the Model tab 
and select the fillet in the file tree. Now, when you 
click OK on the linear pattern dialog in the Tasks tab, 
you will see the array with the fillets added to each 
instance of the pocket (Figure 4). Removing a feature 
is slightly counter-intuitive in that you can’t select the 
feature to remove in the list in the ‘Add/remove 
feature’ box in the dialog. Similar to adding a feature, 

you click the ‘Remove feature’ button and then 
highlight the feature in the preview or in the file  
tree view.

Sometimes we might want to make an array of 
objects radially. As an example, start a new body and 
in a sketch on the XY plane, draw a circle with 30 mm 
radius; constrain the centre of the circle to the datum 
point. Close the sketch and pad the circle. Similar 
to our earlier example, create a sketch on the top 
surface of our cylinder and draw a small slot to create 
a pocket. First, leave the slot without constraints and 
position it somewhere in the upper left quarter of our 
cylinder face and perform the pocket.

ROUND AND ROUND
Again, with nothing highlighted, click the ‘Create a 
polar pattern feature’ tool icon. The resulting dialog 
box is similar to our earlier linear pattern tool. Click 
‘Add feature’ and select the pocket that we made. 
Scrolling down, leave the axis and angle settings 
as the default and set the occurrences to 5. If you 
have the ‘Update view’ box ticked, you should see 
that the pocket is replicated and rotated around the 
datum point. As our original slot was off axis, the 
array positioned the repeated slots relative to this 
original position; we can of course go all the way back 
to the root sketch of the pocket and adjustments 
will be recomputed to the pattern array. As shown 
in Figure 5, we closed the polar pattern dialog and 
opened the slot sketch in the file tree. In the slot 
sketch, we constrained the slot so that the centre of 
the slot was positioned on the Y axis datum line.

Press SHIFT+V or 
SHIFT+H to quickly 
add a horizontal or 
vertical distance 
constraint between 
two selected points 
or a selected edge.

QUICK TIP

Figure 6 
Simple array 
of parts using 
the rectangular 
array tool

Figure 5 
Creating a polar 
pattern of slots 
around a disc
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Many times we will want to create more complex 
arrays, sometimes with more complex geometries 
or sometimes not in a single continuous body, which 
means we would be working outside of the Part 
Design Workbench. The built-in Draft Workbench has 
some array tools that can be extremely useful for this, 
but it’s a useful Workbench for much more as well.

ON REPEAT
As a simple example, let’s start a new empty project 
and move to the Part Workbench. Click the ‘Create a 
cylinder’ tool to create the default 10 mm tall cylinder 
with 2 mm radius. Next, use the drop-down menu to 
move over to the Draft Workbench. Let’s highlight 
the cylinder in the file tree and then click the array 
tool icon, which resembles a collection of six blue 
rectangles. In the dialog box, the first items you can 
adjust are the ‘Number of elements’; edit the X and 
Y values to 5 and leave the Z at 1. This is then aiming 
to create a rectangular array of 5×5 of the cylinder 
object. Next, we can edit the spacings of the array. 
It’s slightly counter-intuitive in that the X, Y, and Z 
elements each have an X, Y, and Z input box, but if 

you play with the values and apply the array, you’ll 
soon see what effect these have. For now, in the ‘X 
intervals’ section, set X to 10 mm. In the ‘Y Intervals’ 
section, set Y to 10 mm and leave the Z, as we only 
have one layer in our array. Clicking OK, you should 
now see an array of our cylinders spaced at the 
intervals we set (Figure 6).

Highlight the array item in the file tree and delete 
it. We should now see our cylinder item and if we 
highlight it and press the SPACE bar, we’ll make it 
visible again. Next, let’s try the ‘Polar array’ tool from 
the Array tools drop-down menu. In the dialog, leave 
the polar angle set to 360 degrees to create a full 
circle array and set the number of elements to 5. We 
need to add a point which is the centre of rotation; if 
we left the centre of rotation set at the 0,0,0 point, 
we would simply create five cylinders placed on top 
of each other. Change the Y co-ordinate to 10 mm 
and then click the OK button. You should now see a 
circular array of five cylinders appear.

Delete the polar array and let’s try the circular array 
tool. Highlight our test cylinder and click the ‘Circular 
array’ tool icon. This tool works differently in that the 
number of copied objects in the array is dependent on 
the size and spacing of the array rather than a directly 
input value.

In the dialog box, the ‘Radial distance’ is the radius 
of each circle in the created array; we set this to 
50 mm for a test. If we don’t change the centre of 
rotation and leave it at the datum or zero point, then 
the first circle in our array will be made with a  

FOLLOW THE PATH
Sometimes we will want to create an array of objects, 
but constrain them onto another object or path. This 
can be achieved using the path array tool. In a new 
project, once again go to the Part Workbench and 
create a first cylinder and set the radius to 30 mm and 
leave it at 10 mm tall. Then create a second cylinder and 
leave it with the default dimensions of 10 mm tall and 
2 mm radius.

Move back to the Draft Workbench and first select 
the object of which we wish to create an array; let’s 
select our second, smaller cylinder. Next, we select 
the path we want the array of objects to be connected 
to; holding CTRL/CMD, click the lower outer edge of 
the larger cylinder. Then click the ‘Path array’ tool; this 
applies an array without a pop-up dialog box, but the 
resulting array has some editable parameters in the 
Combo View window. You should see the array has 
been created with four instances of the smaller cylinder 
placed equidistantly around the larger cylinder edge. If 
we highlight the array object in the file tree and adjust 
the ‘Count’ parameter, it will add or remove instances 
from the array and redistribute the count to maintain 
equal distances between each instance.

Many times we will want 
to create more complex 
arrays, sometimes with 

more complex geometries

”
”

Near the Part Design 
pattern array tools, 
you might notice the 
‘Create a mirrored 
feature’ tool, which 
is similar to the 
symmetric geometry 
tools on the Sketcher 
Workbench.

QUICK TIP

Figure 7 
Creating circular 
arrays of Part objects
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50 mm radius from this point. The second circular layer 
will be made at a further 50 mm from the first circle 
so therefore will have a 100 mm radius, etc. Next, the 
‘Tangential difference’ is the spaced distance between 
instances of the array object in the same circular layer 
of the array. We initially set this to 15 mm, but play 
with this value to see how it affects your test arrays. 
The ‘Number of circular’ is the number of concentric 
circles that are added, spaced as we said at the radial 
distance; we set this to 3 for our test. Finally, there is 
the Symmetry input; it’s difficult to explain the effect, 
but this value controls the number of symmetric 
planes an array has – the best thing is to start with 
it set to 1 and then change the values and see what 
effect it has on your array! With the above settings, 
you should see an array similar to Figure 7.

We’ve seen that the Draft Workbench array tools 
can be used to create arrays of copies of a part, but 
they can also be applied directly to sketches and 
even be applied to bodies created on the Part Design 
Workbench. The caveat with arrays of a Part Design 
body is that the array will usually create separate 
objects that cannot be considered part of the original 
body. When this occurs, the array is listed outside of 
the active body in the file tree and the original body 
part visibility is toggled off.

As a final example exploring arrays, let’s create a 
complex-looking decorative array using other Draft 
Workbench tools to create the underlying geometries. 

Create a new project and move to the Draft 
Workbench. You should see a grid on the XY plane. 
If you don’t, find the ‘Toggle Draft Grid’ icon, which 
looks like a mesh and is at the end of the snap toolbar 
icons; toggle this button until you see a draft grid.

You may notice that the Draft Workbench has a 
collection of drawing tools that look similar to the 
Sketcher drawing tools. They do work in very similar 
ways, but in the Draft Workbench, wires and edges 
are drawn without constraints and use either snapping 
to the grid or other objects, or inputting positional co-
ordinates. As such, the Draft Workbench has a lot of 
options for different snapping styles. For our example, 
we need to enable snapping by clicking the ‘Snap Lock 
On/Off’ padlock icon. This should now activate the 
other snap icons; we want ‘Snap grid’ and ‘Snap near’ 
to both be on, as seen in Figure 8.  

First, let’s draw a polygon on the Draft grid so that 
it sits on the XY plane. Click the ‘Create a regular 
polygon’ tool icon and then left-click to draw a polygon 
around the datum or zero point. To help you draw it 
accurately, zoom in towards the datum point and you 
should see the cursor lock to the grid before you click 
to draw. Adjust the polygon placing circle to roughly 
6 mm in diameter. In the properties dialog, you can 
adjust the number of sides, but as a default it is set 
at three. If you create the default triangle, you can 

Figure 8 
Some of the tool 
icons on the Draft 
Workbench: top row 
drawing tools, middle 
row snap options, and 
lower row includes 
array tools

Figure 9 
Drawing a pentagonal 
polygon in Draft is 
similar to the Sketcher 
Workbench apart from 
not using constraints

Figure 10 
Creating points to act 
as snapping points for 
a B-spline
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highlight the Polygon object in the file tree and adjust 
the number of sides in its properties table.

CURVED LINE
Next, let’s create some points which we will use to 
create a curved line in three axes. The first point of 
the line is going to be the centre of our polygon, or 
the zero point. Click the ‘Create a point object’ and 
click to place a point at the datum. Next, let’s add a 
second point and then raise it on the Z axis. We are 
aiming to create a curve, so place this second point 
on the XY grid at a random point close to the zero but 
not on it. We went with an X co-ordinate of 6 and a 
Y co-ordinate of -2. Having created this second point, 
we highlighted it in the file tree and, in the dialog, 
adjusted the Z axis position to 30 mm. You may need 
to adjust the zoom, but you should see this point now 
rise up above the plane. We added two more points 
above: the next had the co-ordinates X = -28, Y = 0, Z 
= 60, and the final point was at X = -10, Y= 9, Z = 80 
(Figure 10).

Creating a curve between the points we just made 
is easy with the ‘Create a multiple-point B-spline’ tool. 
Select this tool and hover near the upmost point we 
just made. When you are hovering, if you are too far 
away from the raised point, you’ll see that next to 
the pointer position there is an icon that looks like the 
Draft grid icon; this indicates that if you click, you’d be 
snapping to the grid. If you are close enough to the 
raised point, this icon disappears, and if you left-click, 
you will attach the B-spline to the point. Left-click 
on the upper point and then move to the next lower 
point and left-click again; continue to do this until you 
reach the last point at the zero position. Left-click 
to attach the last point and then click the ‘Close’ 
button (Figure 11).

Just for a moment, we are now going to switch to 
the Part Workbench to use the sweep utility. On the 
Part Workbench, click the ‘Utility to sweep’ tool icon 

and in the dialog, select the Polygon item we drew 
from the left-hand list, and click the right-facing arrow 
to add it to the right-hand column. Next, click the 
‘Sweep Path’ button, then left-click on the B-spline 
curve we drew in the preview window and click 
‘Done’. Check the ‘Create solid’ box and click OK. You 
should now have a curvy swept hexagonal object in 
the preview (Figure 12).

Moving back to the Draft Workbench, select the 
swept object in the file tree and then click the polar 
array tool icon. You can then left-click in the preview 
window to select a centre of rotation (Figure 13). We 
put our centre of rotation at around -30 mm on the X 
axis to create our array of five of our swept items; you 
can see the completed array in Figure 1.  

Figure 11 
Using the B-spline tool to draw a curved line 
between the points we created

Figure 12 
Using the sweep 
utility on the Part 
Workbench to create 
the final part for 
our array

Figure 13 
Selecting a centre of 
rotation for the array 
of swept items; we 
chose -30 in the X axis
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ften, we’ve begun with a sketch 
and then extruded it to create the 
first building block of our project 
or design. Similarly, here, we are 
going to start with a sketch, but we 
are going to explore creating surfaces 

from sketches or wires to build an object. To begin, 
let’s go to the Sketcher Workbench and create a new 
sketch on the XY plane.

Select the ‘B-spline by control points’ option from 
the ‘Create a B-spline in the sketch’ drop-down in the 
drawing tools area, and draw a collection of B-splines 
around the origin point, making sure that the final 
B-spline ends at the first B-spline point (Figure 2). 
We aren’t aiming for anything in particular, just an 
interesting curvy outline that has some inner and outer 
swooping curves. Play around moving the B-spline 
control points until you get a shape you like that 

doesn’t have too tight a set of curves (Figure 3). We 
don’t need to constrain the B-spline that we have just 
created, so go ahead and close the sketch.

Moving back to the Part Workbench, select the 
sketch in the file tree, and copy and paste the sketch 
to create a second identical sketch that will appear as 
‘Sketch001’ in the file tree. Select this second sketch 
in the file tree and, in the sketch dialog, increase the 
Z axis value in the Placement > Position drop-down to 
move the second sketch directly above the first. As 
a rough estimate, our curvy sketch is around 120 mm 
at its longest point, and we moved our copied sketch 
upwards by around 25 mm (Figure 4, overleaf).

You should now see, in the preview view, two 
sketches perfectly aligned above one another. Select 
both the sketches in the file tree and let’s create our 
first surface by clicking the ‘Create a ruled surface’ 
tool icon. Hopefully, you now see that a surface has 

Turn lines and sketches into solid objects

FreeCAD, surfaces, 
and projection

O

Figure 1 
Creating curved 
surfaces, and 
projecting other 
objects onto or 
through them, can 
create interesting 
and useful effects
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been created between our two sketches, similar to our 
example in Figure 5 overleaf.

You’ll notice that, as it stands, our surface doesn’t 
have any thickness and our object isn’t a solid part 
with a top and a bottom. If we wanted to create a 
solid shape, of course, we would have used a single 
sketch and the pad or extrude tools. Instead, let’s aim 
to make our curved wall 
into a sort of tray with a 
base, and turn our ruled 
surface into a wall with 
some thickness, but 
open at the top. First, 
let’s make the ruled 
surface we created have 
some thickness but, 
just for fun, let’s look 
at the wrong way to do this using the extrude tool. 
Doing this incorrect experiment makes us think about 
the projection of axes through workpieces, which we 
will return to as a subject later in this article. Select 
your ruled surface and click the ’Extrude’ tool; in the 
dialog, select the Y axis as a custom direction and 
set to extrude it a couple of mm. Apply the extrusion. 
Inspecting the results, you’ll see that it works for some 
parts of the surface but not for others, as the extrusion 
is projected across the ruled surface in the Y axis. 
Applying an extrusion like this also leads to some parts 
of the extrusion being added inside the boundary of the 
ruled surface, but other parts extruded outside. Select 
the extrusion in the file tree and delete it, and toggle 
the ruled surface so that it is visible.

One of the best parts of using FreeCAD is the ability 
to apply multiple operations or tasks to a single piece 
of geometry. To add a base to our curvy wall, to make 
it into our curvy tray, we can use the drop-downs in the 

file tree to go all the way back and select our original 
sketch. We can then click the Extrude tool and add 
-3 mm to the Z axis custom direction and set the length 
option to 0. Clicking Apply, we should have added a 
base underneath the offset wall to complete our tray.

Previously in this series, when we have worked 
with solid objects, we have often created sketches 

either attached directly 
to a flat face of an object 
or drawn on a plane, 
like XY or XZ, and then 
extruded or pocketed 
through an existing solid. 
With a curved object, 
such as the wall of our 
tray, drawing directly onto 
the surface is not really 

possible. However, we might often want to add design 
aspects to a curved surface. One approach to this is to 
use ‘projection’. Imagine placing your hand in front of a 
display projector and seeing the shadow of your hand 
on the projection surface on the wall or whiteboard. 
We can do this in FreeCAD, except the projector is 
referred to as the camera view and is simply the 

Figure 2 
The rough 
arrangement of 
B-spline points before 
finishing the B-spline

Figure 3 
Finishing our B-spline, 
we adjusted the 
control points to 
create a curved shape

We covered the 
basics of the Part 
Workbench and the 
Sketcher Workbench 
in the first two parts 
of this series, which 
started in issue 37.

QUICK TIP

Doing this incorrect 
experiment makes us think 
about the projection of axes 

through workpieces

”
”
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current view in the preview window. The equivalent of 
your hand is the object you want to add to a surface, 
and our ruled surface is the object onto which we 
want to project. Whilst this might sound complex, it’s 
actually pretty straightforward to do.

Whilst we have used the imported, and then 
extruded, dog logo for this first example of projection, 
you can use any small extruded part, perhaps a small 
extruded circle or square. First, we need to choose 
which surface area of our object we want to project 
the logo onto. You can project parts onto any surface, 
but obviously if the surface is very folded, the effect 
isn’t going to work as well; therefore we chose a 
larger, smoother face. We then need to orient that 
chosen face to be pointing at us when viewed in the 
preview, remembering that the preview window is 
the projection viewpoint. With that established, we 
then need to move our object we want to project 
onto the curved surface into a position in line with the 
projected surface and the preview window. We can 
do this via the usual right-clicking the object in the file 

tree, selecting Transform, and moving and rotating the 
object until we are happy with the position. It’s not too 
critical how far away from the surface the object is, but 
it’s a good idea to leave a reasonable gap so you can 
see the effects of the projection. In Figure 7 overleaf, 
we have rotated the preview view to show how our 
projection was set up.

With your preview view and your projection object 
correctly set, click the ‘Project edges, wires, or faces 
of one object onto a face of another object’ tool. In 
the dialog you will see a long button that says ‘Select 
projection surface’ – click this button and then select 
the surface onto which we want to project. Next, click 
the ‘Add face’ button and select the face of the object 
you wish to project that is visible in the preview view. It 
may take a few seconds, but the selected face should 
turn a purple colour. You’ll need to change the extrude 
height to a value that works for the shape of your 
projection surface. In our example, the extrusion height 
was 3 mm – this gave enough height for the whole 
logo to be projected to the lowest parts and highest 
parts of the curve of the ruled surface. Experiment 
with values until you get a projection that works for you 
(Figure 8). Finally, click ‘OK’ and you should now see 
your object projected onto the curved surface of your 
tray part. Of course, now you can remove or toggle the 
visibility of the part you used to make the projection.

A common use for projection is to create 3D text 
effects. Let’s first look at how to generate 3D text in 
FreeCAD, and then let’s use some text and project it 
onto our curved surface again. Then we can combine 
projecting onto a curved surface with some Boolean 
part operations to create some interesting effects. 
For simplicity, let’s just open a new project to look at 

Figure 4 
A copy of our B-spline 
sketch is created 
and raised above the 
original in the Z axis

Figure 5 
Creating a ruled 
surface between two 
identical sketches
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SURFACE WORKBENCH

Using the ruled surface tool on the Part Workbench 
is useful. In some ways, it is the first step towards 
thinking about 3D modelling in terms of edges and 
surfaces – rather than creating a 3D object via 
extrusion or padding, and then cutting and adding 
parts to and from it.

Surfaces in FreeCAD are given their own 
Workbench, and it’s certainly worth exploring in its 
own right. The ruled surface tool we use in this article 
has some limitations – one main one being that, if 
you have a closed path like the base of our curvy 
tray, the ruled surface tool can’t be used to create 
a surface filling the path. This is why we create a 
small extrusion from the original sketch. If you are 
interested, create a sketch similar to the first B-spline 
sketch we created in the main tutorial, and then move 
to the Surface Workbench. Select the first tool icon, 
‘Creates a surface from a series of picked boundary 
edges’, and in the dialog, click ‘Add edge’, and then 
select the sketch edge in the preview window. You 
should see a surface created filling the sketch area.

It’s not too critical how far 
away from the surface the 

object is, but it’s a good idea to 
leave a reasonable gap

”
”

Figure 6 
Creating a filled offset 
gives our ruled surface 
some thickness

You could also 
project onto a 
surface using the 
usual height method, 
and then use the 
Transform function to 
move the projection 
to a specific depth.

QUICK TIP

the text tool we are going to use. In the new project, 
open the Draft Workbench and then click the ‘Create 
a shape from a text string’ tool icon, which looks like a 
yellow ‘S’. In the dialog, you can see some positional 
co-ordinate input boxes which select the point at 
which our text will be created from. If you move your 
pointer over the grid in the preview window, you 
will see that these co-ordinates react to where your 
pointer is. For this example, let’s leave them set at 
0,0,0, which you can either type in or click the ‘Reset 
point’ button. You need to point the ShapeString tool 

at your font installation folder. Clicking the ellipsis at 
the side of the ‘Font file’ input box should open a file 
browser. On Ubuntu flavours of Linux, you will need 
to right-click in the file browser and check the ‘show 
hidden files’ option, and font files can usually be found 
at usr/share/fonts. On Windows 10, the location is 
usually C:\windows\fonts. Navigate to your font folder 
and select a font. In the ‘String’ input box, type the text 
you want to create, and then set the height of the text, 
noting that the text height is not in the usual ‘point’ 
font units found in word processing packages, but 
rather, in millimetres. Clicking OK, you should now see 
the text string you input created in the draft preview 
window. Notice that it creates a wire/edge, but also 
creates a surface face. 

C:\windows\fonts
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You should also see that you have a 
‘Shapestring001’ object in the file tree (Figure 9). Now 
that you have a ShapeString object, you can move 
back to the Part Workbench and perform the usual sort 
of operations upon it. Whilst not totally necessary, if 
we extrude the ShapeString on the Part Workbench a 
little, say 3 mm, it means that we can use the simple 
‘Transform’ operation we used earlier to move the 
object into our projection position.

We can now use the text in the same way as we 
used our small logo or part in the earlier projection 
example. In Figure 10, you can see that we have again 
projected the text onto the curved side of our curvy 
tray example.

You may have noticed when we set up a projection, 
as well as a height input box, there is also a ‘Depth’ 
box. Of course, the depth option allows you to project 

through the selected surface to a set depth. To see 
how this works, a useful experiment is to project into 
a part that is partially transparent. In a new project, 
create some example text using a ShapeString, and 
then return to the Part Workbench. Click the ‘Create a 
cube solid’ to create a cube. Resize the cube so that 
it is larger than your text ShapeString, and then right-

click and select Transform; move the cube item down 
underneath the ShapeString, ready for projection.

Click the Projection tool and select the surface of 
the cube item we just made. Then select the faces of 
the ShapeString in the usual way. Add 2 mm of height, 
but add 5 mm of depth to the projection, and then 
project onto the cube item. Select the cube item in 
the file tree, right-click, and select Appearance. In the 
appearance dialog, slide the ‘Transparency’ slider to the 
right to set the transparency to around 40%. Closing 
the Appearance dialog, you should now be able to see 
that the cube is partially transparent, and we can see 
the projection is inside the cube to a depth of 5 mm. 
Finally, we can select the cube and then the projection 
object, and click the ‘Make a cut of two shapes’ tool to 
remove the projection from the cube object. This is a 
useful effect if you are trying to make a text-based sign 
object for 3D printing (Figure 11).

The surface tools and 
projection approaches can 
create very complex effects 

and designs

”
”

Figure 7 
A rotated view 
showing the setup 
we created to project 
the logo part onto 
our curved tray wall

Figure 8 
Our logo projected 
onto our curved 
part. It creates a 
useful and pleasing 
embossed effect

Figure 9 
Making a ShapeString object is the basis of 
creating 3D text effects
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PUTTING IT ALL TOGETHER!
As a final experiment, we can put together all the 
techniques we’ve covered in this part of the guide.  
We’ve returned to our slightly odd-shaped curved tray, 
and we have once again set it up with our example 
text ShapeString projected onto it. This time, we have 
kept our height at 10 mm and set our depth to 10 mm, 
which provided more than enough depth to fully 
project the text through the curved wall of the tray.  
You can see above that it looks a little messy, but 
in Figure 1 you can see the result when we have 
performed a cut operation to remove the projected 
object from the tray. It’s an interesting fretwork-type 
effect that can make a very pleasing object, although 
for 3D printing we would have to model some struts to 
keep the floating parts of the lettering in position!  

The surface tools and projection approaches can 
create very complex effects and designs, but we 
mentioned earlier that they have their limits. How, for 
example, could we create a pattern or text that flows 
completely around a cylinder or other curved shapes? 
Next up, we’ll look at other tools and techniques to get 
us solving these issues, and more.  

VECTOR GRAPHICS
For our example of projecting a part onto a curved 
surface, we have used a small dog logo, which 
was imported as an SVG and then extruded into a 
part. The SVG file for the dog logo is a single path 
outline – experiments with more complex SVGs had 
varied results.

The ability to import an SVG is a really useful 
feature occasionally, and works well. We simply 
went to File > Import and navigated to our SVG. When 
selected, we get a dialog asking if we want to import 
as a ‘Drawing’ or ‘SVG as Geometry’. We need to 
select the latter, and then the dog logo is imported and 
appears in the file tree as an object labelled ‘Path’. On 
the Part Workbench, if we select the imported SVG 
and then click the Extrude tool, we can extrude in the 
usual way. We extruded the little dog logo to 2 mm.

There are also ways to import an SVG and convert 
the SVG into a sketch so that we can constrain its 
contents, making it usable in other Workbenches. A 
useful video tutorial on this, by the author, is available 
here: hsmag.cc/ImportSVG.

Figure 10 
Combining our new 
skills, it’s easy to 
project text onto 
curved surfaces

Figure 11 
The depth setting 
in the projection 
dialog makes it easy 
to create cut-out 
projection effects

http://hsmag.cc/ImportSVG
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n the previous section, we looked at 
projection as a tool to add geometries 
or objects onto curved surfaces. In this 
month’s tutorial, we will discuss the limitations 
of projection and look at how we can map 
sketches onto the surfaces of curved objects. 

Along the way, we will make a geeky maker ring 
to 3D-print, and we will also explore some more 
complex uses of the Curves Workbench.

Last month we projected objects onto curved 
surfaces, and this works well in many instances. It 
has some limitations, though; the major one is that by 
design, projection works with a fixed projection view 
and as such, it can’t be used to wrap a design around 

another design. Let’s start by looking at how we can 
wrap a sketch around a cylindrical object.

Open FreeCAD and use the Addon Manager to add 
the Curves Workbench. Click Tools > Addon Manager. 
When the list populates, scroll to the Curves 
Workbench and click to install. Once downloaded and 
installed, you will be prompted to restart FreeCAD.

Once you have restarted FreeCAD, open a new 
project. For our first example, let’s start in the Part 
Workbench. Click the ’Create a cylinder’ tool icon 
and then highlight the ’cylinder’ object in the file tree. 
In its dialog box, change the radius to 10 mm and 
the height to 30 mm. Next, let’s switch over to the 
newly installed Curves Workbench. In the preview 
window, select the surface that forms the outer wall 
of our cylinder, and then click the ’Map a sketch on 
a surface’ tool icon. You’ll notice in the file tree view 
that a new ’SketchOnSurface’ object appears and 
that this is a drop-down menu item. If you click it to 
open the drop-down menu, it should contain only one 
item: mapped sketch. If you double-click on this item, 
it will open the Sketcher Workbench. In the sketch, 
there will be a blue rectangle. When geometry lines 
in sketches in the Sketcher Workbench are blue, it 
means that they are construction geometry that acts 
as a guide but doesn’t appear in the sketch as part 
of the object. They have many uses, but in this case, 
the ’Map a sketch on a surface’ tool has created a 
construction geometry that matches the dimensions 
of the cylinder’s face and acts as a containing area 
for our mapped sketch. For a first simple example, 

Learn to work with curves as 
we make a piece of jewellery

Design your 
own ring

I

Figure 1 
An example of mapping sketches around cylinders, this ‘maker 
chic’ 3D-printed ring acts as a spanner for M2 to M5 nuts!
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let’s draw a rectangle somewhere inside the blue 
construction rectangle (Figure 2).

Having drawn a rectangle inside the construction 
geometry, close the sketch and you should 
automatically return to the Curves Workbench. 
You should now see the rectangle we drew on the 
surface of the cylinder in relative position when the 
blue construction geometry is wrapped around the 
cylinder. If you don’t see your mapped rectangle, 
rotate the cylinder as it may be positioned out of 
view. You can now close the drop-down mapped 
sketch on the file tree and when you select the 
parent SketchOnSurface item, the small mapped 
rectangle should be green and selected in the 
preview window. Selecting this, we can perform 
some operations on this sketch like any other. With 
the sketch highlighted in the dialog, set the ’Fill faces’ 
option to ’true’ and then increase the ’thickness’ a 
few millimetres. You’ll see the sketch is extruded out 
from the face of our cylinder (Figure 3).

It’s perhaps worth pointing out that the resulting 
objects made using mapped sketches work in the 
same way as other objects with regard to the Part 
Workbench and other tools. In Figure 4 (overleaf), 
you can see that we have added some fillets to the 
edges of the part and used the appearance menu to 
set the object’s colour. We’ve also gone one step 
further in that we have clicked the surface of our 
mapped object and created another SketchOnSurface 
object to create the small extruded hexagon.

As well as adding more mapped sketches to 
build up complex geometries, we can use Part 
Workbench tools such as the Boolean operation 
type tools to make cut-out parts using the mapped 
sketch. As an example, we thought of a fun mini 
project to make and 3D-print. We are going to make 

a useful (ish!) 3D-printed ring. Let’s start in a new 
project and once again with the Part Workbench. 
Create a cylinder that is just a fraction larger than 
the diameter of one of your fingers and around 
12 mm tall.

Create another cylinder that is slightly larger 
in diameter but the same height – the difference 
between the first and second cylinder diameter 
will be the thickness of the ring. If you don’t move 
either cylinder, they should be aligned and concentric 
around the origin point. Select the second larger 
cylinder first and then select the first cylinder and 
click the ’Make a cut of two shapes’ tool icon from 
the Boolean tools selection. You should now have a 
basic ring shape. 

Figure 2 
Drawing sketch items 
to be mapped onto 
the face surface of 
our example cylinder

Figure 3 
Using the thickness 
dialog to extrude  
our mapped sketch 
off the surface of  
the cylinder
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Moving to the Curves Workbench, we will  
map a sketch to the outside surface of the ring 
as we did earlier with our cylinder. Click the outer 
surface and then click the ’Map a sketch on a 
surface’ tool icon once again. Click to drop-down  
and double-click the mapped sketch, which will open 
in the Sketcher Workbench.  

Our idea for this maker ring is that we will cut  
out some hexagonal shapes that not only look 
decorative but will serve as an emergency small 
spanner tool. As such, inside our construction 
geometry, we added some hexagons sized to 
common small metric nut sizes. We went for M2, 
M2.5, M3, M4, and M5. You don’t need to fully 
constrain the sketch, but we opted to align one line 
of the hexagon with a vertical constraint so that we 

could then constrain the nut size by selecting  
two opposite points and applying a horizontal 
dimension. We added roughly 0.1 mm to the  
M-series given nut sizes to make them an easy fit 
– you can see the sizes we used in the constraint 
values (Figure 5). We preferred our hexagon 
spanners positioned randomly, but you could 
constrain them to be on the centre line and more 
equally spaced if preferred.

Once you are happy with your hexagons, close 
the sketch and you should see the mapped sketch 
around our ring. Select the SketchOnSurface object 
and, in the dialog, set ’fill faces’ to ’true’ – but this 
time, add a negative value equal to the thickness 
of your ring design in the ’thickness’ input. Our ring 
is 2 mm thick, so we went with -2 mm. This should 
now have extruded the mapped sketch through the 
ring (Figure 6).

Now that we have all the objects created, it’s a 
case of moving to the Part Workbench and selecting 
the ring first, then the SketchOnSurface object, and 
then creating a cut of the two parts to create our 
ring. We can then use File > Export to save our ring 
as an STL file suitable for slicing and printing. You 
can see the ring we made in Figure 1.

Using the sketch mapping tools on the Curves 
Workbench is just one example of what can be done 
with this workbench. Almost every tool on the Curves 
Workbench could have a tutorial written about it, 
but let’s look at a couple of tools to make a complex 
curved surface that curves in all axes.

We are aiming to make an object that looks like an 
aeroplane cockpit canopy cover as it’s a challenging 
shape to model. Again, we are not particular about  
the dimensions of the object and, as such, we 
are not worried about constraining aspects of 
the design.

Figure 4 
Parts created using 
mapped sketches 
behave similarly to 
other objects, and you 
can add fillets and 
chamfers and change 
their appearance 
settings as usual

Figure 5 
Our mapped sketch 
laid out and partially 
constrained with 
the M-series nut 
dimensions, plus a small 
clearance allowance

Figure 6 
Our hexagonal spanners extruded through the ring using  
a negative thickness value
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To begin, create a new 
project, move to the Part 
Design Workbench and create 
a body. Create a sketch in the 
XY plane; in this sketch, let’s 
create a B-spline. This B-spline 
is going to be the lower side 
edge profile of our canopy 
cover. Click the B-spline tool and start the B-spline 
attached to the X axis to the left of the  
origin point. Add some points and then finish the 
B-spline to make it look similar to the left-hand side 
of Figure 7. Before we close the sketch, select the 
B-spline that we just made and click the ’Create a 
symmetric geometry with respect to the last selected 
line or point’ tool to add a mirrored B-spline on the 
right-hand side of the Y axis line (Figure 7).

Create another sketch in the active body, but this 
time in the XZ plane. We need to import the 
endpoints of the mirrored B-splines that sit on the XY 
plane (the starting end of the B-splines in the previous 
sketch). In the new XZ plane sketch, click the ’Create 
an edge linked to an external geometry’ tool and 
zoom in to select the endpoints of the two B-splines 
from the first sketch. Now that we have those points 
available, draw another B-spline that begins with the 
point constrained to the left-hand B-spline from the 
first sketch. Place the second B-spline point on the Z 
axis line above the origin and attach the final B-spline 
point to the imported edge of the mirrored B-spline. 

CURVED CONE
If you want to map a sketch onto a cone shape and you want to work in Part Design, 
the ’Map a sketch to a surface’ tool works a little differently. You have to draw your own 
construction geometry and do things in a slightly different order. As an example, in a new 
project, move to the Part Design Workbench. Create a new body and create a first sketch 
in the XY plane. Create a circle roughly 100 mm in diameter around the origin point. Close 
this sketch. Create a second sketch in the XY plane and draw a smaller circle for the 
top of our cone around the origin point – again, don’t worry about constraining these 
sketches too much. Closing the second sketch to return to Part Design, highlight the 
second sketch and in the dialog, under the ’Attachment’ submenu, go to ’Position’ and 
raise the Z axis value – we went with 25 mm, to move the sketch upwards.

Select both the sketches in the file tree and then click the yellow and red ’Loft a 
selected profile through other profile sections’ tool icon. Click OK and you should have 
a cone. Moving to the Curves Workbench, select the curved outer face of the cone and 
then click the ’Map a selected sketch’ button. Different to earlier examples, you will see 
that a mapped sketch object appears without the SketchOnSurface object. Double-click 
the mapped sketch object and you will move to the Sketcher Workbench, but there won’t 
be any construction geometry.

Toggle the ’Toggles the toolbar or selected geometry to/from construction mode’ 
button to turn the sketching tools blue, and then draw a construction geometry rectangle 
from the origin point. You can work out the exact shape and size of the curved cone 
surface limits, but for this example we just drew a rectangle that would fit on the cone 
surface with room to spare.

Toggle the Sketcher tools back so that they no longer draw geometry objects, and 
draw an object inside the rectangle. We went for a ‘slot’ object. Close the sketch to 
return to the Curves Workbench. Finally, select both the ’additive loft’ object that is our 
cone and the mapped sketch in the file tree and then click the ’Map a selected sketch’ 
button again. It should now create the SketchOnSurface object and map our slot onto 
the cone’s surface. Similar to earlier examples, we can add thicknesses and perform cut 
operations to create our design.

Figure 8 
A B-spline in an XZ plane sketch attaches the rear edges of the 
original B-splines and will form the rear edge of the canopy

Figure 7 
Using the ‘Create a 
symmetric geometry’ 
tool on the Sketcher 
Workbench to create 
two B-splines that will 
form the side edges 
of our canopy
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and press the SPACE bar. You should now see the 
blue lines and labels for the XY, XZ, and YZ planes. 
Click the ’Create a new datum plane’ tool icon on 
the Part Design Workbench. You should see a ’Plane 
Parameters’ dialog box appear in the Combo view 
area. At the top of the dialog, you will see four boxes 
with ’No reference selected’ written in each box. 
To the left of the first box, the button text should 
read ’Selecting’ – if for any reason it doesn’t, click 
on that box until it does. If we imagine our desired 
new datum plane by visualising where we want to 
sketch, we could describe the plane as a sort of XZ 
plane moved to the far end of our original mirrored 
B-splines. This kind of hints as to how we will create 
the new datum plane. First, let’s click on the XZ plane 
that we made visible in the preview window. You 
should now see that the new brown-coloured datum 
plane moves onto the XZ plane. Double-check the 
dialog; you should find that the first box now has 
’XY_plane’ in the input, and the button now says 
’Plane’. Click the button until it returns to ’Selecting’. 
Finally, we need to move and zoom to select the 
endpoint of one of the mirrored B-splines we made 
in the original sketch. This should make that vertex 
point the reference of our new datum plane, which 
stays oriented as parallel to the XZ plane. Once it’s 
in place, you can click OK to close the datum plane 
dialog (Figure 9).  

With the new datum plane highlighted in the file 
tree, click the ’Create a new sketch’ tool to open a 
new sketch. Import the B-spline endpoints to the 
sketch and make a smaller B-spline to form the front 
of the canopy in the same way that we did the sketch 
for the canopy rear on the XY plane.

Creating datum planes is an incredibly useful  
tool in many projects”

”

Figure 9 
Setting up a new 
datum plane to 
attach a sketch to

Figure 10 
Creating a ruled 
surface is the first 
step of creating our 
final curvy canopy

Often in mapped 
sketches objects 
cover the 
construction 
geometry. Click the 
‘When in edit mode 
switch between 
section view and 
full view’ tool to 
solve this.

QUICK TIP

When you finish this B-spline, you should have a 
symmetrical curve that will form the rear edge of our 
canopy design (Figure 8).

We now need to add a similar smaller B-spline that 
will connect the front ends of the original mirrored 
B-splines to form the front edge of our canopy design. 
Of course, these points don’t sit on a datum plane, 
so we need to add a datum plane to work on first. 
Creating datum planes is an incredibly useful tool 
in many projects. To help us set up our new datum 
plane, let’s make the three standard plane origins 
visible. To do this in the file tree, highlight ’origins?’ 
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To create a surface for 
our canopy, first we are 
going to make a flat ruled 
surface between the original 
sketch lines and then we 
are going to use the ’Sweep 
profiles on 2 rails’ tool and 
the ’Approximate points to 
NURBS curve or surface’ tool. 
To create the ruled surface, 
move to the Part Workbench, 
select the two B-splines of 
the original sketch, and click 
the ’Create a ruled surface’ 
tool (Figure 10).

Moving to the Curves 
Workbench, in the file tree 
view, select the new ruled surface object and select 
the two sketches that create the rear and front edge 
shape of our canopy design. With these three objects 
highlighted, click the ’Sweep profiles on 2 rails’ tool. 
Your computer may take a little time to process this, 
but once it’s complete, you should have a collection of 
points, or a ’point cloud’ in the preview window that 
is beginning to look like the shape of our aeroplane 
canopy (Figure 11). There are plenty of options to 
increase and decrease the resolution of the point cloud, 
but for this example the default settings are adequate.

To convert the point cloud into a surface, make 
sure that the Sweep2Rails object in the file tree view 
is highlighted, and then click the ’Approximate points 
to NURBS curve or surface’ tool. You should now 

have a perfect canopy surface. Of course, the surface 
created is similar to our earlier ruled surface in that it 
has no thickness dimension – we can, however, use 
familiar tools to create a thicker solid object. With the 
’Approximation Curve’ object highlighted in the file 
tree, you can move to the Part Workbench and click 
the ’Offset’ tool. In the offset tool dialog, you can 
create an offset and check the ’fill offset’ box to create 
a thicker canopy (Figure 12).

We’ve seen a small range of tools on the Curves 
Workbench in this chapter, but we’ve only scratched 
the surface of what this workbench is capable of. As 
ever, there is a heap of knowledge on the FreeCAD 
community forum as well as lots of videos and 
tutorials online to help you explore the rest.  

Figure 11 
Creating a point 
cloud which we can 
convert into a curved 
surface using the 
Curves Workbench

Figure 12 
Our completed 
canopy design 
finished by creating 
a filled offset

Seriously, don’t 
depend on this 
3D-printed ring 
to try and fix your 
bike or anything!

QUICK TIP
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iCad is an excellent open-source 
PCB design package that can render 
populated 3D images of circuit 
board designs. In combination with 
FreeCAD, we can create custom 
component models for KiCad or import 

KiCad PCBs whole, allowing us to design enclosures 
or other surrounding systems. Let’s check out some 
FreeCAD tools that simplify these processes.

One of the concepts in KiCad is that a schematic 
component is assigned a physical footprint from 
a list; that footprint consists of numerous items: 
copper pads, silkscreen drawings, and more, 
which all appear in your PCB design. Commonly, a 
3D model is assigned to the footprint so that you 
can view your components and your PCB in 3D. 
Occasionally a 3D model might be missing or might 
not fully represent your component, or indeed, 
you might be working with a custom footprint and 

component and need to create a 3D model for your 
part. FreeCAD has us covered for this – there’s an 
add-on workbench that contains specific tools to 
make this process much easier.

Start FreeCAD and then install the KiCadStepUp 
Workbench. To do this, go to Tools > Addon 
manager and find the KiCadStepUp Workbench in 
the list, then click Install. Once downloaded and 
installed, you will be prompted to restart FreeCAD. 
Once restarted, you should see the workbench in 
the workbench list. Start a new project in FreeCAD 
and move to the KiCadStepUp Workbench, where 
we’ll first take care of a little housekeeping.

Once in the workbench, click Edit > Preferences 
and scroll down the icons on the left-hand side 
to find the preferences for the KiCadStepUp 
Workbench. Click that icon, and at the top of the 
page, there is an area to set up the paths to where 
KiCad stores its 3D models. To find these, open 

Figure 1 
A PCB file imported 
from KiCad with 
missing models 
added with FreeCAD, 
and a rudimentary 
enclosure design 
added

An open-source workflow for 
electromechanical creations

FreeCAD: Working 
with circuits

K
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KiCad and click Preferences > Configure Paths, 
this should open a dialog box that shows the 
locations and paths set within KiCad. Copy the 
paths to the relevant 3D model file locations and 
put them in the boxes in the FreeCAD KiCadStepUp 
preferences dialog.

The first thing you might want to do in FreeCAD 
is to move over to the KiCadStepUp Workbench and 
do a quick test to import a 3D model of a KiCad PCB. 
In FreeCAD, open a new project and then move over 
to the KiCadStepUp Workbench and click the yellow 
icon with a green arrow which reads ’Load KiCad 
PCB Board and Parts’ as you hover over it. Navigate 
to one of your KiCad PCB board files (the file in the 
KiCad project that ends .pcb) and open it.

You should notice a couple of things (Figure 2). 
The first thing is that when you use a tool icon on 
KiCadStepUp, it automatically launches a floating 
toolbar with a collection of the most commonly 
used KiCadStepUp tools on it. You can move this 
out of the way, or indeed close it, but the toolbar 
will persist when you move to other workbenches, 
which, later in this tutorial, we will find useful!

Secondly, you should see your PCB import as a 
3D model. You will receive a couple of messages 
about the import – just close these, and you should 
be left with your PCB in the preview window. The 
imported PCB doesn’t have the traces visible or the 
silkscreen items. You can import the silkscreen 
using a KiCad DXF export and importing into 
FreeCAD, but most of the time, we probably won’t 
need that level of detail in FreeCAD. You can create 

the copper traces and pours – we will look at this 
later in the tutorial – but doing so adds complexity to 
the model that you may not need and might make it 
difficult or slow to move the PCB model. You will 
also see that the different components on the PCB 
are listed in the file tree view as separate parts. This 
means that the components can be treated in a 
similar way to any FreeCAD part. You can toggle  

Figure 2 
A small KiCad PCB 
project imported 
into FreeCAD

We’ve used 
the 'tooltips' to 
describe tool  
icons in every part 
of this FreeCAD 
series. If you are 
struggling to find 
the tool icon, hover 
over a few and read 
the tooltips!

QUICK TIP

GETTING PERMISSION
It’s highly likely that if you are creating 3D models 
for KiCad components, you will want to save them 
into the 3D packages folder so that you can quickly 
find them and use them in KiCad. We run KiCad on 
Linux, and by default, when installed, the library and 
modules folders are only read and writeable as the 
root user – the general user won’t be able to make 
changes. On Linux, we can use a terminal to switch to 
be the root user and use the classic chmod command 
to make the relevant KiCad folders read and writeable 
for our regular user login. Press CTRL, ALT, and T to 
open a terminal, then switch to root user using the 
command sudo su and put in your password when 
prompted. Once logged in as root, input the following 
command using the file path to the folders you want 
to make read and writeable. We’ve opted to make all 
the folders inside our KiCad modules folder read and 
writeable, and as such, our command and file path 
read: chmod -R a+rw usr/share/kicad/modules.
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individual parts’ visibility, for example, by 
highlighting the part in the file tree and pressing the 
SPACE bar.

Sometimes when working in KiCad, you’ll design a 
board using a component or components that don’t 
have a 3D model for you to use in the 3D viewer. 
Or indeed, you might be creating a custom footprint 
and custom components for use in KiCad and they 
won’t have a standard 3D model or models. We say 
’models’ because often in KiCad, an object or part 
in the 3D viewer will have multiple models lined up 
to create the 3D view. In Figure 3, you can see a 
PCB we are working on that uses a 4.4 mm wide 
TSSOP16 package IC which is missing in KiCad’s 
3D viewer. The footprint is there, and we can see 
the copper pads, vias, and silkscreen, but the actual 
placed component isn’t there. The footprint that 

is there is actually a 3D model of the small part of 
PCB board it populates and all the geometry of the 
footprint. If we create a model of the component 
that would be placed on top, we can add this to 
the list of items included in the KiCad 3D viewer to 
complete our 3D board view.

The first step of this is to identify some 
accurate dimensions for the part. Most electronics 
components will have these details in their 
datasheet, which are available online. We found 
a diagram for the correct TSSOP16 package that 
matched our component and used this to create our 
simple 3D model.

Armed with our dimensions, we fired up FreeCAD 
and began to model our part. We went for a 
simple approach that dimensionally represents the 
component but is only representative in design 
and lacks detail and refinement. We used the Part 
Workbench and began with a rectangle sketch that 
we cloned 16 times and aligned to create the pins 
of the IC component. Using the simple clone tools 
on the Sketcher Workbench is definitely useful for 
creating multiple similar parts such as these pins. 
Our IC is a little over 4 mm wide, and as such, each 
pin rectangle was 0.65 mm wide. It’s worth noting 
that at this scale, FreeCAD will automatically slip 
between mm, μm, and nm when you are applying 
constraints, but if you replace the unit letters, you 
can, of course, input them as fractions of a mm.

Having laid out our 16 rectangles to represent the 
pins, we extruded the sketch on the Part Workbench 
up to a height of 0.5 mm. Right-clicking on the 
extrusion in the file tree, we clicked Appearance and 
set the colour to a silver/grey (Figure 5).

We then added a second sketch via the Part 
Workbench and drew a simple rectangle that 

CENTRE LINES
When we found the dimensions for our IC package, 
we noticed that the dimensions for the pin spacings 
were drawn and labelled relative to the centre line 
of the pin. As we had this information, it made sense 
to use it, and as such, we added an extra point 
constrained to the centre of the short vertical line of 
the pin. This meant that we could then use this point 
on each pin rectangle to positionally constrain the 
pin without converting any dimensions off the original 
drawing. To add a point in the Sketcher Workbench, 
you simply use the 'Create a point in the sketch' tool.

Figure 3 
A PCB we have 
designed in KiCad 
that uses an IC 
package that doesn’t 
have a 3D model in 
the standard libraries

Figure 4 
Most electronics 
component packages 
have details of their 
dimensions within their 
datasheets, which can 
be found online
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would represent the body of the IC component. As 
we had positionally constrained our pin sketches 
around the origin point of the XY datum plane when 
we constrained the 
rectangle, similarly it 
meant it was in the 
correct position. We 
then extruded the 
rectangle to the height 
of the IC package taken 
from the datasheet. We 
added a tiny chamfer 
to the upper outer 
edge of the extrusion as a token nod to modelling 
prettily! Finally, we changed the appearance of the 
extruded rectangle to black – you can see this in 
Figure 7. Once we were happy with the look of our 
package, we selected the pins and the body of the 
IC model and used the Union operation on the Part 
Workbench to create a single fusion object. This is 
important as KiCadStepUp can only export a single 
object as the 3D model to be used in KiCad.

Having created our simple model, the 
KiCadStepUp Workbench has some great tools 
allowing us to check the fit and position of the 
model relative to the KiCad footprint model. On the 
KiCadStepUp Workbench, click the ’Load KiCad PCB 
Footprint’ tool and navigate to the footprint file for 
the component you are modelling.

Select the footprint and it will be imported into 
the preview window of FreeCAD and appear as a 
folder of items in the file tree view (Figure 6). When 

we imported the footprint, it aligned pretty well with 
our model of the IC, but we wanted to move it very 
slightly. If you have created your model away from 

the origin point, you can 
right-click and select 
Transform in the usual 
way to move the part 
around in the preview 
window to get it roughly 
positioned. Then in the 
KiCadStepUp toolbar, 
there are some clickable 
buttons for the X, Y, and 

Z axes, and you can set tiny increments in their 
dialogs. We tweaked our model in increments of 
+- 0.01mm to get the pins of our package well  

We used the Part 
Workbench and began with 

a rectangle sketch that  
we cloned 16 times

”
”

Figure 5 
Our very simplified 
approach to 
creating the IC pins 
– the model will be 
representative and 
will be accurate in 
the area that the 
component sits in, but 
isn’t finely modelled

Figure 6 
Loading the KiCad 
footprint file into 
FreeCAD allows us to 
position and check 
our 3D-modelled 
component
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aligned on the pads of the imported footprint 
(Figure 7 overleaf). You can also see that the 
KiCadStepUp toolbar is available for use when open 
and undocked, even though we are on the Part 
Workbench. This is a really useful feature.

Once you are happy with the position of your 
component, it’s time to export the model to the 
correct file path to be then used in KiCad. Again, 
with the model selected as our single fusion object 
in the file tree view, we clicked the ’Export 3D 
model to KiCad’ tool icon. When you click this icon, 
some dialog boxes will appear: the first two are 
’mesh deviation’ and ’crease angles’, which we left 
with their default values. The next two dialogs ask if 
you want to change the colours of the parts of your 
model from their current values to suggestions that 
match common options used in KiCad. We left both 
our colours on the ’as is’ option to use the colours 
set in FreeCAD, but feel free to experiment. Once 
you have OK’d the dialogs, two files will be created: 
a WRL file and a STEP file. On our machine using 
the stable Linux app 
image of FreeCAD 0.19, 
these two files were 
written to the folder 
that our app image is 
stored in. Find the two 
created files on your 
machine and note that 
they are titled with 
whatever the highlighted part was called in the 
file tree, in our case, ’fusion’. We renamed both 
the files to a more useful and descriptive name, 
TSSOP16_4.4mm – we then copied and pasted 
them into the correct KiCad folder. In our instance of 
KiCad, the 3D packages are located as usr/share/
KiCad/modules/packages3d. Within that folder, 

we then navigated to the folder that would make 
sense to store the model we had created; for our 
model, this was the Package_SO.3Dshapes – we 
pasted our two files here. Having saved everything, 
we can now close FreeCAD and launch KiCad once 
again. Opening up our PCB project, we now need 

to assign the additional 
component model to 
our footprint. There are 
a few different places 
in KiCad that we can 
create this association, 
but as this is a complete 
PCB project, we did it 
from within PCBNew.

Opening the project in PCBNew, we selected 
the component footprint and pressed the E key 
to edit it. In the resulting ’Footprint Properties’ 
window, there is a tab called ’3D Settings’. At the 
top of this tab there is a window with a list of 3D 
models currently associated with this footprint. In 
this case, there is just one model, and the model 
is the 3D render of the footprint without the placed 
component on top. Brilliantly, KiCad allows you 
to connect multiple models to each instance of a 
footprint, so we can add our component here. First, 
click the ’+’ icon to create a new empty item in the 
list. Next, click the folder icon, which is next to the 
+ icon, to set a path to the component model file. 
Navigate your way to find the WRL version of the 
files we exported from FreeCAD and moved to the 
correct KiCad module subfolder. Once selected, you 
should see a preview of the model. Click OK and 
check that the new listing is ticked in the checkbox 
(Figure 8). Close the Footprint Properties window 
and then select View > 3D Viewer. If everything is 
well, you should now see your PCB rendered with 
your nice new 3D component model. In our project, 

KiCad allows you to connect 
multiple models to each 

instance of a footprint, so we 
can add our component here

”
”Figure 8 

Adding our new 3D 
model to be rendered 
in position on our 
PCB project in KiCad

Figure 7 
With the fusion  
part selected in the 
file tree, you can use 
the translation tools 
from KiCadStepUp 
Workbench to  
nudge the part into 
an exact position

Looking at your 
footprint in the 
Assign Footprints 
window in Eeschema 
in KiCad can be  
useful to work out 
the file path to a 
footprint location to 
open in FreeCAD.

QUICK TIP
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we repeated the above steps twice as we had two 
of the same IC component on our board. You can 
see the 3D view in KiCad is now complete with all 
its components (Figure 9).

While creating models for missing 3D 
components for KiCad is a great achievement, 
we have only really scratched the surface of what 
the KiCadStepUp Workbench can be used for. 
Of course, the most obvious use is to be able to 
create CAD models of projects around the PCB 
model. All the usual FreeCAD tools are still at our 
disposal, and as a super-quick example, we made 
a simple tray enclosure using a body in the Part 
Design Workbench (Figure 1). You can use all the 
usual tools and tricks; for example, you can toggle 
between section and full view in the Sketcher 
Workbench with the PCB model behaving like any 
other object. We created a pocket in our padded 
enclosure idea and moved the PCB model into a 
rough position inside the pocket. As an example of 
how useful this tool can be, we highlighted both 
the enclosure body and the PCB model in the file 
tree view and then clicked the ’Check Interferences 
and Collisions’ tool icon on the KiCadStepUp 
Workbench. It took a short while to process, but you 
should see that the Report View window opens and 
a list is slowly generated of any components that 
collide with any other components in the complete 
design. If you have parts of your PCB touching or 
overlapping your enclosure or design, they will 
be picked up in this operation; however, it will 
also list the touching components on the PCB, for 
example, where a pin passes through a hole. This 
is useful in itself, but you might also notice that it 
creates collision parts in the file tree – these are 

small 3D parts created only where collisions and 
interferences occur. It’s not immediately apparent 
why this might be useful, but if you consider that 
you could use these collision parts in combination 
with boolean operations to cut away parts of an 
enclosure where objects are overlapping, you can 
see that these models have merit, and, of course,  
if they aren’t of use, you can simply delete them!  

FINER DETAILS
Often a simple model of a PCB is going to be most 
useful, enabling us to design around it and see how it 
fits within our design. As such, KiCadStepUp imports 
the simplest version of the PCB file that it can, simply 
the board edges and the component models, so we end 
up with a model that has the dimensional geometry of 
our PCB. However, we can also use KiCadStepUp to 
add more detail to our PCB model. One of the simplest 
ways is to add the traces and copper pour layers into 
our 3D model. To do this, select the imported PCB part 
in the file tree and then click the ’ksu tools Add Tracks’ 
tool icon. When you click the item, reselect the KiCad 
PCB file for the project and then click Open. This may 
take some time and also will increase the complexity of 
the model, but you should see your traces and copper 
pour appear on your PCB model. 

Figure 9 
Success! Our new 
IC models correctly 
placed in the KiCad 
3D viewer
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TL files have been around since 
the 1990s, and in simple terms, 
they contain a mesh of triangular 
facets that describe the shape of the 
design. STL files are a common mesh 
format to use in 3D printing where they 

are imported into a ‘slicer’ piece of software that 
generates the G-code for the 3D printer to follow. 
As such, STL has become a standard file type for 
sharing 3D print designs on sites such as Thingiverse 
and GrabCAD and more. Whilst heavily associated 
with 3D printing, STL can often be used for other 
processes such as CNC milling or routing.

Most of the time, for simple parts, creating an STL 
file in FreeCAD is simple and somewhat automated. 
As an example, let’s quickly create any object in the 
Part or Part Design workbench. In Figure 2, you can 

Figure 1 
A simple example of 
a mesh with an issue 
we have discovered 
using an automated 
analysis tool

Get your designs ready for 3D printing, CNC milling, and more

Getting Meshy 
in FreeCAD

S see we have created a cube object and a sphere 
object in the Part workbench and cut part of the 
sphere out of the cube.

With the cube object selected in the file tree, 
click File > Export and you should see that FreeCAD 
suggests you export the object as an STL file. 
Give the file a name and export it, and it’s ready 
to be sliced for 3D printing. In the background, 
FreeCAD has made a lot of sensible choices about 
the resolution of the mesh of our exported part. 
Put simply, FreeCAD makes a choice about the 
number of triangle facets our exported STL mesh 
object contains.

Sometimes we might want to have more control 
over the mesh that‘s created for our part, and we 
might want to change the resolution to get the best 
results for our project. This is one area where the 
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more specialised tools on the Mesh workbench can 
help. As an example, we have a nose cone part for a 
rocket designed – let’s move to the Mesh workbench 
using the drop-down menu to create some different 
resolution meshes to compare.

On the Mesh workbench, highlight the nose cone 
part and then click the tool that reads ‘tessellate shape’ 
on the tooltip as you hover over it. This tool is also 
accessible by clicking Meshes > Create mesh from 
shape. You should see a dialog box in the combo view 
area, and you should see two changeable values on 
the Standard tab. The first value, ‘Surface deviation’, 

should be 0.10 mm, and the second value, ‘Angular 
deviation’, should be 30 degrees. If they aren’t, set 
them to these values and then click OK (Figure 3).  

RESOLVING RESOLUTIONS  
You should now have two objects in the file tree: your 
original nose cone part and the new mesh object. 
Similar to other items in the file tree, you can toggle 
the visibility of the mesh and the part by highlighting 
the object and pressing the SPACE bar. Select the 
original nose cone part and set it as invisible so that 
we just see the mesh object in the preview window.

You can see in Figure 4 that the created mesh 
consists of lots of triangles closely approximating the 
part, but we can adjust the values to increase the 

resolution of the mesh if we delete our first mesh, 
make the nose cone part visible, and highlight it so 
we can create a new mesh. For this mesh, let’s set 
the surface deviation to 0.03 mm and the angular 
deviation to 10 degrees. You should see, similar 
to Figure 5, that the resulting mesh is a higher 
resolution and more precisely matches the original 
part. Of course, this also increases the complexity of 
the mesh and, if taken too far, may well begin to slow 
down your graphics card performance.  

To export a mesh from the Mesh workbench, you 
can highlight the mesh in the file tree, right-click, and 
select ‘Export mesh’. There are numerous options of 
STL types, but we tend to export as ‘Binary STL’ and, 

Figure 2 
A simple part used as 
an example of how 
easy it is to generate 
an STL mesh file

Figure 3 
Creating a mesh 
on the Mesh 
workbench allows 
for more precise 
control of settings 
and the subsequent 
resolution of the part

While STL files are 
the most common 
mesh file, they aren’t 
the only ones. In fact, 
many would argue 
that STL are not great 
files for mesh objects.

QUICK TIP

FreeCAD has made a lot of sensible choices about 
the resolution of the mesh of our exported part”

”
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these seem to work well with our slicing software for 
3D printing. One thing to note is that the Export mesh 
function seems to want us to add the ‘.stl’ to the file 
name in the name input box.

Of course, creating a mesh file from an object we 
made in FreeCAD is just one small aspect of the work 
of the Mesh workbench. One area it is particularly 
useful in is for editing and amending mesh files. This 
scenario often arises when we’ve found an object 
online that we wish to 3D-print but will require some 
reworking. Often, if you are downloading an object 
from a website such as Thingiverse or GrabCAD, you 
may only have the option 
to download a mesh file/
STL, or indeed you might 
have the project file but it 
is made in software that 
you don’t own.

As an example, we 
have an STL file of a 
hands-free door puller. 
Let’s pretend that, in 
use, we decided it would be better if the hook faced 
the other way round. We could, of course, with the 
knowledge within this FreeCAD, draw this part from 
scratch in a matter of minutes, but let’s use the 
Mesh workbench to make some changes. Click the 
‘Imports a mesh from a file’ tool icon and navigate to 
the STL file and select to import it (Figure 6).

The Mesh workbench has some tools that are 
similar in approach to the Part workbench, where 
we create simple solid objects and combine them 

using Boolean functions to stick objects together, 
or subtract one shape out of another. If we want to 
turn around the hook part of our mesh file, we will 
create a copy of the hooked end and rotate it using 
these tools.

REGULAR SOLIDS  
First of all, click the ‘Build a regular solid’ tool 
icon or select the same tool by clicking Meshes > 
Regular solid. You should now see a small window 
with a drop-down to select various shapes, cubes, 
cylinders, etc., and some entry boxes to add 

dimensions. We will 
create a cube 35 mm 
long, 50 mm wide, and 
10 mm high. Similar 
again to working with 
solids on the Part 
workbench, if you 
highlight the cube object 
in the file tree, right-click 
and select Transform, 

we can then move the cube into place over the 
hooked end of the door puller (Figure 7).

Next, select the two objects in the file tree and 
click the ‘Intersection’ tool icon. You will now see an 
additional item in the file tree labelled ‘Intersection’. 
If we toggle the cube item to be invisible and then 
select the intersection item, we can then right-click 
and use Transform to move the intersection object, 
which is a copy of the hook section, away from the 
rest of the door puller object. Next, make the cube 

The Mesh workbench  
has some tools that are 
similar in approach to  

the Part workbench

”
”

Figure 4 
Our first attempt at 
creating a mesh of the 
nose cone part

Figure 5 
Our second mesh resulting in a 
higher resolution mesh, which more 
closely matches our nose cone part

The Intersection, 
Union, and 
Difference Boolean 
operation tool icons 
look like green 
versions of their 
counterparts on the 
Part workbench.

QUICK TIP
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visible once more, select the door puller object and 
the cube and then perform a ‘Difference’ Boolean 
operation on it. You should now have a version of 
the original door puller with no end and a copy of the 
hooked end (Figure 8).

All that remains is to move and rotate everything 
into the new position, and then we can use the 
‘Union’ Boolean operation to create a new single 
mesh object. We can then highlight the new door 
puller union object and click the ‘Export a mesh to file’ 
tool to create our new STL file ready for 3D printing.

Continuing to use our door puller tool project as an 
example, let’s explore how we create a Part object 
from a mesh. Moving to the Part workbench, we can 
highlight the mesh – in our case called ‘Union’ in the 
file tree view – then click Part > Create shape from 
mesh. You should now see that a part has been made 
of our door puller object (Figure 9). Let’s make our 
mesh object invisible in the file tree to explore our part. 
You should see that the part object creates its faces 
and edges based on the triangles in the mesh, which 
means that it is an accurate copy, but also means it 
can be a little challenging to work with. You can, of 
course, select faces and map sketches to faces, which 
is pretty straightforward on larger flat sections of a part 
but gets challenging if you consider the curved part 
of our puller. It can also be useful to convert meshes 
to parts if you want to recreate aspects of a mesh 
design. Converting a mesh to a part means that you 
can use the ‘Link to an external geometry’ tool in the 
Sketcher workbench to pull in reference points to 
create sketches over parts converted from meshes.     

Sometimes we might want to work with extremely 
complex mesh files. If you’ve ever downloaded a 
complex model, such as a model of a person or object 
that’s full of complex organic curves, you might notice 
that your graphics card starts to slow down  when 
you manipulate the object. The FreeCAD   

OPENSCAD
FreeCAD is a community-developed, open-source 
piece of software that uses other open-source pieces 
of code and modules within it. Another excellent 
open-source piece of CAD software is OpenSCAD, 
which uses a code-based approach to 3D modelling. 
Files and models created with OpenSCAD can be 
imported directly to FreeCAD. FreeCAD has an 
OpenSCAD workbench to enable people to use the 
best of both software approaches.

In the Mesh workbench some of the functionality, 
including the Boolean operations we are using in this 
article, require OpenSCAD to be installed and a path 
to the OpenSCAD executable to be set up in FreeCAD. 
Head over to openscad.org and download and install 
the latest version for your operating system. Once 
installed, back in FreeCAD, move to the OpenSCAD 
workbench and then click Edit > Preferences and 
scroll down to select the OpenSCAD icon. In the 
Preferences dialog, the first item is an input box to 
set the file path to the OpenSCAD executable – your 
system should have detected the correct path, but it’s 
worth opening the file location and checking it is all 
set correctly. Once checked, click the Apply button 
and close the preferences.

Figure 6 
Importing an STL 
file to the Mesh 
workbench for editing

Figure 7 
Creating a mesh solid cube and positioning 
it over the part we intend to rotate

You might want to 
install the brilliant 
Rocket workbench 
using the Add-on 
Manager if you want 
to play with the nose 
cone design.

QUICK TIP

http://openscad.org
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Mesh workbench has a handy tool to play with 
optimising the mesh resolution that may be able 
to reduce the data, or put simply, the number of 
triangles in a given mesh while still retaining enough 
detail. This tool is called the ‘Decimation’ tool. Mesh 
decimation must be used in moderation, as taken 
too far, it’s easy to completely destroy the object, 
which can also be a fun experiment. In the preview 
window, let’s zoom in so that we have a close view 
of a part of the internal chamfer on the large hole 
in our door puller object. Notice that when zoomed 
in, you can see the facets that make up the mesh 
surface. As this is a small file, we’ve made this mesh 
a pretty high resolution, but let’s explore the effects 
of decimation. First, select the door puller object, in 
our case called ‘Union’ in the file tree. Notice that in 
the dialog box, once selected, we get some details 
of the number of points, edges, and faces our mesh 
contains. For us, these are 1606 points, 4818 edges, 

and 3212 faces. Next, click the ‘Decimates a mesh’ 
tool, which appears as a green diamond-shaped 
tool icon. In the Decimating dialog box that appears, 
set the reduction level to 50 percent and leave the 
absolute number box unchecked. Click OK. In the 
preview window, if you are still zoomed in, you should 
notice the resolution of our puller part change, it 
should look cruder and the triangles should be more 
obvious (Figure 10).

If we check the details of our mesh object in the 
dialog box, we can see it has reduced the number of 
points, edges, and faces by 50 percent to 803 points, 
2409 edges, and 1606 faces. This carries through to 
affect the file size of an exported mesh, and indeed, 
exporting this decimated version creates a file size 
percent smaller than the none decimated mesh. If 
you zoom out on our 50 percent decimated mesh 
version of the door puller, you’ll see that it makes 
very little real-world difference to the resolution of 
the object, and the size and shape of the object is 
unchanged. You can experiment with the decimation 
value – it can be quite amusing to see what happens 
to a shape when you approach the near 100 percent 
decimation values.

Sometimes we might work with mesh files, or 
indeed create mesh files, that have issues and 
problems. The Mesh workbench has a tool that 
enables us to quickly and repeatedly analyse meshes 
for problems. With our mesh object highlighted, click 
the ‘Opens a dialog to analyse and repair a mesh’ tool. 
This should open a large dialog box on the right-hand 
side of the preview window. There is a list of potential 
problem items that FreeCAD can analyse a mesh 
for. You can analyse a mesh for each item on the list 
individually, or you can click ‘Analyse’ on the ‘All above 
tests together’ option at the bottom of the list. Close 
that dialog box for now, and let’s quickly make a new 
simple object with a problem!  

Mesh decimation must be used in moderation, as taken 
too far, it’s easy to completely destroy the object”

”

Figure 8 
New parts created 
and ready to be 
put back together 
in our improved 
configuration

Figure 9 
With the two parts of 
the puller rearranged, 
we combine them 
back into a single 
mesh using the Union 
Boolean operation 
ready for export
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In a new project, move to the Part workbench 
and create two identical default cube solid objects. 
These default to 10 mm cubes, using Transform, 
move the second cube object up 10 mm in the Z 
axis and across 10 mm in the X axis. Finally, highlight 
both cubes in the file tree view and perform a Union 
operation to make the two cubes – one part called 
‘Fusion’. Moving to the Mesh workbench, with our 
fusion object highlighted, click the ‘Tessalate shape’ 
tool icon to create a mesh object. You can see the 
resulting mesh imported in Figure 1. Make the 
original solid part fusion object invisible in the file 
tree, highlight the mesh object, and then reopen the 
mesh analysis dialog as before. Double-check that 
your mesh object is the object listed in the Mesh 
Information section (especially if you have multiple 
projects open), then click the Analyse button on the 
‘All above tests together’ option. The tests will run 
quickly, and you should see just one error reported.

You should see that in the list of analysis areas in 
the dialog, the ‘Non-Manifolds’ section has a check 
box with one non-manifold issue found. A simple 
way to think of this common error to understand 
when something is non-manifold is to consider if 
it is possible to be manufactured. In this instance, 
our two cubes are only connected at one edge and 
they do not overlap at all, which means, in essence, 
that the connected edge is infinitesimally small. 
Of course, it’s impossible to create a connection 
between these objects, and as such, they are 

described as non-manifold. Another way to create 
a non-manifold example is to create a tube with no 
ends where the surface of the tube has no thickness 
– this can be done using lofting tools or sweeping 
operations in FreeCAD, for example.

FIXING THE ISSUE  
Having analysed our cubes example and found the 
non-manifold edge issue, we may well be tempted 
to click the Repair button next to the offending 
issue in the dialog box. If you try this, FreeCAD will 
automatically apply a repair, but be prepared for this 
to fail as it will only work occasionally on simple 
problems, such as a small gap on a surface that 
needs closing. It’s always worth a try, however, and 
you can always undo any odd changes the repair 
functions apply. For the sake of completeness, let’s 
manually create a solution. If we move back to our 
part object and delete the fusion object so that we 
have our two separate cubes, move the upper cube 
back over and into the lower cube creating a couple 
of millimetres where they overlap. Then create a new 
mesh and analyse it – you should see that you have 
cured the manifold issue.

Finally, while we’ve looked at some useful stuff on 
the Mesh workbench, we have only really scratched 
the surface of what’s available. As ever, there is lots 
more information, and tutorials, to be found online 
on both the FreeCAD community forums and in the 
FreeCAD wiki.  

Figure 10 
Using the ‘Decimate a 
mesh’ tool to reduce 
the resolution of a 
model can make a 
complex model easier 
to work with

Another useful 
tool on the Mesh 
workbench allows us 
to scale mesh object. 
Simply select the 
mesh in the file tree 
and click the ‘Scale 
selected meshes’ 
tool icon.

QUICK TIP
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e have already looked at the 
basics of sketching in the 
Sketcher workbench and then 
occasionally looked at other 
Sketcher features, such as 
cloning and making multiples 

of objects (on page 48). As such a fundamental 
approach to creating parts, it’s certainly worth looking 
at in more depth.

To begin, let’s revisit an approach we have used 
previously which we can use as an example. Open up 
FreeCAD and start a new project, move to the Part 
Design workbench, create a body, and then create a 
sketch in the XY plane.

In your new sketch, draw a rectangle using the 
‘Create a rectangle in the sketch’ tool and don’t worry 
about constraining it. Close the sketch and, back on 
the Part Design workbench, use the Pad function (on 
the ‘Task’ tab in the combo view window) to pad the 

rectangle sketch into a larger cuboid. Next, select 
any face on the cuboid in the preview window and 
click the ‘Add a sketch’ tool to open a sketch that is 
attached to that face.

If we imagine that we want to add a hole to the 
upper right-hand corner of our selected face, and 
that we want the hole to be specifically placed with 
respect to the upper right-hand corner, this is slightly 
tricky. It’s tricky, as the sketch underlying the cuboid 
object is unconstrained and we don’t know its size 
or its position relative to the origin point. We have 
used a tool previously though that allows us to import 
underlying geometry and help us solve this issue. The 
tool we have used is the ‘Create an edge linked to an 
external geometry’ tool which, when selected, allows 
us to select underlying geometry objects, edges, 
and points, and make them selectable in the current 
sketch. So, to accurately place a hole positionally 
relative to the upper right-hand corner, we can simply 
select the right-hand edge of the cuboid and then, in 
turn, use that imported geometry to set horizontal and 
vertical distance constraints to the centre of our hole 
circle sketch (Figure 2).

In essence, what we have done in our hole, in a 
cuboid example, is use an underlying geometry to 
create a guide point in the new sketch onto which we 
can attach constraints. We can see, therefore, that 
guide points can be incredibly useful, but often we 
may need a guide point in a position where there is no 
underlying geometry that we can import. An incredibly 
powerful feature of the Sketcher workbench is that 
we can switch all the drawing tools to ‘construction’ 
mode. In a new project, again move to Part Design, 
create a new body, and create a sketch in the XY 
plane. Find the tool icon that looks like a red box over 
a blue dashed box, where the tooltip reads ‘Toggles 
the toolbar or selected geometry  

Often a sketch is the foundation of a part, and we have only 
looked at the basics. Let’s delve deeper into more intermediate 
features and approaches for sketching in FreeCAD

FreeCAD: 
intermediate sketching

W

Figure 1 
Using the Polyline 
tool, in various modes, 
to trace accurately 
over the imported 
image object



81

to/from constructions mode’, and click it. You should 
see that all your drawing tools now turn from white 
lines in the icon to blue.

You should note, at this point, that drawing whilst 
in construction mode is exactly the same as standard 
mode. All the tools work in the same way; however, 
the geometries drawn will appear as blue lines and, 
when you move back to the Part Design workbench 
or other workbenches, you won’t be able to see any 
construction geometry. The power of construction 
geometry is that, when you toggle back to normal 
geometry to draw visible parts of the sketch, you can, 
of course, attach points or constrain visible sketch 
edges and point to the construction geometry. Toggle 
back to normal drawing tools, and let’s work through 
an example to show this in use.

In Figure 3, you can see the completed object we 
are aiming to make. We’ll use some construction 
geometry to help, but along the way we will also 
explore the ‘Create a slot’ tool that we haven’t used 
yet in this series. First, let’s draw a standard circle in 
our sketch. Select the circle drawing tool and, starting 
from the origin point, draw a circle. Double-check 
your circle is centred to the origin, and then use the 
‘Constrain an arc or circle’ tool to set the diameter of 
the circle to 30 mm. Due to the nature of the plane 
origin point and axis lines, you might now appreciate 
that we have the Y axis line onto which we can attach 
one of our slots correctly but that, as there are three 
equally spaced slots, we don’t have geometry onto 
which we can constrain the further two slots. We can 
solve this by drawing two construction mode lines.

Click the ‘Toggles the toolbar or selected geometry 
to/from constructions mode’ once more, and then 
select the ‘Line’ tool. Click and draw a line that starts 
at the origin point and moves out at an angle to 
meet the edge of the circle. Do this twice, with one 
construction line in the lower right-hand quadrant of 
the circle, and one in the lower left (Figure 4).

Next, click the ‘Fix the angle of a line or the angle 
between two lines’ tool, and select the vertical Y axis 
line and then the lower right-hand construction line. 
As we want the three slots to be equally spaced, set 
this angle to 120 degrees. Repeat this, selecting the Y 
axis line and the lower left construction line so that  

Often we may need a guide 
point in a position where there 

is no underlying geometry that 
we can import

”
”

Figure 2 
Using imported 
external geometry to 
create a guide point to 
constrain items to

Figure 3 
This slotted plate 
uses construction 
mode geometry to aid 
the placement and 
constraining  
of the slots



TUTORIAL

82

FreeCAD: intermediate sketchingFreeCAD: intermediate sketching

we have both our construction lines correctly 
positioned (Figure 5).

Select the ‘Create a slot in the sketch’ tool, and 
make sure you have toggled the drawing tools 
back to normal mode and you aren’t still drawing 
in construction mode. Draw a slot by clicking 
somewhere on the vertical Y axis line and dragging 
down towards the centre of the circle, but don’t 
connect the sketch to the centre origin point. Notice 
that when you draw with the slot tool, numerous 
constraints are automatically added, and this includes 
that the slot is either vertically or horizontally 
constrained. Let’s fully constrain this slot. Begin by 
selecting the lower point on the Y axis line and set 
a vertical distance between it and the origin point 
of 5 mm. Next, select the two points in the slot that 
are on the centreline, and create a vertical distance 
between them of 20 mm. To set the width of the slot, 
select either set of two points that are at the end of 
the outer line, and mark the connecting point of the 
arc which forms the slot end. With two selected, set 
the distance between them as 3 mm. This results in 
a fully constrained slot with a length of 23 mm (slot 
length, plus the radius of the arc at each end) and a 
width of 3 mm (Figure 5).

SORTING YOUR SLOTS
To draw the other two slots is slightly more complex. 
Draw a slot of any size in the lower left-hand 
quadrant. Again, the drawn slot will be constrained to 
vertical or horizontal automatically, and so we need 
to delete those constraints to be able to position it 
on an angle. Find the small red horizontal or vertical 
dash that is the constraint. Highlight this with a left-
click and delete it with the DELETE key. You should 
now be able to drag the slot into an angled position. 
To correctly place the slot following the construction 
line, we can use a single symmetry constraint. First, 
select two points that are at the end of the same 
arc forming the end of the slot, and then select the 
construction line. Next, click the ‘Create a symmetry 
constraint between two points with respect to a line 
or third point’ tool – this should now constrain the slot 

‘M’ HOT KEY

A very useful feature within the Sketcher workbench, 
when using the Polyline tool, is the M hot key. When 
the Polyline tool is in use, pressing the M key cycles the 
tool through various modes that are incredibly useful. 
To explore this in a new sketch, select the Polyline tool 
and draw a few random lines in the standard mode. 
Without right-clicking to complete a polyline, press 
the M key once. This first new mode enables you to 
automatically place a right angle line segment. Click the 
M key once more, and it will cycle the angle placement 
relative to the last polyline point. Click M again, and you 
can now draw an arc that is anchored tangentially on 
the last point of the line. Another M press changes the 
arc orientation, and a final M press allows you to draw 
an arc anchored to the last point, but not tangential. 
Whilst this sounds complex in description, it’s simply 
a case of playing with the Polyline tool and it soon 
becomes instinctive.

The Image 
workbench works 
with lots of common 
file types, including 
SVG. However, you 
might be able to 
import an SVG as 
geometry, negating 
the need to sketch it!

QUICK TIP

Figure 4 
Setting up a pair of 
construction lines to 
be constrained to the 
correct angle to align 
our slots

Figure 5 
Our construction 
lines created and the 
first slot added and 
constrained on the Y 
axis line
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to be aligned with the construction line perfectly. We 
can now add distance constraints to bring the slot to 
the same relative position as our first slot. However, 
note that, due to the angle, we can’t use vertical or 
horizontal distance constraints, so we need to use the 
‘Fix the length of a line or the distance between a line 
and a vertex’ tool.

Repeat the above to get all three slots fully 
constrained, and then close and pad the sketch to 
get the final result. Whilst this is a relatively simple 
example, it does show how combining construction 
geometry alongside 
regular geometry is 
a powerful sketching 
approach. You can use 
all the drawing tools in 
construction mode and, 
as such, there is no end 
to the possibilities.

Moving away from 
construction mode, 
another really useful pair of tools are the ‘Extend an 
edge with respect to the picked position’ and the 
‘Trim an edge with respect to the picked position’ 
tools, the latter of which is particularly powerful. If 
you have used Inkscape, the excellent open-source 
2D vector graphics software, you probably have used 
the concept of Boolean operations, union, difference, 
intersection, and more, to combine different primitive 
shapes. This is similar to how, in the Part workbench, 
we use Boolean operations to combine primitive 
solids. It’s a feature in Sketcher that I missed at first, 
until I discovered the ‘Trim an edge with respect 
to the picked position’ tool. As a simple example, 

let’s open a new project and again move to the Part 
Design workbench, create a new body, and then a 
sketch on the XY plane.

In this sketch, first let’s select the ‘Create a circle 
in the sketcher’ drawing tool, and draw a circle 
anywhere on the plane. Next, select the ‘Create a 
rectangle in the sketch’ tool, and draw a rectangle 
that overlaps the circle. If we now select the ‘Trim an 
edge with respect to the picked position’ tool, we can 
use this to get rid of parts of lines we don’t require. 
If you click a line that intersects another line, that line 

section will be deleted, 
even if they are from 
separate objects like our 
circle and our rectangle. 
In Figure 6, you can see 
that we have deleted 
two line segments inside 
the circle that belonged 
to the rectangle circle.

We can of course also 
remove the line that belongs to the circle that is in 
between the lines of the rectangle in exactly the same 
manner. That just leaves the now disconnected line 
left over from the rectangle that is free-floating inside 
the circle (Figure 7). If we now try and use the ‘Trim 
and edge with respect to the picked position’ tool, we 
will get an error message. The Trim tool is only of use 
when a line intersects or is connected to another line. 
If we had deleted this line first using this tool, it would 
have worked as it was still connected to the rectangle, 
but now this tool will fail. For non-connected lines 
such as this one, you can simply left-click on it to 
select it as an item and press the DELETE key. 

The Trim tool is only of use 
when a line intersects  

or is connected  
to another line

”
”

Most of the 
functions we have 
shown in this article 
work whether you 
are in construction 
or normal mode 
in Sketcher.

QUICK TIP

Figure 6 
Using the ‘Trim an 
edge’ tool to remove 
intersecting lines
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A similar useful tool is the ‘Extend an edge with 
respect to the picked position’ tool. In a new project 
and a new sketch, draw a rectangle and then draw 
some polylines near the rectangle that don’t quite 
meet the rectangle lines, similar to Figure 8. Next, 
select the ‘Extend an edge with respect to the picked 
position’ tool and left-click on one of the lines that 
doesn’t meet the rectangle. If you move the cursor, 
you can now extend this line to any position you like 
or, as it crosses the line forming part of the rectangle, 
that line will become highlighted meaning that you 
can attach the line to the rectangle at that point 
(Figure 9). This tool works not just on straight line 
geometry, but will also work to extend arcs and more.

Another slightly advanced sketching approach is 
the concept of sketching over an imported image, 
or images, to create some geometry that matches a 
real-world object. To do this we can use a separate 

workbench, ‘Image’, to import picture files to 
particular planes. We also can then scale the images 
correctly and more. Let’s create a new project 
and move to the Image workbench. On the Image 
workbench, you will see that there are three main tool 
icons. Find the tool icon that reads ‘Create a planar 
image in the 3D space’ and click it. Next, navigate to a 
picture file you want to import (Figure 10).

FINAL STEPS
Once you select an image, you will get a dialog box 
asking which plane you would like to attach the 
image to. We opted for XY in the first instance. The 
dialog box also has an ‘Offset’ input box – this is the 
distance from the selected plane where the image 
is placed. It’s useful, when intending to trace parts 
of the image in Sketcher, to have the image placed 
slightly under the plane, so we added a -0.1 mm 
offset before clicking OK. You should now see your 
image loaded onto the selected plane and you can 
see an ‘imageplane’ object appear in the file tree 
view. Of course, like most items in the file tree, you 
can toggle the visibility of the imageplane item on and 
off using the SPACE bar.

Having imported our image successfully, we can 
switch to the Part Design workbench. Create a new 
body and then create a new sketch in the XY plane. 
If you imported the image with the correct negative 
offset, you should now see the image in the Sketcher 
workbench but with the datum lines above the image. 
To double-check, draw a shape in the sketch and 
make sure it appears over the image. You can now 
begin to draw and trace parts of your image using the 
Polyline tool. Using the M key to cycle through the 
different polyline modes, as described earlier in this 
article, can allow you to quite quickly create outline-
traced sketches of quite complex items (Figure 1).

When you import 
an image, it tends 
to import in an 
angled view. The 
view buttons and 
cube work exactly 
the same with the 
image plane, and 
pressing ‘top’ will 
give you a top-
down view.

QUICK TIP

Figure 7 
Trying to use the Trim 
tool to delete the final 
unconnected edge 
will result in an error. 
However, we can  
simply select the line 
and delete it

Figure 8
Setting up some lines 
that don’t meet, for our 
example of using the 
‘Extend an edge’ tool
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Tracing imageplane objects is an excellent 
approach, but one problem is that images, especially 
photographs, rarely scale correctly when imported. 
If you have followed along and imported an image 
and traced (or partially traced) parts of it, as a test, 
select a line and click the ‘Fix a length of a line or the 
distance between a line and a vertex’ constraint tool. 
You’ll probably see that the length of the line doesn’t 
match the reality of the object. In our case, if we click 
the first line on the upper part of the metal blade of 
our shear in Figure 1, we get a length of 105 mm, 
which is way too big. Whilst there are ways to scale a 
complete sketch using the Draft workbench, a better 
approach in this instance is to scale the imageplane 
object before we do too much work with it. If we 
have access to the object in the image, we can simply 
measure a part of the object.

To scale our image plane object correctly, let’s 
hide the sketch by toggling its visibility in the file 
tree using the SPACE bar. Then, return to the Image 
workbench. Click the ‘Scales an image plane by 
defining a distance between two points’ tool icon and 
a ‘Scale image plane’ dialog box will appear. First, 
input a known distance that applies to two points on 
the object. So we input 46 mm. You then click on the 
first point on the imageplane object, so we clicked 
on the point on the top of the blade at the fulcrum 
point on the shears. Next, you click the second point 
representing the other end of the distance you input. 
In our case, this is the point at which the upper blade 
joins the handle. Finally, the dialog asks you to click 
the imageplane object you want to scale. Then you 
click OK, and the imageplane object is now scaled 
correctly to the object (Figure 11).

With a little forethought, we can make our image 
scaling process a little easier and more accurate. If we 
are creating the image ourselves, there are a couple 
of things we can do. Firstly, ensuring that our image 

is parallel to the object means that when we trace the 
item, we aren’t tracing a skewed version of it. Making 
sure a photograph is taken directly from above can 
help; or, if sizes allow, even better is to create a scan 
image of the object on a flatbed scanner. Finally, if 
you add a ruler or a cutting mat with a grid to the 
background of your image, you can use this as the 
reference points for the ‘Scale image plane’ tool for 
really accurate results.  

Figure 9 
The lines are now 
extended into the 
rectangle – the 
upper line has been 
constrained onto the 
upright line of  
the rectangle

Figure 10 
A photograph 
imported to the XY 
plane, and appearing 
in the preview 
window and in the file 
tree view

Figure 11 
Using the ‘Scale 
image plane’ tool to 
make our reference 
image the correct size
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n this section, we are going to work mostly 
on an add-on workbench called ‘Sheet 
Metal’, so let’s get that installed. Open up 
FreeCAD and click Tools > Addon manager, and 
then scroll down the list to find ‘Sheet Metal’. 
Click to install the workbench, and then close 

the Addon manager – you will get prompted to 
restart FreeCAD.

Once you have restarted FreeCAD, start a new 
project and, as a very simple first example, let’s first 
go to the Part Design workbench, create a body, and 
then create a sketch in the XY plane.

Inside the sketch, let’s create a rectangle around 
the origin point. We don’t need to fully constrain this 
sketch, but let’s give it a horizontal and a vertical 
constraint, making it roughly 12 cm by 6 cm. Once this 
is done, close the sketch. Without making further 
changes to this sketch, we can move straight away to 
the Sheet Metal workbench. In this workbench, with 
our sketch highlighted in the file tree, let’s click the 
‘Create a sheet metal wall from a sketch’ tool icon, 
which should be the furthest to the left on the Sheet 
Metal tools toolbar.

You should see that our sketch has been extruded 
slightly to form a sheet, and that a new object called 

‘BaseBend’ has appeared in our file tree. Similar to if 
we had extruded our part, we can still make changes 
to the underlying sketch, and those will be pushed 
through to the BaseBend object. There are also 
numerous parameters in the BaseBend object dialog. 
Notably, you can adjust the thickness of the sheet – 
this is useful since the BaseBend object, as you will 
see, defines the sheet thickness for the rest of the 
attached design.

Next, let’s select one of the edges on the 
BaseBend object. We selected the upmost edge line 
of one of the longer sides. With that selected, click 
the ‘Extends one or more face, connected by a bend 
on existing sheet metal’ tool icon, which should be 
second from the left in the Sheet Metal workbench 
toolbar. You should now see that we have created a 
new section of our sheet design, folded at 90 degrees 
to the original sheet (Figure 2). This new object 
appears in the file tree labelled ‘Bend’ and subsequent 
bends will be labelled ‘Bend001’, ‘Bend002’, etc. 
Highlighting the ‘Bend’ object in the file tree, we can 
adjust plenty of parameters. We’ll leave the first 
parameter, Bend Type, as it is, set at ‘Material 
Outside’, but have a glance at the options for later on. 
You’ll note that our new folded section is folded down 

Figure 1 
An example design 
that could be 
fabricated from 
a single piece of 
sheet metal

Let’s look at an amazing workbench that makes working with sheet metals, 
or other foldable sheet materials, simple to CAD

Sheet folding in FreeCAD

I
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from the original BaseBend object in the Z axis. If we 
wanted this section to fold upwards, we can change 
the ‘angle’ parameter in the dialog. Setting this to -90 
rotates the folded section to point upwards. Similarly, 
we can set the angle of this fold to any amount we 
choose. Moving down the parameter list, we can use 
the ‘gap1’ and ‘gap2’ 
parameters to make the 
folded object not the full 
length of our attached 
BaseBend edge. So, for 
example, in Figure 3, we 
have added a gap value 
of 10 mm to each of 
those parameters. You 
may need to click the ‘Recomputes the current active 
document’ button or press CTRL+R to see the 
changes in your model.

You’ll notice that not only does the bend object 
reduce in length by the gap amount, but also that 
there are some small ‘relief’ notches automatically 
added at the end point of the bend. This is good 
practice in sheet metal work as, if you fold a bend 
that connects to a straight edge, the end of the bend 
will distort the straight edge at the point it joins it. 
Adding the notch stops this distortion from occurring.

If you wanted to not have a relief notch added, you 
can scroll down to the ‘Parameters relief’ section and 
set the relief factor to ‘0’ and then set the ‘use relief 
factor’ setting to ‘true’. This option might be useful if 
you are using the Sheet Metal workbench to design 
using different materials, such as thin card or plastics. 
Before we move on, please also note that, in the 
‘bend’ object dialog, you can change the length of the 
added bend part. Before we add more bends, undo or 
delete any changes you have made so that we have 
our simple BaseBend, and our first bend object that is 
full length with no gaps, etc.

Next, let’s select one of the short edges of our 
BaseBend rectangle sheet and add a second bend to 
create a wall at 90 degrees. You’ll notice that at the 
corner where the two folds meet, there is a small 
gap. This is a by-product of working in sheet metal, 
where the radius of a fold means that folded sections 

stand slightly off the 
BaseBend object. You 
also may note that the 
two folds join together at 
a very sharp point where 
they join the BaseBend 
object. Again, in real life, 
that sharp convergence 
point could create 

distortions in the piece as it is folded, so it can be a 
good idea to add some corner relief. Corner relief is a 
small cutaway that, similar to the earlier notches, 
stops the metal distorting when folded. To add corner 
relief, we need to select the two edges which run 
into the corner on the BaseBend object. You can see 
these edges selected in Figure 4. 

Figure 2 
Creating an initial 
‘BaseBend’ object 
and adding our first 
folded section

Figure 3 
Adding gaps 
automatically can 
add notches which 
would allow sheet 
metal to be folded 
without distorting at 
the fold point

Corner relief is a small 
cutaway that, similar to the 

earlier notches, stops the 
metal distorting when folded

”
”
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With the two lines selected, the ‘Corner Relief to 
sheet metal corner’ tool icon should become active 
(seventh from the left on the Sheet Metal workbench 
toolbar). Clicking the tool should create a corner relief 
object in the file tree, and also create a circular hole in 
the corner of the two folds (Figure 5). There are 
options for other corner relief geometries in the 
corner relief object dialog. Whilst a circular relief 
might be easy to create in a flat sheet design using a 
drill, you might prefer a square relief or another shape. 
Finally, there are also options for ‘circle scaled’ and 
‘square scaled’ geometries. These are useful as, if we 
use a scaled corner relief but then add other folds 
around that corner, as we are about to do, the scaled 
relief is sized so that it won’t interfere with the 
subsequent fold. Therefore, after experimenting, set 
the corner relief to ‘circle scaled’.

As you can see, we automatically appear to be 
making a tiny metal tray or lid! We might in real life 
want to create folds around the corners of the side 
walls to create a very rigid structure. If we select one 
of the outer edges of the shorter sides folded wall 
and click the ‘Extends one or more faces’ tool again, 
another bend object appears and we now have a 
folded metal piece that completes the corner. 
However, this piece currently sits inside/on top of the 
other folded wall section (Figure 6). Of course, this 
would be impossible to make, so we need to use an 
offset to place this fold correctly.

ADD AN OFFSET
Highlight the new bend object in the file tree and, in 
the dialog, click the drop-down menu for the ‘Bend 
Type’ option. Select ‘Offset’, and now the new fold 
will be offset by the amount specified by the ‘offset’ 
field further down the dialog. Our material is 1 mm 
thick, so if we change the offset amount to 1 mm, the 
new section is on the outside of the two tray walls. 
Or, if we input -1 mm, then the fold sits on the inside 
of the walls. Whilst this works, it does mean that our 
material touches inside the folded overlapping 
sections. This becomes an issue later in the process 
when we want to flatten our design, as it requires a 
clearance between folded surfaces. Therefore, set 
your offsets to 1.1 mm to create external folds with a 
small clearance. Having created all the parts to make 
one corner of our metal tray, we can continue around 
the BaseBend object, adding further folds and corner 
reliefs until we have four walls with folded corners.

One interesting thing to note about designs made 
this way on the Sheet Metal workbench is that they 
can still be manipulated and worked on by tools on 
other workbenches as normal. One quick example is to 

FOLD GEOMETRY
When you fold sheet materials, including sheet 
metals, there are numerous forces in play inside the 
fold. On the inside of the fold, the material is under 
a compression force and, on the outside of the fold, 
the material is being expanded. In the diagram below, 
the dotted green line represents the line through the 
material where these forces swap from compression 
to extension and vice versa. This line is called the 
neutral axis. In different materials and at different 
thicknesses of materials, this line will be in different 
positions. The reason this is important is that it dictates 
where fold lines are accurately placed to create the 
overall dimension of a piece accurately. The position 
of the neutral axis is given as a ratio of the material’s 
thickness; this ratio value is called the K-factor. You can 
search online for the K-factor of a given material at a 
given thickness, but also be aware of what industrial 
standard the K-factor value is being stated in, either 
ANSI or DIN. We found that a K-factor ratio of 0.4 ANSI 
was commonly given for 1 mm aluminium sheet. Using 
this value when using the ‘Flatten sheet metal folded 
object’ tool will ensure that all your fold geometry is 
accurate for the material you wish to use. 

compression

extension

Figure 4 
To set up a corner 
relief, you must select 
the two edges that 
run into a corner point 
between folds
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move to the Part Design workbench, select a suitable 
edge, and apply a chamfer or a fillet. A more useful 
example is to perhaps add sketches to our metal tray 
design. If we were to fabricate this tray, we might like 
to add holes in the design for bolts or rivets to fix the 
folded corners firmly. To add a sketch to this design, 
you work exactly as if you were adding a sketch to any 
face in any design. First, move to the Part Design 
workbench and select one of the external folded tab 
faces and click the ‘Add a sketch’ button. We then 
drew a 2 mm radius circle, imagining we might use a 
4 mm diameter rivet. Again, just like any sketch on a 
face, we used the ‘Create an edge linked to an external 
geometry’ tool to be able to position our circle relative 
to the end of the folded tab, (Figure 7).

Closing the sketch, we then used the pocket tool 
on the Part Design workbench to create a hole, and 
selected ‘through all’ as the type so that the holes 
would be created on both sides of the design. Whilst 
we could have done this in a single sketch, we added 
another sketch to create the same holes at the other 
end of our tray.

To fabricate an object, such as our tray created 
from a folded sheet, we need to be able to flatten our 

design back out after we have completed it. 
Flattening and unfolding the design then allows us to 
see the basic shape of the flat sheet that we need to 
cut to create our object. To flatten the design on the 
Sheet Metal workbench, we need to select a face 
which will be the reference plane to flatten the part 
to. With our metal tray design, the obvious choice is 
to pick the outer large surface of the BaseBend 
object. With that face highlighted, you then need to 
click the ‘Flatten sheet metal folded object’ tool icon, 
which is fifth from the left on the Sheet Metal 
workbench toolbar. You should now see a dialog box 
appear, titled ‘unfold sheet metal object’; you may 
also see that the report window opens at the bottom 
of the screen with a report that ‘engineering mode is 
not enabled’. Don’t worry about the report window 
message: just close the report window. In the dialog 
box, make sure that ‘generate projection sketch’ is 
ticked and then also tick the ‘Manual K-Factor’ box. 
When you tick that box, you will need to input a 
K-factor value. We read that an 0.4 ANSI value was 
appropriate for our 1 mm thick sheet metal design 
when working in aluminium.   

Figure 5 
Adding corner relief 
to points where folds 
adjoin can make it 
easier to produce your 
design accurately in 
sheet metal

Figure 6 
Initially when you 
create an overlapping 
corner, it is placed 
directly on top of the 
other folds

Figure 7 
Setting up a sketch 
to create holes for 
fixtures in our  
tabbed metal tray
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Having input 0.4 and ticked ‘ANSI’, we can then click 
the ‘OK’ button. Depending on your computer, it may 
take a few moments but, once processed, you should 
now see two new objects in the file tree view – 
‘unfold’ and ‘unfold sketch’. These two new items 
exist outside of the active body containing our folded 
design; so, to tidy the file tree view, we can close the 
drop-down menu of the active body so that our file 
tree just has three visible list items: ‘Body’ and the 
two new unfolded items. You can also see in the 
preview window our two new items: a blue line 
sketch and a semi-transparent unfolded sheet of our 
design. Toggling off the Body item in the file tree 
means we can inspect these items more clearly 
(Figure 8). Of course, like most objects, we can 
change the appearance and position of these items.

NUMEROUS USES
We can use these items in numerous ways. For 
example, we might use the ‘Unfold’ object to be the 
basis of an engineering drawing by pushing views of 
the object through to the TechDraw workbench and 
adding dimensions and coordinates. This is useful if 
you needed to traditionally mark or scribe a layout 
onto sheet metal. You could also make only the 

sketch item visible, and then highlight it and use File 
> Export to export a variety of file types (DXF, SVG, 
and many more) to create printable plans, or to use to 
create G-codes for a milling machine or to cut on a 
laser cutter.

Whilst there is a lot of mileage in what we have 
looked at so far, there is the fact that everything we 
designed in our tray example was a fold that started 
or extended from an existing edge of an object. Let’s 
look at using sketches to create fold lines that are not 
on the edge of items but inside the face of a sheet. To 
begin, we created a new project, moved to the Part 
Design workbench, and created a sketch in the XY 
plane. In the sketch, we drew the object in Figure 9. 
You don’t have to faithfully recreate this sketch, but 
you can create something similar to play with 
these techniques.

Moving back to the Sheet Metal workbench for a 
moment, we selected our sketch and clicked the 
‘Create a sheet metal wall from a sketch’ tool icon 
again to create a basic BaseBend object. Notice that, 
similar to padding or extruding a sketch, this tool 
acknowledges that internal geometry is going to be a 
void. Next, we want to create some further sketches 
that will act as folding lines for our project. Let’s aim 
to fold each side wing twice at 45 degrees. Move 
again to the Part Design workbench, highlight the 
upper face of our BaseBend object, and create a 
sketch on it.

For our first fold sketch, we drew a vertical line 
across one of our wings 15 mm in from the edge, 
which we imported using the ‘Create a linked edge’ 
tool. Once this single line was set up, we closed the 
sketch and returned to the Sheet Metal workbench. 

Figure 8 
Flattening our design 
creates a flat 3D 
object of our unfolded 
sheet, and also a 
sketch object

Figure 9 
A sketch that contains 
a number of internal 
holes and has side 
‘wings’ to be folded in 
numerous places
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To create this fold, you first need to select the face 
where the sketch is attached on the BaseBend object 
in the preview window; this feels a little counter-
intuitive and we naturally would select the whole 
BaseBend object in the file tree, but this doesn’t 
work. With the correct face selected, hold the CTRL 
key and click the sketch in the file tree. With these 
two items highlighted, you should now see that the 
‘Fold a wall of metal sheet’ tool becomes visible. Click 
this tool icon and you should see a 90-degree bend 
appear in your part at the sketched line, a ‘fold’ item 
appears in the file tree, and the sketch should be 
toggled to not visible. Highlighting the fold item, you 
can then use the dialog to make changes – we set our 
fold to 45 degrees (Figure 10).

SUMMING UP
For our next fold, we again used the Part Design and 
the Sketcher workbench to create a sketch containing 
a line that went across the ‘wing’ at the point it 
connected with the circular centre section of our 
object. Again, we created edges linked to external 
geometry to be able to draw the line precisely at 
those points. Moving back to the Sheet Metal 
workbench, we again selected the upper face of the 
object and then selected our sketch containing the 
fold line. Applying the ‘Fold a wall of sheet metal’ tool, 
we again set the fold angle to 45 degrees and, this 
time, we also changed the ‘position’ to ‘backwards’ as 
this meant the radius of the fold lay outside the flat 

area of the circle rather than inside it. We repeated the 
process above for the other side of the object and, as 
a finishing touch, we added a chamfer to the upper 
wing corners using the chamfer tool in the Part Design 
workbench. You can see the completed item in Figure 
1. One of the reasons we added the chamfers was to 
prove that even when you add geometry on other 
workbenches, the ‘Flatten folded sheet metal object’ 
will still work correctly and carries through all 
geometry on the designed object. In Figure 11, you 
can see that we have flattened our designed part, and 
everything is still present and correct.

It’s been a pleasure to explore this workbench and, 
in the most part, we have found it very straightforward 
in use. We particularly like that the workbench can 
accomplish so much with so few tools, and this 
makes for a pretty straightforward experience.  

Figure 11 
Our winged object, 
flattened, has 
retained all the 
additional features 
and folding points 
on the sketch and 
3D object

Figure 10 
Our first fold using 
a sketch line as a 
fold position

When creating 
sketches that will 
act as fold lines, you 
need to create each 
line in a separate 
sketch, as you 
will need to adjust 
fold parameters 
individually.

QUICK TIP
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hile there’s no denying that 
you could design sheet metal 
objects without using the 
Sheet Metal Workbench, it 
makes a sheet metal design 
much quicker to generate and 

work with. In this section we're looking at the ’Dodo’ 
workbench, which treats working with framed objects 
and designs or pipework in a similar fashion.

To begin, open FreeCAD and click the Tools > 
Addon manager, then select Dodo on the list. Click 
install. When installed, you will be prompted to restart 
FreeCAD. Restart FreeCAD and then create a new 
project. Let’s look at making a framed object first. 
To begin, move to the Part workbench and use the 
’Create a Cube Solid’ tool to create a cube that is  
750 × 750 × 500 mm.

Next, let’s move to the Dodo workbench, which 
is listed as ’Dodo WB’ in the workbench drop-down 

menu. Click the ’Open FrameBranch Manager’ tool, 
and you should see a dialog box similar to the one 
shown in Figure 2. To create a frame, we need to 
select a profile for the frame extrusions. There’s 
a collection of preset profiles included that model 
real-world standard metal extrusions. Let’s select 
a simple 40 mm × 40 mm square extrusion with a 
5 mm wall thickness. Click the drop-down menu that 
currently reads ’IPE’ and select ’RH’, and then select 
the ’RH40×40×5’ by highlighting it in the list below. 
Next, click on any edge of the cube in the preview 
window and then click ’OK’ in the Open FrameBranch 
Manager dialog box. You should now see that every 
edge of the cube object has had the 40 mm × 40 mm 
extrusion added to create a frame. You can, of course, 
in the file tree view, make the cube object invisible to 
get a better view of our frame (Figure 3).

You’ll notice that our frame has all the required 
sections but that they all overlap at the corners. We 

Figure 1 
An example of creating 
pipework with the 
Dodo workbench

Let’s look at a new workbench: the ’Dodo’ workbench 
allows us to create complex frames and pipework 
from a collection of different profiles

FreeCAD:
frames and pipes

W
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need to extend or trim these frame parts to make a 
frame that could be fabricated in real life. With the 
Open FrameBranch Manager still open, we can use 
the ’Get Targets’ and ’Trim/Extend’ buttons to help 
us do this quickly. First, select an inside face of one 
of the frame sections and then, holding down the 
CONTROL key, select the opposite inside face – with 
both of those selected, click the Get Targets button. 
We have now defined the reference as to where we 
want to trim or extend other frame structure objects. 
Next, select any face of a frame piece that crosses 
the target faces that we want to trim to between the 
target faces. Click the Trim/Extend button and you 
should see that our cross member now is shortened to 
directly fit inside the other pieces (Figure 3). We don’t 
need to select new targets to also trim other frame 
pieces to the same length; even the piece below the 
trimmed piece can be trimmed. We can select faces 
on the three other pieces and click the Trim/Extend 
button to bring them all 
to length. You can also, 
when required, select 
the outside edge faces 
of objects as targets, and 
the Trim/Extend button 
will extend pieces to the 
correct length.

It’s worth noting 
that although we have 
used a solid object as the basis of our frame, we 
can apply frame structures directly to sketches. As 
a quick example, create a new project and move 
to the Sketcher workbench and create a sketch of 
a rectangle with an extra line spanning across the 
rectangle inside – our rectangle was 100 cm × 50 cm.

Moving to the Dodo workbench again, click to 
launch the Open FrameBranch Manager. Let’s select 
a different profile – we went with ’IPE80’, which is a 

common steel H-section 
used in buildings and 
structure fabrication. 
Again, click any edge 
of the sketch in the 
preview window and 
then click ’OK’. You 
should now see a frame 
appear made from the 
H-section. You can, of 

course, use any face of any of the IPE80 parts to 
set targets again to trim or extend other sections 
to. Another useful tool in the Open FrameBranch 
Manager dialog is the Rotation tool. Select any face of 
a section of frame and experiment by either moving 
the dial, or by typing an angle into the input box. 

Figure 2 
The Open 
FrameBranch 
Manager dialog, 
open and ready to 
create a frame on 
our cube object

Figure 3 
Our cube has had 
frame elements 
added, and the 
upper section of 
the cube frame has 
been trimmed and 
extended to make 
the frame members 
sit correctly

We need to extend or trim 
these frame parts to make 

a frame that could be 
fabricated in real life

”
”
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As you move, trim, and extend H-sections, you 
will probably start to see the limitation of the Dodo 
workbench. If you position a corner of our frame, 
similar to Figure 4, you will see that although the 
H-sections are in the correct position, the overlapping 
portion of the sections aren’t trimmed. Of course, this 
would be impossible to realise in a real-world build. 
We’ve created a workaround that works with simple 
H-section overlaps; this can lead to quite a complex 
file tree, but it’s still useful to look at here. Arrange a 
corner of the frame so that it looks like Figure 4, and 
then select the two H-section objects that form this 
corner in the file tree inside the ’Travatura’ group – 
select these in an order so that the part you want to 
remove the overlap from is selected last. We opted 
to make the internal part the object we wanted to 
trim off the overlapping parts, which are two small 
sections on the top and bottom of the H-section. Next, 
move to the Part workbench and click the ’Slice Apart’ 
tool, which is in a drop-down menu off a tool icon for 
the less common Boolean operations. You should now 
have a new group in the file tree called something like 
’Exploded Slice’ – inside this group exists a copy of 
our target intersecting part. In the file tree view, toggle 
the visibility of the original target part in the Travatura 
group to invisible, then, in turn, toggle the parts inside 
the Exploded Slice group to work out which parts you 
need to remove or make invisible. You should end up 
with an H-section part within the Exploded Slice group 
that fits the corner assembly perfectly as if ready for 
welding in a real-world build (Figure 5).

INTERESTING INTERSECTIONS
So far, we have made frames with frame members 
at 90 degrees to each other. Of course, it’s possible 
to create frame structures around sketches or paths 
with other angles in them; however, we need to use 
some workarounds if we want to create accurate and 
neatly trimmed intersections. As an example, let’s 
create a rectangular object with a large 45-degree 
plane on one end to create a frame around.

In a new project, open the Sketcher workbench and 
create a new sketch in the XZ plane. Create a sketch 
similar to Figure 6. In this example, it’s probably 

EXTRUDE A SKETCH
You might have noticed that within the Open 
FrameBranch Manager dialog, there is the option to 
select ’<by sketch>’ in the drop-down menu where 
you select the different profile families. This is a 
really useful feature that allows us to draw a custom 
profile for extrusion into frame elements as a sketch. 
However, there is a particular rule that we need to 
follow when drawing a sketch for it to work correctly. 
The rule is that you need to draw your profile with 
the Polyline tool, and you need to draw the polyline 
in an anticlockwise orientation. In a new project, 
create a sketch on the XY plane and draw a simple 
profile shape using the Polyline tool. Remember, 
you can change the behaviour of the Polyline tool 
using the M key on your keyboard, and it’s possible 
to create profiles with arcs and tangent lines as long 
as you create the profile moving in an anticlockwise 
direction in the sketch. For good practice, you should 
fully constrain the sketch; however, for a simple test 
sketch profile, it isn’t necessary. Once you have a 
profile sketch created, you can test it by first moving 
to the Part workbench and creating a large cube to 
use as a target for a frame and then moving to the 
Dodo workbench to create the frame. When selecting 
the profile for the frame, click the drop-down menu 
and select <by sketch>. You should see your sketch 
’sketch’ listed in the dialog box. Select that, and then 
select an edge of the cube, and click OK as we have 
done before. You should see a frame created using 
your sketch profile. If you’ve accidentally created 
a sketch in which the polyline isn’t moving in an 
anticlockwise direction, you will probably still see 
some frame elements, but they won’t follow the edges 
of the cube and will extrude in random directions.

Figure 4 
When H-frame 
sections overlap, they 
often create joints 
that aren’t correct for 
the real world

Figure 5 
Applying a 
workaround solution 
with the Part 
workbench ’Slice 
Apart’ tool gives 
us a more correct 
H-section interface
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useful to fully constrain your sketch so that we know 
accurately where frame elements will be placed. 
Next, move briefly to the Part workbench and extrude 
the sketch into a large frameable object.

Moving to the Dodo workbench, once again open 
the FrameBranch Manager dialog and create a frame 
on our object in the usual way – we opted again to 
use the RH 40 × 40 × 5 square box profile. When 
you initially create the frame, you’ll notice that the 
angled sections need to be extended to fully meet 
the vertical and horizontal sections. If you then select 
targets and Trim/Extend, you’ll see that the angled 
section now extends through the other sections with 
some excess material. You can see this in Figure 7, 
where the front angled section hasn’t been extended 
and the rearmost section has.

REMOVING OVERLAPS
Continuing to Trim/Extend, we can get the horizontal 
and vertical frame members to adjoin correctly, 
as seen in Figure 7. Now we are ready for our 
workaround solution for the angled parts. Basically, 
the idea is to create parts that cover all the material 
we want to remove and then, using the Part 
workbench, we can use Boolean cut operations to 
remove the unwanted overlap sections. There are, as 
ever in FreeCAD, numerous ways we could achieve 
this. We could, for example, create simple solid 
cuboid objects on the Part workbench, move them 
into place, and then perform the cut operations.

Another, perhaps cleaner, approach is to map 
a sketch onto the frame to create an extrusion 
that matches the material we need to remove and 
then perform the cut operation. Select the outside 
face of one of the short upright frame sections, 
then, on the Sketcher workbench, create a sketch. 
When prompted, choose ’FlatFace’ as the sketch 

attachment method. In the sketch, use the ’Create 
an edge linked to external geometry’ tool to import 
any edges and vertices that will help you create your 
sketch. Then, use the Polyline tool to create a sketch 
that will remove all the material you need to remove 
from your target frame section. You can see our 
sketch in Figure 8.

Next, move to the Part workbench and extrude the 
sketch you just created. Extrude it in such a way that 
it moves through the frame element you wish to cut 
material from. You can only perform a cut operation 
using two parts, so the next step is to select one of 
the angled frame members from inside the Travatura 
folder in the file tree and then select the extrusion we 
just made. Click the ’Make a cut of two shapes’ tool; 
this should perform the correct cut on one of the  

Figure 6 
Our base sketch 
in the XZ plane to 
create our wedge-
shaped frame object

Figure 7 
When working 
with angled frame 
sections, it’s hard 
to make frame 
members adjoin 
correctly
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angled frame members. Next, select the other frame 
member you wish to cut excess material from and 
then select our extrusion object, which now can be 
found inside the ’Cut’ object folder that was just 
created in the file tree. In Figure 9, you can see that 
this has worked perfectly and has given us the frame 
member arrangement that we wanted to achieve.

The Dodo workbench doesn’t just have excellent 
tools for creating framed designs, it also has a 
collection of tools for making pipework designs 
easier to realise. Like many aspects of FreeCAD, it’s 
incredibly capable, but we can start with some simple 
examples that you can build on as you explore the 
tools. In a new project, let’s start by making a sketch 
in the XY plane. We created a simple square U shape 
using the Polyline tool. We made it a reasonable 
size because, if it’s too small, when we add pipes 
following the sketch, it might fail if the pipe corners 
can’t fit in the dimensions of the sketch. It’s worth 
noting that pipe and frame objects on the Dodo 
workbench can be applied to not just sketches but 
also wires created using Draft tools, or you can simply 
add pipe objects onto other existing pipe objects.

With a sketch created, move to the Dodo workbench 
and click the ’Open PypeLine Manager’ tool icon.

In the PypeLine Manager dialog box, there’s a 
range of standard pipe types to select from – we 
chose the ’DN40’ pipe from the ’SCH-STD’ group. 
This is a common pipe dimension with a 40 mm 
internal diameter. Next, click any part of the sketch 
in the preview window and then click the ’Insert’ 
button in the PypeLine Manager dialog. This should 

You can add pipe objects 
and other peripherals  

by simply attaching them 
to an existing pipe

”
”

Figure 8 
A sketch set up for 
extrusion to create 
an object that will 
cut away and trim 
the frame members 
correctly

Figure 9 
Using our workaround, 
we now have the ends 
of the angled frame 
members correctly 
trimmed



97

automatically create a pipe that follows the complete 
sketch path with the 90-degree curved sections 
added (Figure 10).

We mentioned earlier that you can add pipe objects 
and other peripherals by simply attaching them to an 
existing pipe. There are numerous tools that help us do 
this. Selecting the outer edge of one end of our U-bend 
pipe construction, click the ’Insert a Reduction’ tool. 
The larger end of the reduction is automatically defined 
by the diameter of the selected adjoining pipe, and so 
we simply use the ’Insert Reductions’ dialog to select 
the smaller end of the reduction. In Figure 11, you can 
see we opted for the ’DN20’ size, and then clicked the 
Insert button to add the reduction.

It’s as straightforward to add a simple length of 
straight pipe to an existing design. Again, select the 
edge of the thin end of the reduction we just added 
and click the ’Insert a Tube’ tool. In the dialog box, 
select the tube type that matches the diameter of 
the reduction (DN20) and then type a dimension into 
the length input box to set the length of the tube 
you require. Finally, click the Insert button to insert 
the tube. Similarly, we can add a curved section or 
’elbow’ into the design using the ’Insert a Curve’ tool. 
When inserting a curve, you select a target edge as 
before and then select a matching tube profile – again, 
we chose DN20. You then need to add a bend angle 
and a bend radius into the input boxes. Starting with 
values of 90 for each gives you a good result – you can 
experiment with other values. A small issue with this is 
that it’s easy to input values that can’t actually exist and 
therefore won’t work! Once you have your values and 
options selected, click the Insert button to insert your 
curve. Finally, with the ’Insert Elbows’ dialog, you have 
a dial wheel that you can adjust to change the angle of 
the curved elbow you have just added. You can see the 
reduction, manually added pipe, and the angled curved 
elbow we have just added in Figure 1.

Often pipework uses flanges as joining mechanisms 
between pipe sections, and as such, the Dodo 
workbench has a Flange tool. At the other end of our 
pipe experiment, we selected the outer edge of the 
pipe end and clicked the ’Insert a Flange’ tool. There 
are various flange standards in the dialog box – we 
selected a DN40 type to fit our existing pipe edge. We 
then clicked Insert to add the flange (Figure 1).

We’re sure by now that you have the general 
idea, but it’s worth exploring the other tools available 
to manipulate and create pipe systems. There are 
tools for adding valves of differing types, U bolts to 
secure pipes to other structures, tools to cap the 
end of pipes, and tools to create flowing branches in 
pipes. There really isn’t much you can imagine that 
you couldn’t design using these tools. Finally, it’s 
also worth exploring how you could add to designs 
using the workbenches we have looked at previously. 
When adding flanges, for example, it would be quite 
straightforward to use the ’Fasteners’ workbench 
to create nuts and bolts to join flanges together. We 
looked at the Fasteners workbench as part of the 
tutorial working with assemblies on page 42.  

Figure 10 
Creating pipework 
that follows a 
sketch is simple 
using the PypeLine 
Manager tool

Figure 11 
Adding a reduction 
part to our simple 
pipe example
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n this final part of our guide to FreeCAD, 
we thought it might be a good idea to look 
at some areas that you might like to 
explore now that you have a good grasp of 
the basics. You probably have some 
intermediate skills if you have followed 

through this guide fully, so let's look at other areas 
of FreeCAD that you might explore.

For the sake of consistency throughout this series, 
we have used FreeCAD in its most default 
appearance – this makes it easier for people to 
recognise where tools are from the images etc. 
However, it’s possible to change up the theme and 
even change the user interface entirely. For simple 
changes of theme go to Edit > Preferences and then 
click the General tab. You should see options to 
change the ‘stylesheet’, as well as options to change 
the size of the toolbar icons. In Figure 1, we have 

changed the stylesheet to ‘Darker Orange’, and 
increased the tool size to medium.

For a more significant change, you might like to try 
a different user interface. This can be achieved by 
installing the ‘ModernUI’ workbench from the Tools 
> Addon menu. You’ll be prompted to restart 
FreeCAD and will be rewarded with a different UI 
where one of the major differences is that the 
workbenches are tabbed across the top of the 
screen, allowing for quick switching (Figure 2). If you 
don’t like the ModernUI, you can uninstall it in the 
usual way using the Addon manager but, additionally, 
you need to create and execute a macro to return to 
the original FreeCAD UI. This is straightforward to 
achieve – you select and copy the macro script text 
that is supplied in the description of the ModernUI 
workbench in the Addon manager. Then, from any 
workbench in FreeCAD, click the Macro drop-down. 

Figure 1 
Changing the 
stylesheet options 
in FreeCAD can 
customise the colours 
and also change the 
tool icon sizes

We look at where you may like to explore next as part 
of your ongoing FreeCAD journey!

FreeCAD, 
summing up!

I
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In turn, click Macros and, in the Execute macro 
window, click Create (Figure 3). Paste in the macro 
script copied from the Addon manager, and then 
close the tab and click Save and give it a name when 
prompted. Return to the Execute macro window, 
highlight the macro you created, and click Execute to 
run the macro. Then, restarting FreeCAD, you’ll have 
returned your installation to the original state.

Whilst on the subject, macros in FreeCAD can be 
incredibly useful. If you have regular tasks that you do 
repeatedly, or similar objects that you create across a 
range of projects, a macro may help to streamline 
your workflow. You don’t have to script a macro by 
hand either, you can create macros using the record 

function. Essentially, once a macro is recording, it 
builds a script of all the actions you perform until you 
stop the macro recording. You can then save and 
name the macro, and execute the macro whenever 
needed via the macro menu. A simple way to try this 
is to create a new sketch and then start the macro 
recorder. Draw a couple of circles and constrain them, 
and then perhaps Pad them using part design, and 
then stop the macro. You can look over the script and 
execute it to repeat the same task. Often macros 

Figure 2 
Available via the 
Addon manager, 
Modern UI changes 
the design layout of 
FreeCAD and uses 
tabs for each  
installed workbench

ROTATING
Sometimes you might want to make your 3D model move, and, as ever in FreeCAD, 
there are numerous ways to achieve this. At first glance, you might jump to installing 
the Animation workbench from the Addon manager, but currently this only supports 
older Python 2-based versions of FreeCAD. It’s worth keeping an eye out for if it gets any 
updates in the future. A current popular approach to animating assemblies is to use the 
Assembly 4 workbench. We haven’t looked at this in the series, but we did look at an 
assembly workbench, A2plus, in issue 43. Whilst you are exploring and learning these 
approaches, a super-simple way to create a rotating movement of your part or project 
is by using the turntable tool. Located at Tools > View Turntable, when you launch the 
turntable dialog, you’ll see a couple of simple parameters: you can adjust the angle of 
the view of the part and you can set the speed of rotation. You can also set the view 
to full screen and also set a timer for the length of time the part rotates for. Click the 
play button and your rotating part springs into life. You can use the turntable function in 
combination with a screen recorder application to make rotating video clips.

Essentially, once a macro is 
recording, it builds a script of 

all the actions you perform until 
you stop the macro recording

”
”

require a little editing and tweaking. It’s been described 
to us more than once that macros are the gateway to 
writing your own workbench!

We’ve come to the opinion, whilst exploring FreeCAD, 
that it really is unique as a CAD environment and we love 
that it isn’t trying to be an open-source clone of another 
tool. This becomes really clear when you look at the 
range of workbench environments there are for 
FreeCAD. There are so many we haven’t explored as  

Figure 3 
The Macro tools can be used to create simple and 
complex automated processes alike
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Figure 4 
A small, simple 
example beginning 
to explore the 
Architecture 
workbench tools

Figure 5 
An amazing 
workbench that 
enables commercial 
robot arms to be 
placed and controlled

CROWD IN

One of the many ways in which people can contribute to the FreeCAD community is by 
helping translate FreeCAD so it can be used in many different languages. This is a large 
task but is being well achieved due to the use of ‘Crowdin’. The Crowdin website really 
simplifies crowd-sourced translation. You simply set up an account, click a language 
you want to help with, and you are presented with every part of FreeCAD text split into 
little areas. Click an area and then try and translate a few terms or sentences. You 
can also view and comment on other people’s translation attempts which means, with 
enough people, the translation becomes more and more accurate. This peer reviewing 
aspect of the Crowdin platform also means that your translation doesn’t have to be 
perfect – often there is no perfect translation and, as such, all attempts help inform the 
best option. Once a language is translated, the FreeCAD developers can then pull that 
language into the platform for an upcoming release. Check out the FreeCAD Crowdin 
page here: crowdin.com/project/freecad.

part of this guide, but we wanted to highlight a few 
examples that you might like to go on to explore.

Perhaps the most obvious one we haven’t looked 
at is the Arch workbench which is built into FreeCAD, 
usually at the top of the workbench list. Arch is short 
for Architecture, and it’s chock-full of useful tools to 
help you design buildings and structures. Whilst you 
may well need to look through the wiki page or find 
an online tutorial, you can quite quickly get going with 
this fabulous workbench. In Figure 4, we have drawn 
a simple rectangle using the draft tools in the Arch 

workbench, and then used a tool to generate a wall 
from the wire outline. We’ve then used the built-in 
tools to simply click and add preset windows and 
doors in our simple structure. Don’t be fooled by our 
first attempt, though: check out some of the amazing 
structure designs in Arch on the FreeCAD forums to 
get properly inspired.

The Robot workbench is perhaps a great example 
of just how powerful a tool FreeCAD can be. Whilst 
the Robot workbench is still included in FreeCAD, it 
isn’t being particularly actively developed, but it’s a 
fun workbench to play with for a few minutes. Often, 
with many workbenches, the FreeCAD wiki has a 
succinct tutorial to work through to get you up and 
running with the basics of the bench. The Robot 
workbench is no exception, and working through the 
instructions at hsmag.cc/RobotTutorial, you can 
import an industrial robot arm. In Figure 5, we used a 
Kuka IR500, and you can create trajectories to move 
the arm through, which then can be played like a 
script. If you happen to own or have access to a Kuka 
robot arm in real life, you can even export the 
subroutines you create to run on the machine.

The Path workbench is FreeCAD’s main CAM 
environment, and is where you can set up CNC 
routing and milling toolpaths to create parts on a wide 
variety of machines. We wrote about the Path 
workbench outside of this FreeCAD tutorial series 
way back in HackSpace magazine issue 25. Of 
course, FreeCAD has developed a lot since then and 
the Path workbench, with its amazing dedicated 
developers, is one of the most actively developed 
areas of FreeCAD. As such, it’s changed somewhat 
since our write-up, but there’s plenty of information 
about it online. It’s definitely worth exploring, and 
offers robust and powerful CAM approaches, and is 
capable of creating G-codes post-processed to suit a 
wide variety of machines (Figure 6).

The FEM workbench enables complex analysis of 
objects under loads, and this type of FEM/FEA 
approach often is quite expensive to perform in other 
proprietary CAD environments. It requires a couple of 

http://crowdin.com/project/freecad
http://hsmag.cc/RobotTutorial
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Figure 6 
The Path workbench is a 
powerful CAM tool enabling 
toolpaths and G-codes to 
be created and simulated 
for CNC machines

Figure 7 
One of the included 
FEM workbench 
examples. This 
example analyses the 
deflection of a beam 
under load

extra external packages to be installed/configured, 
and then models can be assigned material properties 
and then tested under loads. To get a fleeting 
appreciation of what this looks like, even without 
installing the extra packages, you can open one of the 
example projects bundled into FreeCAD on the FEM 
workbench, and see the type of strain/stress analysis 
and representation you can achieve (Figure 7).

When we looked at the Mesh workbench on 
page 74, we needed to have another CAD 
environment, OpenSCAD, installed on our machine 
to enable some of the Mesh workbench features. 
There’s also, however, a dedicated OpenSCAD 
workbench within FreeCAD. OpenSCAD differs from 
many CAD packages in that it is script-based. This 
means you ‘code’ your CAD models. For example, to 
make a cube in OpenSCAD, you might write a line 
that looks like ‘cube([10,10,10],true);’ which 
creates a 10 mm cube centred around the origin 
point. The addition of a dedicated OpenSCAD 
workbench means that if 
(as we did) you have 
used OpenSCAD and are 
moving to FreeCAD, any 
components or models 
you have made in 
OpenSCAD can still be 
used within your 
FreeCAD designs. The 
workbench also allows you to create new parts using 
OpenSCAD scripting directly (Figure 8). If you’ve 
solved a really hard geometry in OpenSCAD, this 
gives you not only the option of reusing that work, 
but also for that work to be enhanced using all of 
FreeCAD’s other tools.

Whilst there are more than enough workbenches 
to get to grips with listed in Addon manager, there 
are also workbenches out in the community that 

aren’t included either in the main download or in the 
Addon manager. These are often in development and 
experimental in nature, but it can be fun if you find 
something in the community that relates to 
something you know about or are interested in.

Sometimes these workbenches are not included 
as development on them 
has ceased. However, 
often the open licences 
of these archived 
workbenches mean that 
someone could begin to 
work on them again. 
They also may still be 
functional and of use. 

One excellent example is a workbench first released 
back in 2015: the Glider workbench enables the 
design of paragliding canopies and recently, in 2021, 
a forum member posted pictures of a paraglider in 
flight that had been designed with this innovative 
workbench (Figure 9).

Are you a developer? FreeCAD is always interested 
in attracting more developers to contribute to the 
software. The majority of the FreeCAD  

Remember that 
FreeCAD is made 
and maintained 
completely by 
volunteers. Be kind!

QUICK TIP

Perhaps you have your own 
idea for a tool that you’d like to 
create for FreeCAD, or an issue 

that you think you can solve

”
”
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workbenches are written in Python. However, there 
are also some workbenches and areas of FreeCAD 
written in C++. There are many areas to look at, or 
perhaps you have your own idea for a tool that you’d 
like to create for FreeCAD, or an issue that you think 
you can solve.

The first port of call is the forum, and in particular 
‘Developers corner’, where it would be a great idea to 
introduce yourself. Read the pinned thread, ’Read this 
first if you want to write code for FreeCAD’, to get 
the basic orientation of the FreeCAD developer 
community approach.

Figure 8 
The OpenSCAD 
workbench offers all 
the functionality of the 
excellent OpenSCAD 
environment built 
into FreeCAD

Figure 9 
The Glider workbench 
is not under active 
development, but 
is still is being used 
by a small number 
of users to produce 
amazing projects

In this final part, we wanted to recap and 
expand upon other sources of help, should you need 
it, for FreeCAD. One of the best resources out there 
is the FreeCAD community forum –  
forum.freecadweb.org. We’ve mentioned it before, 
but it’s worth repeating a couple of points about the 
forum. First of all, there’s a really high chance that 
there is information that can help you with your 
particular situation already on the forum. It’s vast, and 
a search query for your subject will often return a 
heap of golden knowledge. It’s definitely worth 
searching before adding a new question or thread. 
Secondly, in order for community members to be 
well-equipped to answer a question, it’s really useful if 
you post basic information about your operating 
system, version of FreeCAD, etc. Wonderfully, 
FreeCAD has this built-in: if you go to Help > About 
FreeCAD from any workbench in FreeCAD, you will 
see your system information with a handy ‘Copy to 
clipboard’ button (Figure 10). Click the button and 
paste it into your opening post, followed by your 
question, and it may well make it much easier for 
someone to answer. 

Sometimes you’ll find that something in FreeCAD 
doesn’t work as you expect it to. Again, a good bit of 
forum searching and wiki reading will often yield a 
solution, but sometimes something might be broken. 
It’s always worth, and always preferred, that you 
search the forum, and post on the forum, checking if 
others have had your experience and allowing other 

http://forum.freecadweb.org
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Figure 10 
The ‘About FreeCAD’ 
tab allows you to 
copy details of your 
machine, FreeCAD 
version, and 
operating system

community members to help identify if it is indeed a 
bug. If the consensus is that it is a bug, then 
someone in the community will raise it as an issue in 
the correct way or will inform back in the thread that 
the issue is a previously identified issue. Often, the 
answer will be that an issue in the current stable 
release version of FreeCAD has been addressed in 
the developmental version of FreeCAD. On that 
subject, the developmental versions of FreeCAD are 
always available for people to try. We’d suggest, as 
we have throughout these articles, that using the 
latest stable version whilst you are learning is 
recommended, but as you understand more it can be 
fun to try the developmental versions, which often 
show a sneak preview of new, interesting features 
and developments. Also, as FreeCAD is open source, 
there are some forked alternate versions of FreeCAD 
– this helps to keep FreeCAD development 
innovative, as the forked versions often explore 
different features and approaches. One popular forked 
version of FreeCAD, that contributes a lot of 
development back into the main FreeCAD branch, is 
the LinkStage3 fork by Realthunder – with some of 
the basics under your belt, you might like to try it out.

So, as we come to the end of this guide, it’s 
perhaps worth considering where to look for other 
sources of information and tutorials on FreeCAD, as 
well as perhaps places to find some inspiration! First 
up for inspiration, new releases, and new feature 
announcements – and 
also a great place to see 
challenging, interesting 
work done in FreeCAD 
– is following the official 
@FreeCADNews 
account on Twitter. 
Watching that Twitter 
account, you’ll see the 
wide range of approaches people use with FreeCAD 
and also come across people doing CAD challenges 
using FreeCAD and more. They often post using the 
hashtag #madewithfreecad, and it’s astonishing to 
see what people have made. YouTube is absolutely 
crammed with tutorial videos, and pretty much every 
area of FreeCAD is covered. One particular YouTube 
channel, Joko Engineering, deserves particular 
mention for excellent tutorials that not only cover 
using FreeCAD tools, but also often explore 
underlying CAD concepts.

We’ve mentioned it a few times, but the official 
FreeCAD documentation is in the form of a wiki and is 
available at wiki.freecad.org/Getting_started. All 
the built-in workbenches and tools are documented, 

and there are numerous short tutorials on different 
workbenches. It’s got heaps of information clearly laid 
out, and the wiki is already available in numerous 
languages. It also has wider reading on FreeCAD. A 
nice wiki entry that gives a quick-read version of 
FreeCAD’s origins and history can be found at  
wiki.freecadweb.org/History.

We hope this guide has been useful, and we feel 
that if you worked through all 16 parts, you would be 

pretty competent at 
modelling in FreeCAD. In 
our opinion, it’s definitely 
a process that requires 
practice, and with each 
new model you’ll find 
some area that requires a 
new approach to be 
explored and learnt. As 

such, it’s a great idea to work with FreeCAD as much 
as possible. One thing we have seen a lot of in the 
communications we've had preparing this guide is 
that often CAD communities have competitions or 
ongoing challenges which can not only be good fun, 
but also provide opportunities for you to expand and 
learn more approaches.

We’ve really enjoyed writing the tutorials that 
comprise this guide for HackSpace magazine, and 
we hope that you have enjoyed it too. Many thanks 
to those of you that have worked through all the 
tutorials, reaching out to us on social media to 
share your progress. We continue to look forward 
to see what you can create using the brilliant 
FreeCAD platform. 

YouTube is absolutely 
crammed with tutorial videos, 

and pretty much any area of 
FreeCAD is covered

”
”

http://wiki.freecad.org/Getting_started
http://wiki.freecadweb.org/History
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